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1 Legal Restrictions of Sale
The sale of this Software Tool in Mexico is prohibited.

Due to embargo restrictions, sale of this Software Tool in Russia, Belarus, Iran, Syria, and
North Korea is prohibited.
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2 WinDarab V7

2.1 New Features in WinDarab 7.10

2.1.1 Oscilloscope uses Direct2D, Instrumente Panel
uses Direct2D (new)

– Changed the drawing code to use Direct2D instead of GDI to draw the oscilloscope
content (signals). Compared to GDI display drivers provide GPU support for Direct2D
to accelerate drawing of 2D content.

– Note: recommend Windows 11 as this is the current development and test environ-
ment. Nevertheless Windows 10 shouldn’t be an issue as the compiler target is Win-
dows 10.

2.1.2 3D views use DirectX 11
– Changed the 3D code to use DirectX 11 instead of OpenGL due to the stability of

some OpenGL drivers (like the Intel UHD OpenGL graphic driver)

2.1.3 Fonts: User can select the font used in views
– Users can select the font used in many views.

– For supported views the font can be changed globally in the program settings of Win-
Darab. In addition, the font can also be changed for a view individually.

Min-Max-Table: Users can change the font
Distribution: Users can change the font (2D data grid)

Map Creator:: Users can change the font (2D data grid)

– Users can change the font and size that is used to display the data in the listed views.

– A global default preset can be selected in Tools / Settings / Program on the tab “Mis-
celleanous“.

– But it’s also possible to change the font per view. See settings tab “Options” to select
if the global font is used or to choose a view-specific font.

Instrument Panel: Font used by instrument panel can be selected globally

– The font that is used to render instrument panel can be selected globally in Tools /
Settings / Program.

Instrument Panel: Appearance deferred from deprecated GDI rendering

– The appearance of the instrument panel control deferred from the deprecated GDI
implementation because of a different way to calculate font heights. Especially, if the
instrument panel is packed with many controls, the font size was too large.
Now, when fitting the font height, the line gap is included in the font height calcula-
tion resulting in font heights like the old GDI rendering.

– Note: Because Direct2D works differently the appearance of the gauges is not exactly
like the GDI implementation. But now, it’s closer.

Instrument panel Bar gauge includes the width of the scale values to calculate the
font height
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– Actually, the code was there since a long time, but instead of selecting the character
width of the largest scale value, WinDarab always defaulted to one character. Now,
the length of the scale values (min/max) is used to determine the maximum possible
size for the scale values and not only the height of the scale (divided in 6 rows)

Outing Report: The user can change the used font

– The user can change the font and size that is used to display the data in an outing re-
port.
First, the default font for Outing Reports can be set in Tools / Settings / Program on
the tab “Miscellaneous“.
But it’s also possible to change the font per outing report. See Outing Report settings
tab “Options” to decide if the global Outing Report font is used or select a view-spe-
cific font.

2.1.4 User-defined channel groups
– In v7.09 channel groups were defined by the recording tool RaceCon. Adding other

channels to groups or creating own groups wasn’t supported.

– Now, a user can create own groups.

– User-defined groups using the same name like recording-defined groups are merged.

WinDarab supports user-defined channel groups in addition to recording-defined.

– If the channels pane is in hierarchical mode the context menu can be used to add
channels to channel groups (e.g. math channels, alias channels, …).

– The current membership of the focus channels is shown in the context menu.

– An “Organize” menu item is available to create, edit and delete user-defined channel
groups.

– Note:

– User-defined and recording-defined channel groups are combined,

– Member channels that are a group member by the recording-defined groups
cannot be removed from the channel group.

– “Organize” dialog doesn’t show the membership of recording-defined groups.
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2.1.5 WDServer v3.3 "External Telemetry" streams
supported (license required)

– External Telemetry” is a new model allowing 3rd party applications to stream real time
data to WDServer.

– Requires an additional license in addition to WinDarab Expert license.

2.1.6 Licensing tool library updated
– The license tool library is updated.
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– If required, the installer downloads and installs the additional “Bosch License Manager
Tool”.

Further information on License Manage can be found here: License Manager

2.1.7 File Explorer shows stage/road mode for rally files
(alternative for standard outing/lap layout for
circuit racing)

– Additionally adapted the visualization filter for reducing file list (hierarchy, flat, re-
duced)

– A new special channel “Rally Stage/Road” was introduced to configure optional chan-
nel used to determine stage/road sections that defer from the outing/lap recording
concept.
The idea is especially to improve support of Rally data files

– If a file is opened that contains a not-empty channel listed in the special channels list
for “Rally Stage/Road”, the behavior of WinDarab will change:

– The original lap stack of the file is cleared and a user-defined lap stack is created.
An entry in the new lap stack is created for each value change of the “Rally Stage/
Road” channel. (e.g. a file can be splitted into sections by using a stage_mode
boolean channel)

– The File Explorer removes the symbols for In/Out/Fast in the lap stack. Instead it
will show the text represantion of the value.
Tip: Assign a value-to-text formatter to the channel to see a human readable
value!

– If the text representation of the “Rally Stage/Road” value is “Stage” or “Road”,
WinDarab will show colored icons for “Stage” and “Road”.
The symbols will also be used even if there’s no value-to-text formatter assigned,
if the “Rally Stage/Road” channel is “stage_mode”. In this case, “1” is “Stage” and
“0” is “Road”.

– Please be aware of this (as this is the current implemention)

– The user-defined lap stack will be recreated each time the file is opened and it
will be saved to the file.

– All original “hardware” triggers are removed/hidden.

– You can add additional user-defined lap trigger.

– But you can’t remove the created laptriggers permanently unless you unconfigure
the “Rally stage/road” channel.

– You can return to the original lap stack by resetting the lap stack in the “lap trig-
ger” dialog (Oscilloscope / Start / Tools / Laptrigger / Laptrigger …)

https://www.bosch-motorsport.de/content/downloads/Raceparts/en-GB/383403275384966027.html
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2.1.8 DataLoggerImport supports simultanous import of
multiple USB sticks

– DataLoggerImport supports simultanous import of multiple USB sticks.
By default the support is disabled but can be enabled in the advanced settings.
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2.1.9 Control the time gap in linked files between
incontinuous members

– Cutting unnecessary long gaps in data to fixed gaps for better visualization of long
time period data

– If you select multiple files and open them as a linked file, WinDarab links the files to-
gether according to their timestamps:

– If the timestamps of the second file are before those of the first file, WinDarab
linked the files together and adjusted the timestamps to have a time gap of 10
seconds between.

– In all other cases the files were linked together using their timestamps. This could
create very large time gaps.

– Now, we added to new settings to Tools / Settings / Program / “Files and Folders” to
control the behavior for linked files:

– Time gap threshold: If the gap between two files is smaller than the threshold
value, the files are linked together without changing the time gap.
The default value is 1 s.

– Time gap: If the gap between two files is larger than the threshold, then the gap
is set to this value (default: 10 seconds). The time gap is used also, if the
timestamps of the second file are before the second file.



2 | WinDarab V7

10 / 224 WinDarab V7 Wiki Manual Bosch Motorsport

2.1.10 WinDarab support Windows Speech engine
– WinDarab support the use of the Windows Speech engine. For the beginning, a text

can be configured for alerts in the instrument panel gauge settings. If replaying is act-
ive (telemetry or replaying offline files) and an alert becomes active, WinDarab passes
the text to the speech engine and plays the text on the speaker / headsets.

Text to Speech Engine support

– Possibility to select a sound file for alerts in the instrument panel to have an audible
notification about an alert.

– We decided to use the Text to Speech engine of Windows to go more far.
We added a textbox for all configurable alerts of gauges in the instrument panel.
If an alert gets activated, WinDarab passes the text to the Speech to Text engine and
Windows sends the speech output to the speaker/headsets.

– Currently, the speech output is only enabled if replaying data (e.g. watching telemetry
or replaying a file): But the audio output can also be disabled for Replaying (e.g. if the
head set is disconnected and the user doesn’t want to disturb others).

– Please let us know your opinion or suggestions to improve the use of Text to Speech
in WinDarab!
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2.2 General
WinDarab enables you to analyse and display logged data recorded
by Bosch Motronic.

System Recommendations
– 1920 x 1080 resolution (4k supported)

– 16 Gb RAM

– Windows 10

Copyright / License Agreement
We thank you for choosing a Bosch Motorsport product. Please remember that it is the
user’s responsibility to comply with all applicable copyright laws.

Bosch Engineering GmbH

Motorsport

Robert-Bosch-Allee 1

74232 Abstatt

Germany

All rights reserved.

No part of this program or this manual may--in any manner whatsoever-- be reproduced,
modified, shared, translated into another language (including computer languages), or
stored electronically without the prior written consent of Robert Bosch GmbH. Any unau-
thorized transmission of the program and/or manual will be prosecuted under criminal
law. The License Agreement entitles you to work with this software. You may not, how-
ever, run this software concurrently on different computers.

Liability
In no event will Robert Bosch GmbH, or any person involved in the development, produc-
tion, or distribution of this software be liable to you for any consequential, incidental, or
indirect damages including damages for loss of business profits or diminished cost sav-
ings.
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Glossary
Area Refers to the horizontal division of an Oscilloscope in which channel

signals are displayed.

Base Directory A Base Directory represents a link to a particular folder on the hard
drive (--> network). WinDarab saves data in sub-folders within a
specified base directory.

Base Directory for
Calculating Differ-
ences

Logged Data Directory that provides channel values (for the second
channel) for calculating a difference.

Bit Area See Area

CAN Controller Area Network

CanCard Most used hardware for data recording. A more recent device is
CardMemory.

Channels Separate data signals within a recording.

Conditions A condition is a linked set of mathematical criteria that must be met
in a specific sample for that data sample to be included in an evalu-
ation.

Configuration A particular arrangement of channels, which can be loaded and dis-
played in an Oscilloscope.

Darab Explorer Darab Explorer is used in WinDarab to manage Racetrack and
Logged Data Files.

Data Logger Data Logging Device for Measurement Channels

Differences The Differences Channel is a special channel that calculates values
for the difference resulting from a comparison of the same channel
in two different Logged Data Files.

DLS Data Logging System (consists of C55 Data Logger and MSI Devices)

ECU Engine Control Unit

Grid Grid lines which can be displayed in a Oscilloscope.

Logged Data File A Logged Data File contains all data recorded in a vehicle.

Racetrack or Race-
course

A Racetrack or Racecourse is the location where vehicle data record-
ing has taken place. WinDarab assumes that the selected racetrack
corresponds to the racetrack where data was recorded.

Reader See CanCard

Supported Devices
WinDarab supports the following devices from Bosch Motorsport.

DDUs

– DDU 7

– DDU 8

– DDU 9

– DDU 10

– DDU 11

Data Loggers

– C 40
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– C 40 Plus

– C 55

– C 60

– C 70

– C 80

Controllers

– MS 6.x

– MS 7.x

– MS 50.x

2.2.1 Program Start
After starting WinDarab the user interface appears in which the last edited desktop (see
chapter Desktop) or new desktop is opened. A new desktop will open if WinDarab is star-
ted the first time.

WinDarab offers a structured user interface with several components:

This is a possible view of composition of the WinDarab components. You can configure
the WinDarab components so that the view complies with your operation methods.
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Further description of the different components for the shown arrangement:

– File Explorer window displayed upper left contains the list of opened logger data
files.

– Racetrack window placed bottom left shows the current racetrack and course seg-
mentation.

– Channels window arranged upper right displays a list of measurement, mathematical,
internal or temporary channels according to the users’ choice.

– Color window arranged bottom right allows you to pick a color for an element (for in-
stance a channel in an analysis window).

– Oscilloscope, Analysis Window, Instrument Panel resides in the middle of WinDarab
and represents data or results of the calculations that are performed.

Important Tips
Keyboard

– Right next to some menu items, you will also see keystroke combinations that allow
you to perform functions from your keyboard. Using your keyboard rather than the
mouse to execute frequently used functions saves a great deal of time.

Context Menu

– The context menu of an element (window, channel etc.) contains a list of frequently
used and useful functions. It is opened by clicking with the right mouse button on the
element. In case the element has a zoom function, the context menu is opened by us-
ing the middle mouse button, or the left and right mouse buttons.

Changing the Color Style
You can change the style of your WinDarab7 by clicking on the Style menu in the top right
of the window and then choose a style from the drop-down.

License
If you want to update your WinDarab license, you can do this by clicking on WinDarab-
Orb → Tools → Update license.
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From here on just follow the instructions. There are two ways to install a new WinDarab li-
cense.

1. You can insert a license file (.lic)

2. You can insert a license number. For this option you have to be connected to the in-
ternet

To check your license information, just click on WinDarab-Orb → Tools → Show license
information.

Command Line
Following command line arguments may be passed to WinDarab on start-up.

-d <workdesk file>

Opens WinDarab using the given workdesk file. If no additional data files are passed the
saved workdesk is completely restored – including the used files and zoom.

If the argument is not used WinDarab loads the workdesk which was saved by WinDarab
during shutdown of the application.

-f <filename> [-f <filename> …]

Use the –f argument to pass one (or more) data files which are opened instead of the files
within the workdesk.

In front of each file name the argument –f must be provided!

Note:
Don't forget to put filenames inside of two quotes ("<path/filename>") if the path or file-
name contains space characters.
You may use quotes at any time to prevent misinterpreting the command line arguments.
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2.2.2 Desktop
While working with WinDarab a typical desktop layout might look like this:

A Desktop consists of:

– Opened dockable windows

– The worksheets currently processed.

Each worksheet contains the worksheet controls whereby you analyze and visualize
logged data.

WinDarab offers the possibility to save and retrieve a particular Desktop.

If loading a Desktop, you can choose whether to view the files in a new Desktop or
whether to restore a previous situation.

As opposed to simply loading a Desktop, restoring a previous Desktop layout involves the
closing of all currently opened files and the opening of those files that were in use as the
Desktop was saved. In addition to the configured settings (e.g., channels) the windows will
also restore the displayed excerpts and reproduce the situation exactly as it was before.

Every time you exit WinDarab the program saves the current Desktop and retrieves
it the next time you start the program.

Tip:
To suppress the automatic retrieval of the previous Desktop hold down the shift key when
you start WinDarab

Note:
During work WinDarab saves the current Desktop periodically.

Loading a Desktop
Select “Start→ Desktop→ Load” from the menu.
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The “Load desktop” Assistant will appear.

Click on “Open” to open the desktop with the currently opened files.

You can also choose “restore desktop with files” from the dropdown menu to replace
the currently opened files with the files stored in the desktop-file.

Hint:

You can also use the mru-function to open a desktop. Click on the dropdown button
next to the load button and select the desktop you want to use. Press the ctrl-key while
doing so to load the desktop with the files stored in the desktop-configuration.

Saving a Desktop
Follow these steps to save a Desktop:

1. Select “Start→ Desktop→ Save” from the menu.

2. Save Desktop will appear.

3. Select the folder in which you want to save.

4. Enter a file name for the Desktop and click on Save.
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Worksheets
Copy as image

All worksheets support Copy as image.

Worksheet items can be automatically arranged

– In the “Windows” ribbon category we added the function “Tile controls” to tile all
worksheet controls on the current worksheet.

– The function is also available if you open the context menu of the worksheet control
caption/border.

2.2.3 Ribbon
WinDarab menu and toolbars are organized in a Ribbon. The Ribbon is designed to help
you quickly find commands and perform tasks. The commands are grouped logical to-
gether and placed in a tab. Darab Ribbon consists at least the following tabs:

1. Start

2. Tools

3. Windows

Start
The tool tabs on the Start tab depend on which analysis window is currently active. If no
analysis window is opened, the Start tab contains the following tool tabs (see chapter
Analysis and Oscilloscope)

– Desktop

– Settings
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When at least one analysis window is opened the analysis window specific tool tabs will
be displayed right of the Settings tool tab.

For example, here are the tool tabs of the oscilloscope:

Desktop
The Tool tab Desktop provides tools for creating, loading, and storing a desktop.

Start → Desktop → New This item will destroy all worksheets and create a new Desktop,
with one worksheet containing a single oscilloscope. See Desktop for a detailed descrip-
tion.

Start → Desktop → Load Open the Load desktop dialog box and select the desktop you
want to load.

Select the Desktop file.

Click on the Open button.

Start → Desktop → Load (Dropdown) You can also open a recently opened desktop by
clicking on the dropdown-button right to the Load-button and chose Desktop-file from
the list.
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Start → Desktop → Save Open the Save desktop dialog box to save the current desktop.

4. Navigate to the folder you want to store the current desktop.

5. Enter the desktop name in the text field Filename.

6. Click on the Save button.

Settings
The tool tab Settings provides tools for editing, loading, and storing of Analysis windows
and oscilloscopes settings.

The Settings tools:

Start → Settings → Edit – edit settings of an analysis window or oscilloscope.

Start → Settings → Load - load settings of an analysis window, oscilloscope, or instru-
ment panel.

Start → Settings → Save - save settings of an analysis window, oscilloscope, or instru-
ment panel.

They are described in the chapters Oscilloscope, Analysis, Telemetry.

Tools
The Tools tab contains:

– Mathematics

– Settings
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Mathematics
The tool tab Mathematics provides tools for managing mathematical functions and condi-
tions. This will help you to solve a series of mathematical and analytical problems.

The Mathematics tools:

Tools → Mathematics → Functions – allow you to define filters, lookup tables and math
functions

Tools → Mathematics → Conditions – allow you to define conditions to exclude certain
data from consideration during data analysis.

– This will be deprecated in the future and combined into functions with more control.

They are described in detail in the chapters Mathematical Channels and Conditions.

Additional tools:

Tools → Mathematics → Alias channels - define an alias to another channel.

Tools → Mathematics → Setupsheet - dynamically create channels based on a special
file that lives with your data.

Settings
The tool tab Settings provides the possibilities to manage channel settings, channel colors
and general WinDarab settings.

The Settings tools:

Tools → Settings → Channels– allow you to define basic settings for each channel in
WinDarab

Tools → Settings → Channel Colors – allow you to define the color of each channel in
each overlay.

Tools → Settings → Program – allow you to make basic WinDarab settings.

They are described in detail in the chapters Channel Settings and Settings.

Windows
The Windows tab contains the following tool tabs.

– Dockable windows

– Control Bars

– Workbook

– Worksheet

– Worksheet controls

– All controls

– Current control
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– Desktop layout

Dockable Window
WinDarab manages the following dockable windows:

– Files – see chapter File Explorer Window

– Channels

– Colors

– Racetrack – see chapter Racetrack.

– Events (old) – see chapter Events ← this will be depracated/removed in future version.

– Events

– Event Rules

Racetrack

Click with the left mouse button on Windows → Dockable → Racetrack to open a
Racetrack window.

The Racetrack window has three different display states. You can select one by clicking on
the Racetrack-Drop down button and selecting an item.

Illustration 1:

Dockable window

Dockable window is the standard option. In this state, your Racetrack window is docked
wherever you chose and can be handled like explained in The Racetrack Window.

Transparent window

The transparent window is activated when you click on it or when you drag the docking
racetrack window and drop it somewhere without docking it. As soon as the window loses
the focus, its background disappears and all you see is the racetrack.
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You can move the racetrack by CTRL + left click and drag to another location.

Alternatively, you can move your cursor over the racetrack and hover for one second to
display the background again. Then the racetrack can be moved by dragging the window.

Hidden

The last option is to hide the Racetrack window completely.

Hint:

– You can quickly switch through all the states by clicking on Windows → Dockable
windows → Racetrack.

Further Racetrack information can be found at The Racetrack Window.

Channels

Press F3 key to open the Channels Window.

Click with the left mouse button on Windows → Dockable → Channels to open the
Channels window.
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The Channels window displays a list of WinDarab channels. WinDarab channels are di-
vided into the following channel lists:

– Measurements channels

– Math channels

– Virtual channels

– Internal channels

– Temporary channels

The Channels window toolbar allows you to select which channel list should be currently
displayed.

The Channels window provides you the possibility to drag & drop a channel to an oscillo-
scope, analysis window or instrument panel.

The channel list also offers a channel search function. You can find a channel in the chan-
nel list by entering the name of the channel in the text field under the window tool bar.

Channel Info

The channel info is a small region under the channel list. In this region you see detailed in-
formation about the currently selected channel like the sample rate, the data source, or a
selected math channel’s expression.

You can resize the area by dragging the border. You can also max-/minimize it by double
clicking the border.

Colors

Click with the left mouse button on Start → Dockable → Colors to open a Colors window.
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The Colors window provides you the possibility to change the color of a channel, overlay,
or something else by drag & drop the color to the corresponding element.

Control Bars
The ribbon Control Bars tab manages the Outing Bar

Click with the left mouse button on Windows → Control Bars → Outing Bar to enable/
disable the Outing Bar.

Outing Bar

The Outing Bar gives you an Overview over the Overlays, their laps and the position to
each other.

The current visible area is marked yellow; the current cursor position is visualized with a
dotted line. When the Area or the Cursor-position changes, the Outing Bar will update
automatically.

– Click with the left mouse button on a lap outside the visible area, to set the visible
area and cursor-position to the exact position in the lap where it was in the previous
selected lap.

– Click and drag the visible area in the Outing Bar to move the visible area in the Oscil-
loscope. The cursor-position moves with the visible area.

– Click and drag the border of the visible area in the Outing Bar to increase or decrease
the Size of the visible area i.e., zoom in/out.

– Double-click on a Lap moves the visible area to the size and the position of the selec-
ted Lap i.e., zoom to lap.

Workbook
The ribbon Workbook tab allows you to

– Organize your workbooks.

– Insert a new workbook.

– Delete a workbook.

– Import / Export a workbook.
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Worksheet
The ribbon Worksheet tab allows you to:

– Insert a new worksheet.

– Delete a worksheet.

– Rename the worksheet label.

– Change the color of the worksheet tab.

– Import / Export a worksheet.

Worksheet controls

WinDarab manages the following worksheet controls (windows):

– Oscilloscope

– Inform

– x/y-Plot

– Histogram

– Distribution

– FFT

– Flow Chart

– Min/Max-Table

– Outings report

– Lap Analysis

– Instrument Panel

The tool tab Worksheet controls allow you to open one or more worksheet controls.

– A worksheet control could be an oscilloscope, analysis window, inform window or in-
strument panel.

Hint:

Click and drag a symbol with the left mouse button onto your workspace to open the cor-
responding worksheet control.

All controls
With the All-controls tab, you can change the caption for all your worksheet controls and
tile all of your active worksheet's analysis windows.

– Click with the left mouse button on Windows → All controls → Show captions to
show/hide the caption for all your worksheet controls.

– Click with the left mouse button on Windows → All controls → Tile to make all ana-
lysis windows on the current worksheet be tiled to the same dimensions.
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Hint:

– When you hide the caption of a single window while your other windows still have the
caption shown, the Show captions button will be unchecked. You can click on the
Show captions button now to show all captions again or press the button two times
to hide all captions.

Current control
The Current control tab allows you to adjust the current active control.

– Click with the left mouse button on Windows → Current control → Show caption to
change the visibility of your current active control.

– Click with the left mouse button on Windows → Current control → Maximize to
toggle between the normal size and the maximum size of your current active control.

– Click with the left mouse button on Windows → Current control → Close to close
your current active control.

Hint:

– These functions can also be used by right-clicking on a windows caption-bar and se-
lecting the item from the context-menu.

Desktop layout
Click with the left mouse button on Windows/ Desktop layout/ Toggle to toggle
between 2 different desktop layouts.

Hint/Hidden Gem:

– When you click on Toggle for the first time, the docks won’t be visible. You can now
adjust your workspace. Both workspaces will be saved when you close WinDarab, so
they are still the same after the next start.

– This is commonly used as a 'Setup' layout and an 'Analysis' layout.

– Setup = Get your plots setup the way you like, load data, etc.

– Analysis = remove any extraneous windows and just look at data with maximum
screen pixels

2.2.4 File Explorer
The usability of WinDarab’s File Explorer is much the same way as Windows’ Windows Ex-
plorer.

File Explorer is used to manage all WinDarab supported files:

– WinDarab 7 files

– WinDarab 6 files

– WDServer Telemetry files

– Linked files

– MDF Files

– MSX files

Hint:

In addition to access files on existing disk drives you access them through locations. A loc-
ation in fact represents the affiliation of files with a specific drive and folder. Using loca-
tions simplifies access and management of files. See chapter Locations.
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Opening Files
From File Explorer Window

1. Open File Explorer Window if not opened.

2. Choose “Windows → Dockable Windows → Files*” or press “F3” to open the File Ex-
plorer Window.

3. Choose Open file in the File Explorer Window toolbar.

From Darab Ribbon

Choose WinDarab-Button/ Open measurement file in Darab ribbon.
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Open File Dialog

The File Explorer window is divided into:

4. Open File dialog box.

5. File Inform window.

The Open File dialog box allows you to browse through drives, folders, locations and se-
lect the file you want to open.

This area displays sub-folders and files contained in the selected folder.

To select an item, you can either use your keyboard or your mouse. Whenever possible a
preview of the selected file will be displayed.

If the selected file has a password protection act as shown in Open Password-protected
Files.

Hints:

You can select more than one file by using the Ctrl- or Shift-key. Whatever action you
have chosen (e.g., open or delete) will be performed for each file and in the selection or-
der.

The combo box “Show Inform” allows you to choose whether the File Inform window
should be shown or not.

Folders can be created, renamed, and deleted in the Open File dialog box in the same way
as regular windows folders in the Windows Explorer.

Open Multiple Files

– Open the selected file(s) by pressing the “Open”-button. If there is more than one file
selected, the files are opened as one file. You can also select “Open as single files” in
the “Open”-button’s dropdown list to open all selected files as single files.
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– If you use the Shift-key while pressing the “Open” button, the “open linked files”-dia-
log appears. In this dialog you can change the order of the linked files, delete single
files from the list or save the list as a predefined filegroup in the same folder as the
used files are saved in. After that, you can open this exact filegroup by opening the
generated filegroup-file.

File Inform

File Info is divided to 3 groups:

6. Comments

7. Statusblock labels

8. CardMemory Info

To select one item, navigate with the arrows.

These enables you to view the following file information:

Comments Configuration Tools Display configuration tool information stored
in the WinDarab file.

Comment field Display the vehicle settings.

Comment Display the logger data specific comments.

Statusblock label Statusblock label Display the available status block label.

CardMemory Info Logbook Display memory card logbook.

Measinfo Display memory card measurement info.

Sections Display memory card sections.

Locations

You can save data in any folder and on any disk drive you choose. In addition, it is pos-
sible to create locations. WinDarab defines the special folder Data file location as con-
tainer for all locations. A location is a link to a specific folder which enables you to save
files in, or open files from, different locations quickly – without having to navigate the en-
tire drive and folder structure.
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Add Folder to Locations

Follow the steps below to add a folder to the Data file locations folder:

9. Open the File Explorer

10. Choose the folder you want to define as location.

11. Click on the button:

 

12. A link to the selected folder is generated and added to the Data file locations folder.

Hint:

A location can be deleted or renamed in the same way as regular windows link to a folder
in the Windows Explorer.

File Explorer Window
The File Explorer Window displays and manages all logger data files opened in the File Ex-
plorer (see Opening Files). WinDarab supports the following logger files:

– WinDarab 7 Files

– WinDarab 6 Files

– WDServer Telemetry Files

– Linked Files

– MDF Files

– MSX Files

Open File Explorer Window

Select Windows → Dockable windows → Files from Darab Ribbon to open the File Ex-
plorer Window.
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The File Explorer Window is a dockable window. It contains a toolbar and a WinDarab file
list window.

File Explorer Window Toolbar

Opens the File Explorer (see File Explorer)

Close the selected file

Create an overlay to compare files/laps (see Overlay). Each overlay is displayed in a differ-
ent color.
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Zoom and compare fastest laps of each overlay.

Change the color of the selected overlay.

Reduce the lap list. The "outing #"- line under the file name in the file list will not be dis-
played.

File Explorer Window File List

The file list contains a list of all opened files in the File Explorer.
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Under the file name the outing number is displayed. The laps are listed under the outing
number. Each lap is indicated with a lap number and a lap time. The fastest lap is marked
with the label Beschreibung:  . If an overlay is assigned to a lap it is displayed by a
colored point before the lap number.

Hint:

If the menu point "Reduce lap list" is selected the line "Outing #" will be hidden.

File Explorer Window Context Menu

After right-click on an item in the File Explorer window a context menu opens. The context
menu contains the following options (some variations depending on file or lap is high-
lighted):

Open Opens a new file.

Append Opens a new file and appends it to the selected lap.

Replace With this menu-item, you can replace the file by another file. After
clicking on the item, the open-file-dialog opens, where you can se-
lect the file replacing the file in the file-explorer.

Setupsheet Open the setupsheet editor

Out-Lap Sets the "Outlap" flag on the selected lap

In-Lap Sets the "Inlap" flag on the selected lap

Ignore as fastest
Lap

Ignore the currently selected lap as "Fastest Lap"

Renumber Opens a sub-menu to provide options for renumbering laps (alters
the lap-stack)
This is useful with missed beacons or manually inserted

Close You can use the close menu item to close this file.

Fastest laps Zoom and compare fastest laps of each overlay.

Reduce lap list Reduce the lap list. The "outing #"- line under the file name in the
file list will not be displayed.
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Overlay
Overlay provides the possibility to compare laps/files and to add a lap/file to an oscillo-
scope (see chapter Oscilloscope). Overlays are displayed as points in different colors.

By default, at least one overlay exists in the File Explorer Window. If you open a file in the
File Explorer (see chapter File Explorer) the overlay is assigned to the fastest lap of the file.

Overlay Context Menu

Hint:

Click with the right mouse button on one overlay point or the overlay row to open the
overlay context menu.

Add Add an overlay in the overlay list under the File Explorer window
toolbar. If at least one file is opened in the File Explorer window
the overlay is assigned to the next longer lasting lap without
overlay in the first file of the list. If each lap has an assigned over-
lay already all subsequent overlays will be assigned to the longest
lap in the first file.

Show overlay Globally hides this overlay and all associated channels
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Replace file Replace the file of the selected overlay. The File Explorer is
opened and allows you to select the new file.

Detach file Detach the file from the overlay. After this, the overlay has no file.

Change color A color palette is opened that allows you to select the color of the
selected overlay.

Overlay Coloring Allow selected overlay to use the global selection for channel col-
oring or override it

Delete Select this menu point to delete the overlay.

Pin lap Pin this lap, scrolling the cursor will stop at the lap end. Can also
be used to set a base file for referencing when looking at tele-
metry on another overlay

Use as x-axis overlay Select this option to use this overlay as base-overlay for the x-
axis.

Use as base for dif-
ferences

Select this option to use this overlay as the base-overlay for dif-
ference-channels (comparing 2+ overlays).

Pin Lap
This function can be used to compare one (or more) overlays to a datum lap. This is useful
for telemetry.

13. Create an overlay.

14. Open the file containing your 'Datum' or 'Reference' lap.

15. Assign an overlay to the lap to be pinned (Datum/Reference) lap.

16. Right click on the orb → Select Pin Lap

17. Assign the other overlays to your telemetry source, or files you would like to compare
to the Pinned Lap

Hide Overlay
– The visualization of an overlay can be disabled (hidden) – while the file keeps opened

and attached to the overlay.

– To hide an overlay, use the overlay context menu in the file explorer. An overlay is
shown again, if you select the same context menu item or – simly – by clicking into
the overlay column to select a lap. Alternatively, you can use the “Hide” context menu
in the oscilloscope (“H” key).

– What happens if an overlay is hidden:

– The oscilloscope hides all channel of hidden overlays.

– The trackmap doesn’t show the position of the car.

– All analysis windows hide the evaluation results of hidden overlays (except
LapAnalysis)
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– If an overlay is hidden most calculations for the attached files are stopped/dis-
abled.

Only “Event rules” and “LapAnalysis” are still evaluated.

Drag and Drop
Files can be opened by dragging them from your windows file system into the WinDarab
FileExplorer. Depending on the location where you drop the file, the file can be added to
the file-list, replace another file, or replace an overlay.

Adding a file You can add a file to the file-list by dropping it anywhere on the list
but an existing filename or overhead-column. Your files will be added
to the list. If you add more than one file to the list, as default, they will
be added as one file. To open more files as single files, press Ctrl while
dropping the files.

Adding a file to
a Filegroup

You can add one or more files to a filegroup by dropping them over an
existing file. When you drag the files over an existing file, the target is
highlighted to show that you can add the files.

Replacing a file You can replace one or more files by dropping a file over an existing
file while pressing the Shift-key. When you drag the files over an exist-
ing file, the target is highlighted to show that it can be replaced.

Replacing an
overlay

Dropping a file on an overlay-column adds the file to the file-list and
assigns the columns overlay-color to the new added file. If this re-
moves the last overlay from a file, this file will be removed.

File System Monitoring
When a file is opened in the file explorer, the containing folder as well as all his sub
folders are monitored for new darab files. When a new darab file is created in a monitored
folder, darab shows a balloon tip to let the user know that a new file was created.

In addition to this balloon tip, a region on the bottom side of the file explorer is created
where all new files are listed.

You can open these files by dragging them into the file explorer (see Drag and Drop) or
by using the context menu.
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Hint:

The separator between the new files and the file explorer can be dragged to reduce the
size of the region. You also can minimize/maximize the region with a double-click on the
separator.

2.2.5 Channel Settings
You can make basic settings for each channel in WinDarab.

For each individual channel following settings are provided:

– Description

– Format (numerical)

– View Min

– View Max

– Signal (signal curve format)

– Separate Bits

Making Channel Settings
Select “Tools→ Settings→ Channels” in Darab Ribbon to open the “Channel Settings”
dialog box.
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The Channels are divided into five channel types:

– Measurements channels

– Math channels

– Virtual channels

– Internal channels

– Temporary channels

Click on Show measurements button to select and display the Measurements chan-
nels list.

Click on Show math channels button to select and display the Math channels list.

Click on Show virtual channels button to select and display the Virtual channels list.

Click on Show internal channels button to select and display the Internal channels list.

Click on Show temporary channels button to select and display the Temporary chan-
nels list.

Click on Show/Hide all channels button to (de-)select and display/hide all channels.

Channel Format

For each channel in the lists the following settings can be defined:
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Description A description for the channel can be entered in the text field.

Format Define the display format of numbers.

Other
Formatters

These can be used to show text representations of the data. This is useful
when the channel value is an error code that corresponds to a text value
Use 'Other Formatters' → Other' to create formatters

The following formats are provided in the Format combo box of each channel:

Channel Visualisation

View Min You can enter the value displayed as minimum for the channel.

View Max You can enter the value displayed as maximum for the channel.

Signal Determine the format for display of the signal curve.

The following formats are provided in the Signal combo box of each channel:

– Analog - values are interpolated.

– Digital - sampling points are represented by square wave signals.

– Dotted - each sampling point is represented by a dotted line.

– Bits - each channel bit is interpreted as a separate signal and represented by a square
wave signal.
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Separate
Bit

With this option selected, single bit channels will be created for each bit of the
measured channel. If selected each single bit will be shown as a channel.

You can now select each one of these bit-channels individually in the channels pane.

Importing Descriptions
WinDarab enables you to import description for channels from a (named) object store.

Follow these steps to import a (named) object store:

1. Open the “Channel Settings” box by using the “Tools→ Settings→ Channels” menu
item.

2. Click on “Import OSP/A2L”.

3. Now select the (named) object store that contains the descriptions and click “OK”.

4. The descriptions will now be imported.

5. Click on “OK” to close the “Channel Settings” dialog box.

Channel Colors
Select “Tools→ Settings→ Program” to open the Channel Colors Dialog

This dialog allows you to assign different colors for different overlays to specific channels.
The number of overlay-columns in the dialog equals the number of overlays in the File Ex-
plorer.

Automatic is recommended. When left in this mode, WinDarab will automatically choose a
color for the channel that has a good contrast to the selected color scheme.

New Colors
Oscilloscopes and XY plots can get very busy when multiple signals are added. We have
added 20 distinct colors to help.
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Customize
These colors can be customized in setting.ini.

[Options]

DisinctColors= 0xe6194b, 0x3cb44b, 0xffe119, 0x4363d8, 0xf58231,

0x911eb4, 0x46f0f0, 0xf032e6, 0xbcf60c, 0xfabebe, 0x008080, 0xe6-

beff, 0x9a6324, 0xfffac8, 0x800000, 0xaaffc3, 0x808000, 0xffd8b1,

0x000075, 0x808080, 0xffffff, 0x000000__

Here’s an alternative set of colors:

DistinctColors=0xa6cee3, 0x1f78b4, 0xb2df8a, 0x33a02c, 0xfb9a99,

0xe31a1c, 0xfdbf6f, 0xff7f00, 0xcab2d6, 0x6a3d9a, 0x8dd3c7,

0xffffb3, 0xbebada, 0xfb8072, 0x80b1d3, 0xfdb462, 0xb3de69, 0xfc-

cde5, 0xd9d9d9, 0xbc80bd, 0xffffff, 0x000000

2.2.6 Feedback & Support
Bosch Motorsport appreciates contructive feedback from WinDarab users. This feedback
includes bug reports, feature requests, documentation requests, and more.

Bug reports can be created through WinDarab natively or in Windows Task Manager they
can then be submitted to Bosch Motorsport for review. Bosch Motorsport is constantly
working to improve WinDarab. If possible, please use the latest version of WinDarab to
see if your bug had already been resolved.

Report Content
There are three components to maximize Bug Report effectiveness.

1. Problem Description

– Video and Pictures Help

– Workflow to Reproduce Issue

– Computer OS and WinDarab Version

2. Feedback Files

– WinDarab Generated

– Windows Generated

3. Supporting Files

– Formulas

– Desktop

– Data Files

Feedback Files
Via WinDarab

Feedback files can be created by WinDarab in two ways. Both methods write the files
to: %WinDarab Install%/Minidump folder location. If large data sets or desktops are
open, please give it some time, two zip files will be created for each feedback.

Automatic

WinDarab attempts to create crashdumps automatically when a crash is detected. If this
happens the picture below will be shown when the crash occurs

https://github.com/boschmotorsport/WinDarab/releases
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Manual

Press Left Ctrl + Right Shift + F10 and hold for 2 seconds. The window below will show
up, click yes to create the crashdump.

Via Windows Task Manager

Feedback files can also be created by Windows by pressing Ctrl + Shift + Esc then right
click on the WinDarab process and select Create Dump File. This will create a .dmp file in a
location specified by Windows. This method is usually only required if WinDarab is unable
to make its own file or Bosch Motorsport requests the Windows crashdump.

Via ProcDump Utility

Rarely a crash occurs which the WinDarab built in feedback agent cannot catch and it is
not possible to get to Windows Task Manager to get a .DMP file. If this occurs in a repeat-
able fashion:

4. Take note of what causes the crash and provide detailed notes on how to reproduce.

5. Use the procdump.exe tool available from Microsoft

6. From the command line in Windows execute the following command (in the folder
where the executable for procdump exists)

# The following command triggers procdump to start and watch the

process 'darab.exe'

# If a crash occurs it will create a .dmp file

https://docs.microsoft.com/en-us/sysinternals/downloads/procdump
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# ZIP the .dmp file and get it to your Bosch Motorsport contact

procdump -e -ma -w darab.exe

Submitting the Bug Report
Send the three parts of the crashdump to your Bosch Motorsport support representative
via the method of your choosing. Recommended methods:

– Google Drive

– Dropbox

– Bosch Ad-Hoc Data Exchange Request

Bosch Motorsport Commitment to Continuous Improvement

Feedback and support are always welcome; we are actively working to improve our soft-
ware. To give feedback please contact your Bosch Motorsport dealer or support person.

2.2.7 Data Logger Import
The data logger import dialog is a tool to import data from various sources such as burst,
device, flashcards or USB-sticks.

Launching Data Logger Import Tool
The data logger import tool can be launched in two ways:

1. WinDarab via the Orb

– If "Read data logging from logging device" is selected for the Quick Access Tool-
bar:
The Data Logger Import Tool can be launched by clicking the offload icon.

– Click Orb → Read data logging from logging device. Then select the Data Logger
import radio button and click Ok.

2. Standalone Executable

The Data Logger Import Tool can also be launched by opening the executable DataLog-
gerImport.exe found in WinDarab's install directory. Data Logger Import is a stand-alone
tool.

Using Data Logger Import Tool
The tool contains of three tabs to control the settings and the status of the importing.

Settings Tab

The settings tab helps you customize the import-procedure.

https://github.com/boschmotorsport/WinDarab/wiki/Feedback%20and%20Support#report-content
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Import Source Settings

Select the sources that you want to monitor. Available are:

– FlashCard/USB-Stick

– Device

– Burst

If the FlashCard/USB-Stick checkbox is checked, an inserted flashcard or USB-Stick will
be recognized when connected and shown in the current import-tab.

Device and Burst enables the monitoring of the IP-Addresses, that are chosen in the
burst or device-settings visible in the lower half of the dialog.

Note: Device and Burst can’t be selected at the same time. If you

enable one of them while the other one is enabled, the other one

will be disabled.

The settings for each source are on the bottom half of the dialog.

Note: The individual settings are only shown when the correspond-

ing import sources are enabled. For the Device/Flash settings to

be shown, at least one of these sources must be enabled. Accord-

ingly, burst must be enabled to show its settings.
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Device/IP In the Device/IP-field, you can chose from a set of pre-defined IP-addresses
or insert your own IP-address.
This has no effect for Flashcards or USB-Sticks as they have to be inserted
into the PC where DataLoggerImport is running.

Export file The export file-selection defines which fragments should be combined to
one single file.
"One file" merges every imported fragment into one big file. The option
"as stored on the device" doesn't merge any fragments and results in one file
for each fragment.
"One file for each lap" merges every fragment of the same lap into a file
"One file for each outing" merges every fragment of the same outing into
one output file.

Save files
in

This field specifies the base folder, where the measurment files are stored.

Subfolder
template

Specify a naming for the subfolders that can be created when files are being
imported. This field also contains a dropdown menu with the 5 most recently
used templates.

Filename
template

Specify the filename that is given to the imported file(s). This field also con-
tains a dropdown menu with the 5 most recently used templates. There are a
lot of placeholders for the template which can be inserted manually or
chosen by the template-button right to the combo-box.

The following wildcards may be used in Subfolder and Filename templates:

– [year] Year*

– [mon] Month*

– [day] Day*

– [hour] Hour*

– [min] Sec*

– [cardinfo] CardInfo entry (configuralble through RaceCon Recording name)

– [lap] Number of the first lap

– [outing] Number of the outing (of the first lap)

– [fragment] Number of the file fragment

– [n] Consecutive numbering (allowed in file names only), this is always recommended
to be used. In the event naming collisions occur files will have a consecutive number
appended to the name.

– [fastlap] Fastest lap (allowed in file names only)

– [fastouting] Outing containing the fastest lap (allowed in file names only)

– [fastlaptime] Laptime of the fastest lap (allowed in file names only)

– [RecDateYear] Year of the recording (Make sure the clock time on the logger is set)

– [RecDateMon] Month of the recording

– [RecDateDay] Day of the recording

– [RecStart] Time the recording was started.

– [RecEnd] Time the recording ended.
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Note: If you use a finer template than the merge-option, it will

be replaced by ‘-1’. So, if for example all fragments of an outing

are merged and you are using the [lap] template, it will be re-

placed by ‘-1’, even if there is only one lap in the outing.

- Note: You can also specify a format for the following templates:

[outing], [lap], [fragment], [fastlap] and [fastouting]. Add a

number between the template name and the closing bracket to spe-

cify the shown digits. For example: if [fastouting] results in 12,

[fastouting03] results in 012.

Import all on connect

This option must be checked in order to import all new files directly - once a source is
found. For example, the flashcard-data is imported right after the card has been inserted
into the computer. If this option is not enabled, you must manually import the files in the
current import tab. Additionally you can choose exactly the fragments you want to import.

Delete transferred files

With this option enabled, the source files on the device are deleted after they have been
successfully imported.

Common Options

Here, the password for the resulting files can be set. You can select a previously set pass-
word or create a new password with a click on the “New”-Button. If the “Force pass-
word…” option is disabled, no password is set.

Note: A password defined in Racecon will supercede the password

settings here.

The “Delete ARP cache…” option deletes the ARP-entry for the host-IP if a ping failed.
Use this option if you can’t reach the host even if you know it is reachable. We recom-
mend activating this feature.

Note: The settings that you change need to be committed before

they are applied to the import. Do this by clicking the __ “Apply

changes”__-button.

Advanced Settings

Further settings can be found by clicking on the “Advanced…”-button.
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In the advanced settings, you can configure paths for your downloads and your work-
path. For more information about the import-process see Import Process.

You can also change the visibility of the “Reimport files…”-button. For more information
about the “Reimport files…”-button see Current Import-Tab.

Comment Fields

You can view and edit the default values of the comment fields by clicking on the “Com-
ment Fields” – button.

In the Comment Fields dialog, you see all user defined Comment fields with their name,
the unit and the default value. You can edit the default value in this dialog by selecting
the value cell of the comment field.
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Important: Comment Fields are the precursor to Setupsheets. While these are still sup-
ported, they are not recommended.

Current Import Tab

The current import-tab shows you the import-state of your currently active data-source.

Data Source

Without an import-run, the source-field shows information about possible actions you
could do like inserting a flashcard or status-information like searching for a burst-device.

If an import is active or a source is found, the “Data source-field” shows the connected
data-source. Also, it indicates the status of the import with colored bars.

The field right to the data source field shows the download-speed. This is only shown
when you are in the download-phase of an import.

Network

The network shows what measurment media you are connected to. In addition, you see
the latency to this host.

The main part of this page shows the import status.

At the beginning of the import run, it is possible to select or deselect any fragment you
want or don’t want to import in the “Get”-column. This requires the “Import all on con-
nect”-option to be disabled in the settings-tab.

Note: Initially the check marks are set for the files that have never been imported from
this source. So, if a fragment is imported but not deleted once, it will not be checked ini-
tially (and thus it won’t be imported when the “import on connect” option is enabled.

With a click on Import, the import-process is started. Now you see the status of each frag-
ment, lap, outing and so on as the import-process progresses.

First the data is downloaded from the device and then converted into a temporary file.
After the conversion, the files are merged as selected in the settings-tab. If the import was
successful, the items are marked with a green background.

You can cancel the importing by clicking on “Cancel” while the importer is running.

The dialog automatically selects the current active fragment. You can disable this feature
by using the scrollbar or disable the auto-scroll-option at the bottom of the page.

https://github.com/boschmotorsport/WinDarab/wiki/Setupsheets
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When the import is finished, the Progress-column shows the success of the import-pro-
cess.

Reimport files...

You can import already downloaded raw measurement files by clicking on “Reimport
files…” and selecting the files from the work-folder. This is especially useful when you
must import raw data again but don’t have access to the source device.

Note: If there is no “Reimport files…”-button on the Current import-Tab you must make it
visible by selecting the option in the Advanced settings.

Recent Import Tab

The recent import-tab shows the recent imports and their success.

In this tab you find all previous import runs and their success-status. As you can see in the
screenshot above, all import-runs have their own root-entry that can be expanded like in
the current import tab.

An import run is automatically added when the source is removed, and the import is fin-
ished.

The status of every imported fragment is displayed in the success-column. Here you see
which fragments were imported correctly, and which were not imported, which files have
been created and which downloads have failed.

Troubleshooting Data Importing and Tips
Import Process

The Importing of a file runs in four steps that can run partial parallel.
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3. The file is downloaded from the device. In this step, the data is copied from the
device to your local hard drive. You can specify this folder under Settings→Ad-
vanced→Download folder.

4. The downloaded file is then converted into a temporary file. This step doesn’t need
the file to be downloaded completely. As soon as there is data downloaded to your
hard drive it is converted. As the download folder, the work folder can also be spe-
cified in advanced settings.

5. When all parts for the final merging (according to the “export file”-option in the set-
tings-page) are converted, they are merged into a single file that can be used in Win-
Darab. While the merging is in progress, a temporary file is written into the “save
files”-folder specified in the device settings.

6. When the file is merged completely, it is moved to its final folder (“save files”-folder
combined with the specified subfolder) and renamed according to the template as
defined in the device-settings.

After the files have been merged successfully, the temporary files are deleted.

Tips

– Setting File Paths: As you can see, you have many options to control the importing by
setting the paths. And there is also much performance increase that can be gained by
setting the paths wisely.

In almost every step, files are read and written to your hard drive(s). So, if you want a fast
download and have more than one hard drive installed into your pc, it is advised to select
your download folder to be on another physical hard drive than your other folders. This
way the download can use the full transfer rate of the hard drive.

– File Sizes: Have an eye on the file-sizes. The files on your device are compressed.

As the data-import is optimized mainly towards speed, the imported files are uncom-
pressed and can be significantly larger than the original data. Additionally, there are the
downloaded, converted, and merged files saved on your hard drives during the import
process, so make sure you have enough free space to support it.

Common Issues

– Data logging import issues launching due to WinDarab crashing or license is-
sues: Launch standalone DataLoggerImport.exe.

– Cannot get connection to device: Check wiring, physical connection, device power,
and firewall settings. Create a firewall exception for Data Logger Import tool and Win-
Darab.

– Download not completing: Check firewall settings. Do not plug another USB device
in while the download is ongoing.
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2.2.8 Program Settings
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Colors

Modify these settings to change the default colors of the WinDarab user interface.

Color Theme

To change to other pre-defined color themes, use the Style Menu in the Top Right.

We generally recommend Bosch Black for analysis.

If you are in direct sunlight, Bosch White will give better visibility.
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Measurement Window

Single Value Per X Axis Point

When viewing very large data sets and you are zoomed out there are not enough pixels
on the screen to represent each X axis point (time/distance). WinDarab can filter down the
data and generate one value to represent a range of x axis points so that a single value
can be plotted per pixel.

Setting Active:

Setting Disabled:

This setting only affects how the data is shown, underlying calculations (outing report/
math channels/etc) are un-affected.

Automatic Switch between x- or y- Axis Zoom
In many analysis windows Right Click and Hold + Mouse left/right or up/down will allow
the user to adjust the zoom level.

If this setting is disabled:

– The initial movement of the mouse defines the zoom axis.

If this setting is enabled:

– The final movement direct of the mouse defines the zoom axis.
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Files and Folders

Folder Monitoring

WinDarab will monitor the file system for new data files. See File System Monitoring

The default option is to monitor all folders where you open data from. If you have special
sync folders on your machine, you can change to the 'This folder' setting and define it.
(This is generally not needed)

Lap Distance Normalization

WinDarab will, by default, try to normalize the distance of each lap to the currently selec-
ted racetrack.

– If you don't want the normalization to occur select Never.

– If you want each and every lap (in/out included) to be normalized: select Always.

– If you want a definable deviation: enter it (5 % is default)

Normalization Calculation

The normalization calculation is a scalar value multiplied by the logged/calculated value of
unnormalized lapdistance.

Pseudo code to demonstrate normalization.

scalar = selected_racetrack_length / current_lap_length

lapdist = current_lap_lapdist * scalar

More advanced algorithms can be employed using the COM-API.

DIST Flag

https://github.com/boschmotorsport/WinDarab/wiki/File%20Explorer#file-system-monitoring
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This flag will appear in the File Explorer if:

– The lap length does not match the loaded trackmap

Data Compression

If you want WinDarab to create compressed files when Exporting or Downloading from a
logger, enable this setting.

– Opening compressed files is supported in 7.7.36 and higher versions.

Miscellaneous
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Telemetry

Activate WinDarab if Alarm Occurs

This setting will cause WinDarab to take the Focus if an alarm occurs.

Network Adapters for Telemetry

You can define specific network adapters on your machine to look for WDServer.

Most customers will not change this setting.
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Special Channels

See the section Special Channels [} 163]

Physical Units

Users can define unit conversions if they prefer to work in non-standard units.
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Comments

Comments can be added to each datafile. Use this dialog to define what file comments
you would like to be able to write to each file.

Comments can be defined in the Data Logger Import tool [} 44] or by highlighting an
Outing Report then on the ribbon Start → Comments.

File Open

Comments can be viewed for each file when in the File Open Dialog

Outing Constants

Comments can be used for File Constants for use in Math Functions. However, they are a
bit clumsy for this task.

– We recommend using Setupsheets [} 152] instead.
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Import Defaults

This dialog is for the much older import tool and will be deprecated/removed in a later
version of WinDarab.

2.3 Analysis Windows

2.3.1 Oscilloscope

X Axis
Settings for the X Axis can be found by Right Clicking anywhere on the X Axis scale.

From here you can control:

– Start/End/Range of the X axis.

– Time in seconds or Distance in meters

– Lap based x-axis (X Axis in lap distance or laptime)



WinDarab V7 | 2

Bosch Motorsport WinDarab V7 Wiki Manual 61 / 224

Middle Click Window
Settings controlling the oscilloscope are available by Middle Clicking or Left + Right
Clicking.

From here, you can control:

– Settings related to the selected Channel

– Settings related to the Zoom level

– Add/Remove Chart Areas

– Enable/Disable File Shifting (Click + drag an overlay)

– Define a File Shift in X-Axis units (seconds/meters)

– Align lap triggers of different overlays

– Set or Remove a Tag

Automatic Y Axis
– After the user added a y-axis for a channel in the oscilloscope, the y-axis context

menu can be used to turn the y-axis into an “automatic y-axis” (click “Selected chan-
nel” in the context menu)

– An automatic y-axis always shows the corresponding y-scale for the selected channel
in this area.

– A second click on “Selected channel” REMOVES the automatic y-axis.
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– If a channel is dropped onto an automatic y-axis, the y-axis is a normal axis for the
channel.

– Note: A automatic axis always fills the complete height of the y-axis area and cannot
be changed (height or vertical position).

Auto-align Telemetry and Logged Data
– If the option “Auto-Align running laps” is enabled all running laps of telemetry

streams are automatically aligned and the oscilloscope is scrolled so that the aligned
lap trigger is located at the left edge of the oscilloscope.

– As soon as the next lap trigger is received, the new lap is automatically aligned to the
other laps.

– Note: While replaying the cursor is always moved to/for the overlay, which is the
closest to the right side of the oscilloscope. This ensures that all values (channels
pane, analysis windows) are evaluated for the current values.

Show Extremas
How to find it

1. Highlight Channel in Oscilloscope



WinDarab V7 | 2

Bosch Motorsport WinDarab V7 Wiki Manual 63 / 224

'D' key -> 'E' key

Channel Menu/Tab
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Example

2.3.2 Instrument Panel
The Instrument Panel is a window used to visualize data at the current cursor position.

Settings
Instrument Panel settings can be edited/loaded/saved using the F5/F6/F7 function keys
(like many other windows).

Element Selection/Placement
– Instrument panel allow to select multiple gauges by pressing the Ctrl + Left Click or

using a rubber band.

– The location and size of all selected gauges can be adjusted in a single step.

– Copy and paste of the selected gauges is supported

– The layout grid is removed. Now the borders of the gauges act as magnetic lines
making it easy to align/adjust gauges.

– If multiple gauges are selected, the arrow keys can be used to move the gauges by
pixel (without snapping to the magnetic lines). Additionally, the arrow keys can be
used with Shift to align all gauges to the top, left, bottom or right border, together
with Ctrl the size can be adjusted (Ctrl+Right Arrow, Ctrl+Down Arrow) or aligned
and sized (Ctrl+Left Arrow, Ctrl+Up Arrow)

Elements
The elements that can be used on an Instrument Panel are:

– Value Display

– Bar Display

– Round Scale

– Bit Panel
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Value Display

[]

Value Display Common Settings

The Value Display can be configured with the following settings:

– Channel: Defines the channel data that the element will present

– Caption: Allows an alternate 'channel name' to be displayed

– This is useful in the event the measured channel name is not descriptive / long.

– Number Format: Defines the number of digits, number decimals, and scaling that will
be used

– Gauge/Caption: Control the base colors of the display element

– Upper/Mid/Lower Range: Control the color of the display element based on the cur-
rent cursor position value of the channel.
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Value Display Alert Settings

The Value Display can be configured to visually alert the user based on the channel value.

– Hysteresis: the value the channel must change in order to clear a triggered alert

– Example Engine Water Temperature: Hysteresis value = 2 and Upper range = 100
The Alert will trigger when the channel value goes above 100
The Alert will clear when the channel value goes below (100 - 2) = 98

– Upper/Mid/Lower Range: Toggle alerts based on the values on the Common Set-
tings screen.

– Time Controls: Define time based automatic clearing of alerts or retriggers.
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Advanced Value Display Usage - PBX Output

Value Displays can be configured to show an enumeration of the channel. This can be very
useful for error channels where a text value is more descriptive than an error code.

Tutorial:

1. Enter the Tools → Channels Settings Window

2. Select the channels of interest (in our case PBX Output State)

3. Change the 'Format' cells to 'Other Formatters -> More'

4. Create a channel formatter for PBX Output States

5. Add the channel as a Value Display to your instrument panel

Pitfall: The formatter is a global setting, so if you go to an Oscilloscope and change
the Channel Format back to display a number, your instrument panel will also change
back to a number.
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Bar Display

Bar Display Common Settings

The Bar Display can be configured with the following settings:

– Channel: Defines the channel data that the element will present

– Caption: Allows an alternate 'channel name' to be displayed

– This is useful in the event the measured channel name is not descriptive / long

– Number Format: Defines the number of digits, number decimals, and scaling that will
be used

– Gauge/Caption: Control the base colors of the display element

– Upper/Mid/Lower Range: Control the color of the display element based on the cur-
rent cursor position value of the channel.
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Bar Display Settings

– Orientation: Select between Horizontal and Vertical layout

– Shape of Color: Drawing controls for the Bar Display

– Peaks: Controls for visual indication of min/max values
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Bar Display Alert Settings

The Bar Display can be configured to visually alert the user based on the channel value.

– Hysteresis: the value the channel must change in order to clear a triggered alert

– Example Engine Water Temperature: Hysteresis value = 2 and Upper range = 100
The Alert will trigger when the channel value goes above 100
The Alert will clear when the channel value goes below (100 - 2) = 98

– Upper/Mid/Lower Range: Toggle alerts based on the values on the Common Set-
tings screen.

– Time Controls: Define time based automatic clearing of alerts or retriggers
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Round Scale

Round Scale Common Settings

The Round Scale can be configured with the following settings:

– Channel: Defines the channel data that the element will present

– Caption: Allows an alternate 'channel name' to be displayed

– This is useful in the event the measured channel name is not descriptive / long

– Number Format: Defines the number of digits, number decimals, and scaling that will
be used

– Gauge/Caption: Control the base colors of the display element

– Upper/Mid/Lower Range: Control the color of the display element based on the cur-
rent cursor position value of the channel.
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Round Scale Style Settings

– These are self explanatory
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Round Scale Alert Settings

The Round Scale can be configured to visually alert the user based on the channel value.

– Hysteresis: the value the channel must change in order to clear a triggered alert

– Example Engine Water Temperature: Hysteresis value = 2 and Upper range = 100
The Alert will trigger when the channel value goes above 100
The Alert will clear when the channel value goes below (100 - 2) = 98

– Upper/Mid/Lower Range: Toggle alerts based on the values on the Common Set-
tings screen.

– Time Controls: Define time based automatic clearing of alerts or retriggers
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Bit Panel

Bit Panel Common Settings

The Bit Panel can be configured with the following settings:

– Channel: Defines the channel data that the element will present

– Caption: Allows an alternate 'channel name' to be displayed

– This is useful in the event the measured channel name is not descriptive / long

– Bit Panel Layout: Control the shape/layout of the bit panel

– Colors: control the Bit Panel level color settings (can be override on the Bit Set-
tings tab)
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Bit Panel Style Settings

– Overrides for individual bits

– Provide the displayed name / color settings for each bit.
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Bit Panel Alert Settings

The Bit Panel can be configured to visually alert the user based on the channel value.

– Alert: Define which bits provide alerts

– Time Controls: Define time based automatic clearing of alerts or retriggers.
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Advanced Bit Panel Usage - PBX Output State

Using PBX Output State as an example, you can define the Bit Panel to present the Output
State of a PBX output in a user friendly way:

Tutorial:

Step 1:

– Create a filter/default Math Function:
2 ^ ({Default} + 4)

– Name it "pbx"

Step 2:

– Add a Bit Panel to your Instrument Panel

Step 3:

– Define the name of your channel
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– Add the text "-pbx" to the name (this applies the Default channel) 
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Step 4:

– Configure the panel layout and Bit Settings

 

2.3.3 Flow Charts
A Flow Chart is a powerful tool with which you can filter and analyse data. For a rudiment-
ary example, you can make left curves as red segments and right curves as blue segments
on a racetrack like below.

In flow charts, you have flow-objects like compare, formula, range, print value in table or
value, insert/delete segment in a racetrack and others. The flow-objects have parameters:
constants, user defined variables or channels.

The way that WinDarab should analyse the recorded data is described systematically in a
flow chart – comparable to a state machine.

In the picture below, you can see a part of the flow chart used to create the above ex-
ample:
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2.3.3.1 Open the Flow Chart Window
To open a Flow Chart Window:

– Select Windows→Worksheet controls→ Flow Chart and drag it into your Workspace.

– Right click on an empty region of the Desktop Analysis Area and select Flow
Chart from the context menu

2.3.3.2 How Flow Charts Work
In this section, you will get a brief idea how flow charts work – and the way you have to
think to analyze data with flow charts successfully.

To illustrate this, we will start with a simple example.

We want to colorize the racetrack with those sections, where the engine revolution is
greater than 7000 rpm until it drops below 6500 rpm. The input data should be the cur-
rent lap (the lap where the cursor is located in).

Here is an oscilloscope view of the input data (It is not the whole lap):

The “human” way
Here is what you would do, if you want to colorize the racetrack with the sections of re-
volution above 7000 rpm:
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1. Start at the first sample of the current lap.

2. Get a blank paper sheet (with the template of the racetrack).

3. Look for the first/next sample with “rev” above 7000 rpm.
If the end of lap is reached, the analysis is done!

4. Get the current lap distance “lapdist” and start with colorizing the racetrack.

5. Search for the following sample with “rev” below 6500 rpm.

6. Colorize the racetrack between the start positon (found in 3) and end position (found
in 5)

7. Continue to search for all occurrences by repeating step 3-7. Quite simple, isn’t it?

The “flow chart” way
Now let us see, how this example is realized as a flow chart analysis.

First, after opening a new flow chart window, you should setup your data source (Set-
tings / F5).
In our example, we want to evaluate the current lap of some file:

The next step is to insert a racetrack view object on the output page:

And the last step is to create the flow chart, which looks like this – actually exactly the
same as described in the “human” way.
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1 START is the entry point of
the flow chart analysis.

2 This “racetrack” object
clears the current racetrack
segmentation (which is loc-
ated on the output tab)

3 The condition node “rev >=
7000” instructs the flow
chart to look for the next
sample where the condition
get true.

4 The racetrack object inserts
a segment change (start of
segment “Red” – “high
rev”).
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5 The condition node “rev <
6500” instructs the flow
chart to look for the follow-
ing sample, where the re-
volution drops below 6500
rpm.

6 Now the next racetrack ob-
jects inserts the next seg-
ment change (start of seg-
ment “Green” – “rev nor-
mal”) and go back to step
3.

You do not have to mention in a flow chart when to stop the analysis (but you can in
special cases!). A flow chart will always stop at the end of the selected data range (or
never, if using with telemetry data). After running the flow chart (by disabling the “design”
mode), you can see the analysis result in the output window:
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2.3.3.3 Things you should know about Flow Charts
A flow chart is a combination
of state machine and its evalu-
ation rules.
In a state machine “nodes” rep-
resent the states and the “links”
or ”lines” describe the possible
transitions between the states.
In flow chart the “exit” of a
node (which was passed last)
represents the current state
and the nodes linked to the
exit are the possible transitions
for continuation.

The flow chart will move for-
ward in the data until:
- a node connected to the cur-
rent state (exit) evaluates to
one of its exits or
- the end of the data evalu-
ation range is reached.
Normally you don’t have to
care about proceeding the
walk through the data.
In the left example you can see,
that it’s not required to con-
nect the false exit of the condi-
tion with its entry. In real this
would be worse: See next ex-
ample!

Correct Usage:
In case you want to test for al-
ternatives create multiple links
between the exit of a node and
the entries of multiple nodes:
Flow Chart will check both “rev
<= 4000” and “rev >= 7000”.
As long as both are “false”,
Flow Chart will move forward in
the data. If one evaluates to
“true”, Flow Chart will transit
the current state to the corres-
ponding “true” exit.



2 | WinDarab V7

86 / 224 WinDarab V7 Wiki Manual Bosch Motorsport

Incorrect Usage:
This is not correct for checking
alternative routes: If “rev <=
4000” is false, the flow chart
will transit to the “false” exit of
“rev <= 4000”:
Flow Chart will wait for “rev >=
7000” and won’t check “rev <=
4000” anymore!

If you want to check for two
conditions to be true at the
same time, you have to take
care to proceed walking
through the data.
Omitting the “NEXT SAMPLE”
object in the left example a
short circuit would be the res-
ult. The flow chart will stuck at
the first sample where “rev >=
7000” is true and “speed >=
250” is false!

A better performance can be
reached, if you find a flow chart
solution without using “NEXT
SAMPLE”.
The example above was
changed to test “rev >= 7000”
again after “speed >= 250” got
true.
If “rev >= 7000” isn’t true any
more, you can return to the be-
gin of the sequence - and
“NEXT SAMPLE” is not required
anymore.
This is more performant, but
less readable. Use at your dis-
cretion
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The more conditions you have
which should be “true” at the
same time, the more complex
this check will be.
It may be resonable to place
the condition check into a con-
tainer. It makes the main flow
more readable !

Note: A container can provide
any (reasonable) number of
“EXIT” objects.

A container has its own internal
state. This means the outer
flow chart state won’t transit
inside of the container. The
outer state will only transit to
the exit of a container, if the
container flow inside reaches
an “EXIT” object (on the left the
“True” node).
Use parallel containers if you
need a complex logic to decide
on which path the evaluation
has to continue.
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Use multiple “main” flow chart
tabs, if you create multiple in-
depentent flow charts, which
use the single output tab for
their results.
Note: You can use containers
also but they aren’t designed
for this pupose!

In case you want to test for al-
ternatives create multiple links
between the exit of a node and
the entries of multiple nodes:
- Flow Chart will check both
“rev <= 4000” and “rev >=
7000”. As long as both are
“false”, the Flow Chart will
move forward in the data.
- If one evaluates to “true”,
Flow Chart will transit the cur-
rent state to the corresponding
“true” exit.

This is not correct for checking
alternative routes: If “rev <=
4000” is false, the flow chart
will transit to the “false” exit of
“rev <= 4000”:
The Flow Chart will wait for “rev
>= 7000” and won’t check “rev
<= 4000” anymore!
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It’s a good practise to use vari-
ables to store information and
to separate (a little bit)
between output objects and
analysis logic.
This can be helpful to organize
the flow chart but also to be
able to add additional logic
(e.g. logic to supress events
because of their duration).

2.3.3.4 Flow Chart Settings
A dialog box with settings appears automatically when you open the Flowchart Window
for the first time. Closing the window will save the settings. The next time the window is
opened the dialog will not appear instead the saved settings will be loaded.

If you want to modify settings or carry out a new calculation, you can re-open the dialog
box:

– Using the menu item “Start→ Settings→ Edit”

– Using the context menu by pressing the middle mouse button

– Using the context menu by pressing the left + right mouse buttons.

– Using the hotkey, F5

Flow Chart has flow-objects and most of them have parameters and Setup Dialogs. If
there is an active flow-object [red frame], then using any of the above to open Settings
will open its Setup dialog.

You can Load and Save settings with the F6 and F7 Hotkeys, respectively.

2.3.3.4.1 Setup Dialog Box
This dialog box is similar to Common Overlays Settings, but because only one overlay is
used instead of a table with overlays, there is a list box to choose only one overlay. There
is also an additional edit box to change the name of current page of the flow register.
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2.3.3.4.2 Flow Chart Pages
There is one output page where the calculation results are shown and at least one design
page(s). A Design page can represent a flowchart or a container. During editing, you can:

Start→ Flow Pages→
New flow

add a new Design Page

Start→ Flow Pages→
Delete flow

delete current Design Page.

Start→ Flow Pages→
Close container

If the Design Page represent a container then you cannot delete it,
but you can close it. Closing means the objects from Design Page
become invisible.

2.3.3.4.3 Output Page
This page contains analyzed or filtered results, calculated during flows run. The result can
be a simple value, multiple values organized as a table, virtual channels from table
columns, or segments in a racetrack.

Output Table

Insert/
Table

During calculations, you can print different values in cells of the Output table.

Context
Menu/
Settings
-Or- F5

If the object is active (with red frame), you can open and modify its settings.
You can open the “Output Table” dialog box using the context menu by press-
ing right mouse button.

A row in the Column Definition Table contains the Name and the Type of the
column. If the column is a number then you also can choose the length and
the decimals of the number. You can change the order of columns with Up /
Down arrows.

Columns
as Virtual
Channels

Virtual channels can be created from columns in the output table, check the
'VirtChannel' box. These virtual channels can be made persistant (meaning
they save to the file), check the 'Persist' box. You can then set the unit, min-
imum view range, and maximum view range.

Add
Column

A new row is added if you enter a name into the last empty row.

If you want to delete a row, then make the row current and then press the de-
lete button.
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Zoom
range in
measure
window

If you want to be able to double click on the output table and zoom an oscil-
loscope, define two columns (Start and End)

Go to po-
sition in
measure
window

If you only define a Start, set the radio button to 'Go to position in measure
window' and when you double-click the row in the output table only the
cursor will move.

Sorting You can sort the results of the table by a clicking on the column heading of
the table. By default after calculations the results are sorted by the column
chosen in the field Start (In our example it is Time column). If you click on
other column results will be resorted and the new sort column will be re-
membered and after next calculations will be used to sort the results. If there
are several results with the same value for current sort column then they will
be sorted by the values of column in Start field.

Maximum
Rows

The table cannot contain more than 10000 rows. If there are already 10000
rows, the new rows will be ignored.

Output Value

Insert/Value During calculations you can print a value in Output Value, and after
the calculation you can analyze it.

Context Menu→
Settings
F5
Double Click

If the active object has a red frame, you can open and modify its set-
tings.

If you select the check box “Value is a time value”, this means that the
printed value is a time and with double clicking on it, the bounded Os-
cilloscope will go on this time position.

Output Racetrack

Insert/
Racetrack

During calculations, you can insert segment, delete segments or delete all
segments in an Output Racetrack.
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Local
Menu→
Settings
F5

If, the object is active (with red frame), you can open and modify its settings.
You can open the dialog box using the context menu with pressing right
mouse button.

Flow Chart: output can be virtual channels
– Columns in any output table can be enabled to create/populate a virtual channel. The

virtual channel can be used in any other view of WinDarab for futher analysis.

– Peristent channels are also supported for single files (not linked files and not tele-
metry), but only if the evaluation “Whole file” is selected for the flow chart. Note: Be
aware that persistent channels are replaced each time the flow is executed!

– The name of the column is used as the name of the virtual channel and the name of
the table is used as the data source. Nevertheless to prevent name conflicts we en-
courage the use of „unique names“. WinDarab will resolve channel name conflicts**
nevertheless depending on the execution order of Flow Charts the name conflicts
aren’t always resolved the same way!

Setup of the Output Table:

Example Flow chart (calculate the average engine rpm (nmot) above 6000 rpm):

Example Output (oscilloscope and XY Plot):
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2.3.3.4.4 Design Page

Flow objects
There are compare, condition, container, exit, formula, join, next sample, range select case,
print in table, print in value and segmentation in racetrack.

Variables
You need variables to store values, for example the flow-object formula needs variable to
store the calculated result.

Variables From most setups of flow object it is possible to open the table with all user
defined variables.

A table row contains a variable and its value.
A new row is added if you make the last empty row current and write variable
name. A new empty row will be added after insertion.

Delete If you want to delete a row then make the row current and then press the de-
lete button.
Parameters
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While working with flow-object you can use constant-numbers (1, 2, 5.6 …),
constant-strings (“This is a string”), channels and variables. We will call para-
meter any of these objects.

Start

It is used as a start object of a flow. It has no settings. You cannot insert or delete it.

Compare

Insert/Compare It is used to compare 2 parameters.
The red arrow means the comparison is false; the green one means it is
true.
Tip: If you move the mouse cursor over them a small window appears
with their meaning.

Settings - F5 If the object is active (with red frame), you can open and modify its set-
tings. You can open the dialog box using the context menu with press-
ing right mouse button.

Condition

Insert→Condition You can use any earlier created condition.
The red arrow means the condition is false
The green arrow one means the condition is true.

Tip: If you move the mouse cursor over them a small window appears with
their meaning.

Settings - F5 If the object is active (with red frame), you can open and modify its
settings. You can open the dialog box using the context menu with
pressing right mouse button.
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You can build the condition using a dialog with the available func-
tions and a dialog with the available channels (buttons Function… and
Channel…).

Container

Insert→Container If you want to use a block of objects several times you can create
a container and then use it as a single object.

Settings - F5 If the object is active (with red frame), you can open and modify
its settings. You can open the dialog box using the context menu
with pressing right mouse button.

Tip: Double clicking on the container will open a new page with the
content of the container. To open setup of the container press F5
or use the context menu
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An example of a container:

Where Speed is bigger and Speed is smaller are exits of the container. See also: Exit.

Tip:

The green arrows of the container are the exits, if you move the mouse cursor over them a
small window appears with the name of the exit.

Exit

Insert→Exit It is used to exit the current container and return to its parent.
See also: Container.

Settings - F5 If the object is active (with red frame), you can open and modify its set-
tings. You can open the dialog box using the context menu with pressing
right mouse button.

Tip Double clicking on the container will open a new page with the content of
the container. To open setup of the container press F5 or use the menu

Formula

Insert/Formula You can calculate a formula for the current sample like mathematical
functions; the result is remembered into a variable.
See also: Math Functions and Container
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Settings - F5 If the object is active (with red frame), you can open and modify its set-
tings. You can open the dialog box using the context menu with press-
ing right mouse button.

Tip You can calculate the Ave, Min, Max, Sum of a formula for every sample
in a range by selecting Ave, Min, Max or Sum from "Calculate formula
for:". The range is between two parameters ("from", "to").

You can build the formula using a dialog with the available functions
and a dialog with the available channels (buttons Function and Chan-
nel). See also: Defining a Function.

Join

Insert→Join
 

Join has no settings. It is used to collect several links and from it can start
several links too.

Next sample

Insert→Next sample Next sample has no settings. It will increase the current sample.
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Range

Insert→Range
Range is used to check if a parameter is between two limits. A limit
can be constant or a variable.

The red arrow means out of range, the green one means it is inside.

Tip If you move the mouse cursor over the arrows, a small info window
appears.

Settings - F5 If the object is active (with red frame), you can open and modify its
settings. You can open the dialog box using the context menu by
pressing right mouse button.

Select case

Insert→Select
case

The select case allows selection among multiple comparisons, depend-
ing on the select parameter.
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Settings - F5 If the object is active (with red frame), you can open and modify its set-
tings. You can open the dialog box using the context menu with press-
ing right mouse button.

Tip A table row contains a case. You can change the order of cases with
Up / Down arrows.

Checking of cases starts from the first one and continues down until a
comparison evaluates to True.

A new row is added if you click the last empty row and select an oper-
ator or enter a value. A new empty row will be added after insertion.

Delete If you want to delete a row then select the desired row and press the
delete button.

Output to table

Insert→Output
to table

Use Print in table to define in which Output Table and which cell of the
table you want to print. The Print in table has the name of its Output
Table.

Settings - F5 If the object is active (with red frame), you can open and modify its set-
tings. You can open the dialog box using the context menu with press-
ing right mouse button.

A setup-table row contains a column from Output table and the value
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you want to print there. You can change the order of rows with Up /
Down arrows.
A new row is added if you select the last empty row and then select a
column name and parameter. A new empty row will be added after in-
sertion.

Output Row "Output row" is used to find the row in which to print. If "New row" is
checked then a new row is inserted into the Output Table. If you want
you can save the row in some variable for later use.
If you check "Existing row" the row is the value from a variable specified
below. See also: Output Table.

Output to value

Insert→Output
value

Use Output value to define in which Output tab value you want to
print. The Output value has the name of its Output page value.

See also: Output Value.

Settings - F5 If the object is active (with red frame), you can open and modify its set-
tings. You can open the dialog box using the context menu with press-
ing right mouse button.

Segmentation in Racetrack

Insert/Segmentation
in racetrack

Use Segmentation in racetrack to define which Output Racetrack
you want to modify. The Segmentation in racetrack has the name
of its Output Racetrack.



WinDarab V7 | 2

Bosch Motorsport WinDarab V7 Wiki Manual 101 / 224

Settings - F5 If the object is active (with red frame), you can open and modify
its settings. You can open the dialog box using the context menu
with pressing right mouse button.

You can select action:

– Clear all segments (Insert segment will not be available)

– Insert a new segment with a specified color. The inserted segment can be at

– current lap position (current sample).

– any value saved in a variable.

See also: Output Racetrack.

Links
The objects in design pages are connected with links.

See also: Connecting objects with links in design pages.

2.3.3.4.5 Working with the Flow Chart Window

Modes
There are two modes: Edit and Auto Run, for the flow window.

Edit mode

Start→Settings→Design In edit mode you can insert, delete, copy, paste objects or
links.

Run mode

Start→Tools→Replay Run mode will switch edit mode off. All flows
will then be executed; one after another us-
ing the order of pages
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In this mode there are several cases in
which calculation will start again automatic-
ally:

– The sample range has changed (moving in bounded measure window, online files).

– Settings have changed (after OK of setup dialog or after loading).

In Run mode you can move, rearrange objects and change links, but it is not allowed to
make changes in the logic of the flow.

"Edit mode" will stop current execution (see also Executing the flows) and "Run mode" will
be switched off. This means that you will not have any updated results in output objects
until you switch on "Run mode" mode again.

Active object
Clicking on an object will make it active. The active object has a red frame.

You can open and modify the active object settings. Open the dialog box using the con-
text menu by pressing the right mouse button or using the hotkey F5.

– Only one object can be active at one time but you can mark several objects.

Selected objects
Hold Ctrl and click on objects you want to mark. The last clicked object will be also active
object. You can mark objects also by dragging a rectangle on the page with left mouse
button. All objects that are inside the rectangle will be selected.

The selected objects have a blue frame.

If two objects from a design page are selected then the links between them are also high-
lighted.

Inserting and deleting objects
Flow objects - Design page

Insert

You can insert an object in Out-
put or Design page using the
menu Start→Flow objects.
Drag an Item into your Flow chart
to use it.
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The context menu is opened with
the right mouse click. From the
menu select the Insert and then
select an object.

– Insert is only available in edit mode.

Delete

Delete marked objects
The marked objects (all with blue frame) will be deleted. The
links between marked objects will be deleted too.

If you press a button with a flow object on the toolbar you enter the insert mode for the
object. In insert mode every click on the page will be inserting an object only if the click is
not associated with other actions with bigger priority (move, resize, connect-click on con-
nectors of an object).

Switch off insert object
mode

Press the arrow on the toolbar to switch off the insert
mode.
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Move, Copy, Paste Object(s)

If there are marked objects you can move them. Moving one
of the marked objects will move all others too. The relative ar-
rangement between them will stay. Only the links which con-
nect marked object with not marked one will be changed dur-
ing the movement. You can use the keys Up, Down, Right,
Left to move the selected objects also.

Copy Will copy all marked objects (and their links if any) to clip-
board.

Paste If clipboard is not empty you can paste the objects (and their
links if any) from the clipboard.
You cannot paste output objects to design page and vice
versa, but you can copy objects from one design page and
then paste them in another design page.

Resize Object
If only a part of the name of an object is visible, you can resize the object for the best fit.
First make the object active and then if the mouse is near the frame of the object, you will
see the resize mouse cursor and then you can resize it.

Object Connectors
Every object in design pages has one input and/or one or sev-
eral outputs. They are used to define the direction of execu-
tion. The object "Start" has no input connector.

Input Connector If the link which enters the connector is active then the object
will start working.

Output Connector (True
Condition)

If this output is found as the results of the calculation of an
object then the link that starts from with will be activated. In
compare, condition and range this connector is chosen if the
result is true.

Out-Connector (False
Condition)

In compare, condition and range this connector is chosen if
the result is false.
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Connecting objects with links in design pages
You can connect objects with links. A link is created if you drag from output connector to
input connector (or vice versa) with left mouse button down. The line will follow the
mouse cursor.

If the mouse cursor is over a connector, it gets lighter. You can start a link when it is in
edit mode and the connector is lighter color. You can finish the link if the end connector is
lighter.

Tip: If the mouse cursor is over an output connector and you press right mouse button
(content menu will appear) and select an object from "Insert" item of the content menu
then the input connector of inserted object will be connected with the output connector.

Editing links
Clicking on a link will make it active. Then you can change the link with moving some
parts (sub lines) of it left, right, top or bottom.

2.3.3.4.6 Executing the Flow

State of a flow
The state of the flow is defined by current sample and working object or active link.

Working
In any time of execution, there is only one working object or active link. The working ob-
ject can use the current sample with some channel and/or information saved in variables
and can save result in a variable or print it in output object. Depending on the result, the
working object will select an active link. The task of active link is to select next working ob-
ject and so on.

Important: If the working object cannot select a new active link then the current sample
will be increased automatically and the last active link will be activated.

For example, you have a compare object with an input link, output link if comparison is
true and no link if the comparison is false.
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Then the input link will make the object work and suppose that for the current sample
the MaxValue >= speed (i.e. False). Then, since there is no link to the False connector, the
current sample will be incremented and the input link will be evaluated again. The result
of this is: the output link will be reached when a sample for which the speed is bigger as
the MaxValue appears.

The equivalent scheme is

Important: You should be careful when using no link feature. If it is used wrong then un-
expected results are possible.

Iteration
The execution of a flow for a single sample is an iteration. You can go to the next iteration
by using a "NEXT" object. See also: Next Sample.

Important: Because the calculations can take much time especially if the range is about
the whole file, they are made inside of a working thread. Pause and Stop button are en-
abled. Instead of waiting for them you are free to work with some other analysis windows.

**Important:**For online[Telmetry] files, calculations are started automatically after a new
samples have been received.

Errors
Invalid entry

Before running a flow the application prepares some elements of the flow. For example
locking used channels. If there is an element which cannot be prepared from the applica-
tion (for example channel name which is not in current file) then a message appears and
the setup of the element will be opened and the wrong parameter will have a light red
background. The calculation will not start.

Endless loop

During execution of a flow the application checks if there is a progress of execution. Usu-
ally if the flow stays more than some time executing one sample then it is supposed that
there is an endless loop and the calculation will stop. The supposed endless loop will be
shown to the user.
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2.3.3.4.7 More Examples

Channel Limit Violation
The following flowchart can be used to check a channel for limit violations. Every limit vi-
olation is reported to a data table on the output tab containing the channel name,
timestamps, duration and the min/max value.
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The upper and lower limit for the limit violation check is initialized at the beginning of the
flowchart and can be easily modified. The output table is designed to show violations of
multiple channels. You can copy and modify the flowchart for each channel you want to
observe - but you have to replace the channel in several objects.

Note: ValueMin is calculated as the minimum value of “rev” in the time range xTime-
Start to xTimeEnd

Here is the result table of two flowchart evaluationg “rev” and “accy”.

Colorize a Racetrack by Channel Value
This flowchart uses a “Select Case” object to categorize the current speed into zones and
creates appropriate segments for a racetrack element on the output tab.



WinDarab V7 | 2

Bosch Motorsport WinDarab V7 Wiki Manual 109 / 224

If a zone is entered, the racetrack segment is created and two variables are set with the
limits of the zone (2 km/h are added to avoid jitter). As soon as the current speed goes
outside of the limits, the loop begins for new. Here is the result of the flow calculated for
the current lap:

2.3.4 Video Window
The video window allows you to synchronize a video with the data. The video position will
then be always aligned with the data position and lets you compare the data to the video.

WinDarab does not provide video codecs! In order to use the videos, the correspond-
ing codecs have to be installed on the PC by the user. For example, the free LAV Filters co-
dec pack provides video codecs for the most used formats.

Open the Video Window by right clicking in an empty worksheet space and selecting
“Video” in the appearing Darab context menu.
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The Video Window allows you to synchronize a video with the displayed data.

Settings Dialog
Open a video by pressing F5 or by selecting “Settings …” in the video windows context
menu.

The Settings Window shows the used videos and their synchronization parameters.
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File The file name of the selected
video

[Video/Data]Position The synchronization points in
the video and the data. These
are the connected time val-
ues.

Start/End The start and End-Time of the
video.

You can use more than one video, by using the Insert but-
ton again. The used videos can be rearranged by
the Up and Down buttons or deleted from the configura-
tion by selecting a video and clicking the Remove button.

Apply the settings with the OK button.

Navigation
The Navigation in the video player is done in the navigation bar below the video.

The bar changes according to the locked state. This state can be changed by clicking
the Lock/Unlock button on the right side.

In the locked state, the navigation bar can’t be used. Instead the video is controlled by
the cursor position in the oscilloscope. The play button and the time field are disabled
and the navigation bar is hidden by default. It can be temporarily revealed by moving
the mouse to the bottom of the video window.

In the unlocked state, the video is controlled by the navigation bar. You can change the
position of the video by either clicking into the time bar, dragging the cursor, changing
the time in the time field or clicking on the up/down arrow. These arrows jump one frame
forward or backward.

The Play button allows you to play or stop the video. The sound volume can be changed
by the audio slider.

When the video and the data are aligned, press Lock to save the synchronization point.
You can now control the position by the oscilloscope.

You can zoom into the navigation bar by right clicking on the navigation bar and se-
lecting the new navigation range.
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2.3.5 Racetracks
Racetracks are managed by Darab Explorer – Racetrack.

Following processing items are provided by the Darab Explorer – Racetrack and de-
scribed in detail in the next sections:

– Creating a Racetrack

– Deleting a Racetrack

– Renaming a Racetrack

– Editing a Racetrack

– Selecting Racetrack's Segmentations

To open the Darab Explorer – Racetrack there are the following methods:

From Racetrack Window:

Open Racetrack Window if not opened. (“Windows → Dockable windows →
Racetrack”)

From Orb Window:

Open Racetrack Window if not opened. (“Windows → Dockable windows →
Racetrack”)
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Creating A Racetrack
1. Right Click on a Racetrack Window

2. Select New Racetrack from the menu.

3. The Racetrack dialog box will appear. You are now able to create a new racetrack by
accessing the desired functions for racetrack layout (see chapter Racetracks edit
modes).

4. When you are satisfied with the results click on Save As.

5. In the dialog box Save Racetrack select the folder in which you want to save the
racetrack. Then enter a name for the racetrack.

6. Click on Save.



2 | WinDarab V7

114 / 224 WinDarab V7 Wiki Manual Bosch Motorsport

Creating Racetrack Segmentation
7. Right Click on a Racetrack Window

8. Select Edit Racetrack from the menu.

9. Select Determine segmentation based on recorded data

10. In the “File/Lap” field choose the file and lap for the course calculation.

11. Activate the calculation method “Transversal Acceleration”.

12. Enter a minimum segment length.

13. A segment will be created only if the transversal acceleration value over this distance
exceeds the set limit (threshold value).

14. Select the channel in which the transversal acceleration was recorded in the “Trans-
versal Acceleration Channel”

15. Enter the value that must be exceeded at the beginning of a curve.

16. Next

17. Manually edit the segment lengths if applicable

18. Next

19. Enter a descriptive name for this Racetrack Segmentation

Note: The curve ends if the g-force is 30% below the set threshold value.

2.3.6 Math Channels and Filters
In WinDarab it is possible to define filters or new channels with the help of math func-
tions. WinDarab provides functions and filters that will help you to solve a great number
of math and analytical problems.

– In a math function it is possible to use 'comment fields' — in addition to recorded
channels — to include conditions that are specific to a particular file. Comment fields
are included in the channel selection list and marked with “C”.

– Another approach is to use the 'Setupsheet' functionality to define outing dependant
constants
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2.3.6.1 Math Channels
A math channel calculates values based on other channels in a file. Which channels will be
used is determined by the user entered expression.

If a math channel has been defined, it will be listed in the channel window. Much like in-
ternal channels, math channels can be used (in nearly all instances) as if they were logged
data.

– If new a math channel is added, but another math channel with the same name
already exists, the existing math channel is replaced by the new one. In case of a
manual creation of the new math channel (Extras/Functions/New) a message box ap-
pears, informing the user about the duplicated math channel name.

Channel modifiers
{<channel>:A} Channel value with interpolation

{<channel>:D} Channel value without interpolation (BEFORE/AT current timestamp)

{<channel>:B} Channel value without interpolation (BEFORE current timestamp)

{<channel>:N} Channel value without interpolation (BEHIND/AT current timestamp)

2.3.6.2 ‘Default’ Channels
WinDarab supports special functions that can be applied to any channel.

Defining Default Channels
Default channels are defined just like any other Math Function, just substitute {default} in
your expression for a channel name:

Applying Default Channels
Analysis Win-
dow

Instructions
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Oscilloscope Right click on the channel name
The bottom section of the context menu contains available default
channels

Oscilloscope Use the ribbon: Channel → Filter → Filter channel with:
see below

X vs Y Plot In the channel selection box, append the name of the default function
with a hyphen.
The channel name is in green the default function is in yellow

Oscilloscope, define default function

2.3.6.3 Working with Functions
Math functions can be saved in a folder in the File Explorer. In addition to the selected
folder and its contents, the lower area of this window shows a summary of the most im-
portant information pertaining to a math function.
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“As Default Folder“ Button
If you start the program WinDarab makes all functions saved to a specified folder avail-
able. To specify this folder select it from the directory and click on the “As Default Folder”
button.

“Sub-Folder“ Option
Activating this button makes all formulae contained in the default folder as well as those
contained in the sub-folders available.

“Make Available” Button
If you would like to make a math function available you will have to do this explicitly. This
button is not active when the math function has already been made available.

Report
This button enables you to create a report that contains all the settings for a math func-
tion. If you press this button, a dialog box for choosing a report template appears.

Note

– WinDarab provides one template for each language it supports.

– If two functions with the same name exist WinDarab will only use the first one.

2.3.6.4 Defining a Function
To define a new math function or to modify an existing one, follow these steps:

1. Use Tools → Mathematics → Functions to open the “Functions” dialog box.

2. Select the math function you want to edit and click on “Modify”

– Or “New Function” if you want to create a new function.

3. The dialog box “Edit Function” appears. It contains three tabs in which you can make
all entries pertaining to the math formula.

4. Once you have finished making your entries or modifications, click on “Save“ or “Save
as”.
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Notes

– When a math function is modified, WinDarab immediately function if it is displayed or
in use in a window.

– You can also create a new function by right-clicking into the Channels window and
select Math function → New. If you right-click on a function in the Channels window,
you can chose to edit this function.

– Math formulas and channels with identical name are not allowed.
If a user tries to save a math formula but at least one opened file contains a data
channel with the same name, WinDarab asks the user to select a different name for
the math formula.

– WinDarab shows a message, if a file contains data channels with the same name as
already defined math formulas. The data channels are not available until the user
changes the name of the math formula and reopens the file.

2.3.6.5 Formula & Computation Tab
– Description

– Enter a brief description that will be displayed in channel selection lists.

– Expression

– Enter the math expression you want to calculate in this section.

– Data file to validate the math function

– Select a file containing a list of channel names. This enables you to access the
choice of available channels in the Insert channel area.

– WinDarab will use this to test the syntax of the expression.

– Insert Math Function

– This is a list of all available operators, filters, and functions
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Selecting a Channel
– Channel names should always be enclosed in braces. Alternatively, you can insert a

channel in an expression by using the Insert Channel area

– {default} is a wild-card that can be used. See Default Channels

– A formula is not limited to a single line. If a formula is too long or complex for one
line, you can split it by using multiple lines.

Selecting a Function
A user can select a math function from the Insert Math Function section

– Information about each function can be found via intellisense or in Mathematical Ex-
pressions

Compute Function
This area is used to determine the sampling rate for calculating a math function.

Depending on the configuration for recording data, data is sampled at varying intervals.
As a result, the number of samples per unit of time may vary.

Depending on the meaning of the variables in a math calculation, it may be necessary to
vary the sampling rate. This setting determines the quality and speed of processing.

for every <x> sample:

This setting calculates the function independent of the samples that were recorded, and
which belong to channels included in the formula. Calculations are instead carried out for
each <x>th sample of

– of all referenced channels: calculates every <x> sample point of all referenced chan-
nels

– of the fastest channel: calculates every <x> sample point of the fastest channel

– of the selected channel: calculates every <x> sample point of the selected channel

– of the slowest channel: calculates every <x> sample point of the slowest channel

Note: If WinDarab searches for the fastest channel it ignores standard channels such
as xtime or xdist because they are included in every block and thus would always be the
fastest channels. If you would indeed like to make a calculation for these samples, you
must select the 'of the selected channel'.

Compute function with a period of <x> ms:

WinDarab calculates the function at a specified minimum time interval.

– WinDarab is able to perform a calculation only if sample positions are valid. As a res-
ult, WinDarab always searches for the sample separated from the previous sample by
at least the specified value. It is therefore possible that the intervals vary – but they
are always at least as big as the specified value.

Include Relevant Timestamps

Some math channels work better if relevant timestamps are included to the math func-
tion. E.g., functions like “LapSigma” reset their result if a laptrigger is passed. However,
values can be incorrect at the laptrigger boundary if this timestamp (exactly at laptrigger)
isn’t included in the selected timeline. This new option ensures that the timestamps of the
laptriggers are included in the math channels timeline and the math channel has a value
at these positions.
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Note: The used math functions in a math formula control if relevant timestamps exist and
which they are (an example is LapSigma which adds the timestamps of the laptriggers to
the math channel).

Computing Example
Assume there are two channels (v_wheel_rb and v_wheel_rf) with different sampling rates
(100 ms and 130 ms) and you want to create a math-channel to calculate the average of
these channels.

You can create a math-channel with the expression “({v_wheel_rb} + {v_wheel_rf})/2”.

The Image below shows the two channels in the upper area and the math-channel with
the computing-configurations “every sample from the fastest channel”, “every sample
from the slowest channel”, “every 150 ms” (from top to bottom in the bottom area).

As you can see, the blue math-channel has the same sample-points as the blue channel
(fastest).

The red math-channel has the same sample-points as the red channel (slowest). The green
math-channel has its own sample-points that are not in any way linked to the included
channels sample-points.

The sample-points that are not on the channels-points are interpolated by the surround-
ing sample-points of the channel. As an example, the blue math-channel uses the exact
values from the blue channel and interpolates (where the sample-points are not at the
same point by a coincident) the red channel.

Format Tab
All the settings pertaining to the display of a math channel are made in the “Format” tab.

Numerical Format

Make the settings for the numeric display of the channel values. You can choose either a
“decimal”, “hexadecimal” or “binary” format. If you choose the decimal format, you can
specify the width of the entry field as well as the number of decimal places.

Range of Values
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Use this area to set the range of values (from - to) and the unit of measure to be used in
the default channel display.

2.3.6.6 Filter Functions
For this section, math foundations of filters are required. WinDarab provides a lot of math
filters, such as:

– bandpass

– bandpassFIR

– filter

– lowpass

– lowpassFIR

– highpass

– highpassFIR

– stopband

They can all be found in the function window in the category “filter functions”

Bandpass, Lowpass, Highpass, and Stopband Functions
These Functions all have an editor, where you can insert the parameters for the function.

In the filtertype-list are up to six different filtertypes, that you can chose for your filter.
Each of the filters have individual strengths and weaknesses regarding roll-off or phase re-
sponse

The other lists supply the parameters for the order, the frequency, and the sample fre-
quency.

– Keep in mind, that the sample frequency must be at least twice the filter frequency.
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When all parameters are configured, you can go to the expression editor by clicking on
Next.

In this dialog, you must enter the expression you want to filter. The expression can be as
complex as you require.

– It is also possible to define another filter within this expression by calling up the As-
sistant again.

'Filter' Function
Choosing 'Filter' from the filter functions allows you to define your own coefficients.

– The Assistant supports up to 12 sampling points. If your filter requires more sampling
points, you have to add these manually to the expression created by the assistant.

BandpassFIR, LowpassFIR and HighpassFIR Functions
These functions don’t require an assistant. They all require as parameters the order of the
filter, the channel to filter and at least one cut-off frequency (bandpass requires two).
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All other parameters like the frequency are calculated.

2.3.6.7 Mathematical Expressions
The following sections list all operators and functions supported in WinDarab. WinDarab
follows conventional mathematical rules for evaluating expressions.

Constants
e (Eulers’s
number)

e = (1/0!) + (1/1!) + (1/2!) + (1/3!) + ... = 2.7182...

NoValue Allows you to 'filter out' data, no Value is returned and creates a discon-
tinuity in the signal

HOLD Returns the value of the latest calculation result.
HOLD can be used to eliminate/replace invalid measurement values.
the use of HOLD can slow down math function calculation because the
function must be recalculated from the beginning of a file.

pi pi = 3.1415…

Arithmetic Operators
* Multiplication

+ Addition

- Subtraction

/ Division

^ , Calculates the result of <x> raised to the power of <y>

<X> BitAnd
<y>

Calculate the result of the bitwise AND-combination of <x> and <y>

<X> BitOr <y> Calculate the result of the bitwise OR-combination of <x> and <y>

<X> BitXor
<y>

Calculate the result of the bitwise XOR-combination of <x> and <y>

Comparisons
< Less Than

<= Less Than or Equal to

= Equal to

<> Not equal to

> Greater than

>= Greater than or Equal to

Logical operators
AND Logical AND Operator

NOT Logical NOT Operator

OR Logical OR Operator
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General functions
aver-
age(<Chan-
nel>;<Samples
>)

Calculates the average value of a channel for x(n) within the range n-
<Samples> to n+<Samples>

If (<Condi-
tion> ;
<IfTrue> ;
<IfFalse>)

If the first expression is true, the result of the second expression is re-
turned. Otherwise, the result of third expression is returned.

IsSegment Returns 1, if the car is in one of the given racetrack segments, otherwise
0.
The segments can be selected by their number or by name

Seg-
ment(<Seg-
mentation
Name>

Returns the number of the racetrack segment

SegmentIn-
dex(<Seg-
mentName>

Returns the index of the segment in the selected Segmentation

TakeAve(<cha
n-
nel1>;...;<chan-
neln>)

Returns the average value of all input channels at the current sample

TakeMax(<cha
n-
nel1>;...;<chan-
neln>)

Returns the max value of all input channels at the current sample

TakeMin(<cha
n-
nel1>;...;<chan-
neln>)

Returns the min value of all input channels at the current sample

Math Functions
Abs(<x>) Returns the positive absolute value of <x>.

arccos(<x>) Calculates the radiant angle, the cosine of which equals the parameter
<x>.

ArcCosH(<x>) Calculates the radiant angle, the hyperbolic cosine of which equals the
parameter <x>.

ArcSin(<x>) Calculates the radiant angle, the sine of which equals the parameter <x>.

ArcTan(<x>) Calculates the radiant angle, the tangent of which equals the parameter
<x>.

ArcSinH(<x>) Calculates the radiant angle, the hyperbolic sine of which equals the
parameter <x>.

ArcTanH(<x>) Calculates the radiant angle, the hyperbolic tangent of which equals the
parameter <x>.

ceil(<x>) Calculates the smallest integer greater than or equal to to <x>.

Cos(<x>) Calculates the cosine of the radiant <x>.
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CosH(<x>) Calculates the hyperbolic cosine of the radiant <x>.

Exp(<x>) Calculates the exponential value 

floor(<x>) Calculates the biggest integer smaller-equal to <x>.

frac(<x>) Returns only the decimals from <x>.

Has-
Value(<value>
)

True if the value is valid and False if the value is 'NoValue'

int(<x>) Cuts all decimals from <x>.

lb(<x>) Calculates the base-2 log of <x>.

lg(<x>) Calculates the base-10 log of <x>.

ln(<x>) Calculates the natural log of <x>.

round(<x>) Rounds <x> to the nearest integer value.

sign(<x>) Returns the sign of <x> (-1 or 1).

Sin(<x>) Calculates the sinus of the radiant <x>.

SinH(<x>) Calculates the hyperbolic sine of the radiant<x>.

sqr(<x>) Calculates  .

sqrt(<x>) Calculates  .

Tan(<x>) Calculates the tangent of the radiant.

TanH(<x>) Calculates the hyperbolic tangent of the radiant <x>.

BitInvert(<x>) Calculates the bitwise Inversion of <x>.

Important Due to limitations in precision of math results (because WinDarab is us-
ing 32-Bit IEEE-float values) there are problems, if the resulting value is
too big. E.g. the result of BitInvert(128) is wrong, while the result of BitIn-
vert(255) is correct.
The precision problem occurs only, when saving the math result in
memory. While evaluation the expression, there won’t be any precision
issues.
This means that the expression can evaluate a maximum of 32-Bit values,
but the final result should be smaller.

Scripting
:= Assignment operator for Local or Var variables

begin Keyword to define the start of a script inside a math function

end Keyword to define the end of a script inside a math function

Local Keyword to define a Local variable, which is a variable that resets to 0 at
each new timestamp (doesn't retain its previous value)

Var Keyword to define a script variable that remembers its previous value

Trace functions
Ave(<channel>) Calculates the average value of a channel over the file
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DetectEvent([Rising|Active|Fall-
ing|Inactive]; <BeingCondi-
tion>;<MinTrueDuration>;<Be-
ginDelay>;<EndCondi-
tion>;<MinFalseDura-
tion>;<EndDelay>)

Returns a code from the event detected, if after the be-
gin-condition for the given time (in milliseconds) the
end-condition isn't found.
Without phase: 1: Begin Event (Rising Edge); 2: Inside
Event; -1: End of Event(Falling Edge); 0:Outside Event
With phase: True(1) or False(0)

delta(<Channel>) Calculates the difference between Channel(x(n)) and
Channel(x(n-1))

dn Calculates the difference Samples(x(n)) and
Samples(x(n-1)).

ds Calculates the difference between xDist(x(n)) and
xDist(x(n-1)).

dt Calculates the difference between xTime(x(n)) and
xTime(x(n-1)).

IsLap([OutLap|RunningLap|InLap|
FastestLap|NormalizedLap];...)

Returns true, if the current lap has one of the listed at-
tributes. You can check for multiple attributes in a
single call
e.g.:
IsLap(InLap;OutLap) returns true, if the lap is
an In or Out lap.

LapAve(<Channel>) Calculates the average value for a channel within the
current lap

LapIndex Returns the index of a lap, its a continuous counter
starting at 1

LapMax(<Channel>) Calculates the maximum value of a channel within the
current lap

LapMin(<Channel>) Calculates the minimum value of a channel within the
current lap.

LapNo Returns the lap number as shown in the File Ex-
plorer pane

LapSigma(<Channel>) Same as Sigma but with a lap change set as the reset
condition.

LapStdDev(<channel>) Calculates the standard deviation for the channel within
the current lap.

Lookup(<TableName>;<para-
m1>;<param2>;…)

The lookup table is called with the given parameters
which specify the dimensional values.

Max(<Channel>) Calculates the maximum value of a channel.

Min(<Channel>) Calculates the minimum value of a channel.

OutingNo Returns the outing number shown in the File Ex-
plorer Pane

SampleRate(<channel>) Returns the average sample rate in milliseconds of the
channel

SegmentAve(<Channel>) Calculates the average value for a channel within the
current lap

SegmentIndex(<SegmentName> Returns the index of the segment in the selected Seg-
mentation
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SegmentMax(<Channel>) Calculates the maximum value of a channel within the
current lap

SegmentMin(<Channel>) Calculates the minimum value of a channel within the
current lap.

SegmentStdDev(<channel>) Calculates the standard deviation of a channel within
the current lap.

sigma(<Channel>; <reset>) Calculates the sum of Channel(x(0)) to Channel(x(n)).
The optional second parameter defines a reset condi-
tion that - when occurring - resets the sum and starts
from zero again.

ValueAtDist(<channel>; <dist> [;
<LapIndex>])

Returns the value of the channel at the given distance.
See New Math Functions

ValueAtTime(<channel>; <time>
[; <LapIndex>])

Returns the value of the channel at the given time.
See New Math Functions

IIR Filter Functions
WinDarab provides seven filter functions:

– bandpass

– bandpassFIR

– lowpass

– lowpassFIR

– highpass

– highpassFIR

– stopband

WinDarab supports a number of different approximation techniques and frequencies for
each of these filters.

– Tip: Using the WinDarab Filter Assistant simplifies the assembly of filter functions con-
siderably

bandpass
Syntax:

– bandpass (<Technique>;<Order>;<Frequency Range>;<Expression>)

Parameters:

Technique Order Frequency Range>

Butterworth 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 11 /
12

50:100 / 50:200 /100:200 / 150:200

bandpassFIR
Syntax:

– bandpassFIR(<Order>, <lowerCutoff>, <upperCutoff>, <Channel>)

The channel is filtered using a FIR-bandpass-filter of the given order (>=4th order) and a
cutoff frequency [Hz].

https://github.com/boschmotorsport/WinDarab/wiki/7.7%20Changes#new-math-functions
https://github.com/boschmotorsport/WinDarab/wiki/7.7%20Changes#new-math-functions
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lowpass
Syntax

– lowpass (<Technique>;<Order>;<Frequency>;<Expression>)

Parameters:

Technique Order Frequency

Chebyshev-I 4 / 8 / 10 / 12 5 / 10 / 20 / 50 / 100 / 150 /
200

Chebyshev-II 4 / 8 / 10 / 12 5 / 10 / 20 / 50 / 100 / 150 /
200

Elliptic 4 / 8 / 10 / 12 5 / 10 / 20 / 50 / 100 / 150 /
200

Butterworth 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 11 /
12

5 / 10 / 20 / 50 / 100 / 150 /
200

FIR-Hamming 40 / 50 / 60 5 / 10 / 20 / 50 / 100

FIR-Remez 60 5 / 10 / 20 / 50 / 100

lowpassFIR
Syntax:

– lowpassFIR(Order, CutoffFreq, Channel)

The channel is filtered using a FIR-lowpass-filter of the given order (>=4th order) and
cutoff frequency [Hz].

highpass
Syntax:

– highpass (<Technique>;<Order>;<Frequency>;<Expression>)

Parameters:

Technique Order Frequency

Chebyshev- 4 / 8 / 10 / 12 5 / 10 / 20 / 50 / 100 / 150 /
200

Chebyshev-II 4 / 8 / 10 / 12 5 / 10 / 20 / 50 / 100 / 150 /
200

Elliptic 4 / 8 / 10 / 12 5 / 10 / 20 / 50 / 100 / 150 /
200

Butterworth 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 11 /
12

5 / 10 / 20 / 50 / 100 / 150 /
200

FIR-Hamming 40 / 50 / 60 5 / 10 / 20 / 50 / 100

highpassFIR
Syntax:

– highpassFIR (<Order>, <CutoffFreq>, <Channel>)

The channel is filtered using a FIR-highpass-filter of the given order (>=4th order) and
cutoff frequency [Hz].
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stopband
Syntax:

– stopband (<Technique>;<Order>;<Frequency Range>;<Expression>)

Parameters:

Technique Order Frequency Range

Chebyshev-I 4 / 8 / 10 / 12 50100 / 50200 / 100200 / 150200

Chebyshev-II 4 / 8 / 10 / 12 50100 / 50200 / 100200 / 150200

Elliptic 4 / 8 / 10 / 12 50100 / 50200 / 100200 / 150200

Butterworth 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 /
11 / 12

50100 / 50200 / 100200 / 150200

The use of the diacritic mark "~" (tilde) between the upper and the lower frequency is
mandatory.

Lookup Function
Syntax:

– Lookup(<LookupTable>;<param1>[;<param2>…])

Parameters:

– LookupTable: The base table for the lookup-value.

– For more information on lookup tables see LookupTables.

– param1-x: The input parameters for the first (x) dimension of the lookup table

– param2-y: The input parameters for the second (y) dimension of the lookup table

Note: The number of the dimensional-parameters has to match the dimension of the
lookup table.

2.3.6.8 Examples
The following examples use a few channels and functions that are:

– speed: The speed of the car in km/h

– lapctr: The current lapnumber

– HOLD: The last value calculated by this math-channel

– dt: Time passed since the last calculated sample of this math-channel

– sigma: Sums up the expression inside for the whole file up to the current sample

Example with sigma and dt - Integration over time
There is no function for integrating a channel over time. No matter, integration over time
is simply the sum of a channel multiplied with the delta-time:

In this example, the speed is integrated over the file. The result is the distance driven (as-
suming the unit of speed is km/h, we have to divide by 3.6 to receive the distance in
meters)

sigma(speed*dt) / 3.6

Example with delta and dt - Derivation of a channel
To derivate a channel by time, you have to divide the change of the channel by the
change of time:
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delta(channel)/dt

Example with HOLD - Filtering measurement errors
Assuming the speed of a car is between 0 and 400 km/h. If we want to clean the speed-
channel from all measurement errors (values outside the valid speed-range) we have to
find the error values.

If (speed <0 OR speed >400;0;speed)

Now every wrong value is set to 0. Instead of using this static value, you may want to keep
the latest reasonable value. This can be accomplished by inserting the HOLD-function:
HOLD returns the previous result of the math channel.

If(speed < 0 OR speed > 400; HOLD; speed)

Examples with sigma, lapsigma, dt, and delta - Calculating
“highspeed”-duration for each lap
In this example, you are shown how to use these functions to generate a math channel
that calculates the duration driven with more than 200 km/h for each lap. First thing to do
is to sum up the time; the car is faster than 200 km/h.

sigma(if(speed > 200; dt; 0))

The if-function returns the time since the last sample when speed is greater 200 and 0 if
not. Sigma sums up the results of the if-function to get the time past driving faster than
200 km/h.

Note:

– This current function sums up the time for the whole file.

If you want the time being calculated for each lap individual, you have to reset the sum at
the each laptrigger.

Unfortunately the sigma-function works on the whole file by default, so you need to reset
the function after each lap. For that matter, the sigma-function has an optional reset con-
dition.

Sigma(if(speed > 200; dt; 0); delta(lapctr) <> 0)

The new part in this function does exactly that. If the lap number changed (delta(lapctr)
<> 0) sigma resets the sum back to zero and starts again.

Note:

– Instead of delta (lapctr) you can also use {laptrig} <> 0.
Whatever your choice is, take care of the calculation period of your math channel. Es-
pecially {laptrig} is a single peak at the lap trigger and can be easily missed, if the cal-
culation period is set to “Slowest channel”. Therefore using the lap counter is better,
but again: If the period is “slowest channel” and your speed is measured faster, you
have to select “fastest channel”!
For more information, see also “Computing Tab”.

There is a faster way to get the same results as well. Use LapSigma for resetting the sum
at the beginning of a new lap.

LapSigma(if(speed > 200; dt; 0))

Example with DetectEvent - Brake Pressure
A Simple math function:

DetectEvent({pbrake_fl} > 10)
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This generates an output with a non-zero value while the condition is true, in this case, the
front brake pressure is greater than 10 bar. For one braking event, this looks like:

1. Rising Edge: The output is equal to a value of '1' for exactly one sample.

2. Event True: The output is equal to a value of '2' while the event is true (between the
rising and falling edge)

3. Falling Edge: The output is equal to a value of '-1' for exactly one sample.

Detect Event Supports Multiple Overloads

– Two additional arguments “BeginDelay” and “EndDelay” were added to DetectEvent.
With these arguments DetectEvent delays state changes by the given amount of time.

– The two arguments are optional and don’t change the signature of the “old” Detec-
tEvent:

DetectEvent(Inactive|Rising|Active|Falling; <BeginCondition>; <Be-

ginDuration>; <BeginDelay>; <EndCondition>; <EndDuration>; <End-

Delay>)

– The kind of the arguments are actually controlled by the given number of arguments.
Hereby the first keyword argument (Inactive/Rising|Active|Falling) is always optional
and is NOT counted as an argument!

DetectEvent with 6 Arguments

DetectEvent(

Inactive|Rising|Active|Falling;

<BeginCondition>; <BeginDuration>; <BeginDelay>;

<EndCondition>; <EndDuration>; <EndDelay>

)

DetectEvent with 5 Arguments

DetectEvent(

Inactive|Rising|Active|Falling;

<BeginCondition>; <BeginDuration>; <BeginDelay>;

; <EndDuration>; <EndDelay>

)
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DetectEvent with 4 Arguments

DetectEvent(

Inactive|Rising|Active|Falling;

<BeginCondition>; <BeginDuration>; ;

<EndCondition>; <EndDuration>;

)

DetectEvent with 3 Arguments

DetectEvent(

Inactive|Rising|Active|Falling;

<BeginCondition>; <BeginDuration>; ;

; <EndDuration>;

)

DetectEvent with 2 Arguments

DetectEvent(

Inactive|Rising|Active|Falling;

<BeginCondition>; <BeginDuration>;

)

DetectEvent with 1 Arguments

DetectEvent(

Inactive|Rising|Active|Falling;

<BeginCondition>;

)

Variables in Math Functions
Math functions support var & local variables

– var declared variables keep their values between the calculation of one sample to the
next. They are initialized once when evaluation the value of the first sample and can
be used to “transfer” intermediate results to the next calculation cycle.

– local declared variables are always initialized when calculating a sample. They can be
used to calculate intermediate values – e.g. if an intermediate result is required mul-
tiple times in the same expression.

Example #1

Calculate the average wheel speed over a file

var wheelSpeedSum

var wheelSpeedCount

Local wheelSpeedAve := (vwheel_fl + vwheel_fr) / 2

wheelSpeedSum := wheelSpeedSum + wheelSpeedAve

wheelSpeedCount := wheelSpeedCount + 1

wheelSpeedSum / WheelSpeedCount

Example #2

You can even use script blocks within any other function argument. Simple put your ex-
pressions within “begin” and “end”

var wheelSpeedSum

var wheelSpeedCount

If (nmot >= 5000;



WinDarab V7 | 2

Bosch Motorsport WinDarab V7 Wiki Manual 133 / 224

begin

Local wheelSpeedAve := (vwheel_fl + vwheel_fr) / 2

wheelSpeedSum := wheelSpeedSum + wheelSpeedAve

wheelSpeedCount := wheelSpeedCount + 1

end; 0)

wheelSpeedSum / WheelSpeedCount

Math Functions Support 'NoValue'
– In math channels you can use “NoValue” to supress any output in WinDarab (e.g. the

oscilloscope signal is interrupted).

– A math function “IsValue” was added to checka input value for “NoValue”.

– Also all analysis windows (should) work correctly, if they meet a “NoValue”.

– Note: All comparisions with NoValue will returns false (NoValue is internally a NaN
double value)

– Here’s a sample math function:

if (nmot > 6000; nmot; NoValue)

This channel will show only a signal, if nmot is larger than 6000 – anywhere else there’s
nothing!

ValueAtDist
ValueAtDist(<channel>; <dist> [; <LapIndex>])

– If <LapIndex> is omitted, <dist> is the absolute distance value within the file.

ValueAtDist(<channel>; <xdist>-10)

returns the value 10m before the current position.

– If <LapIndex> is given, the <dist> argument is a lap distance value.

ValueAtDist(<channel>; 100; LapIndex)

returns the value at position 100m of the current lap.

ValueAtDist(<channel>; lapdist; LapIndex-1)

returns the value at the lap position but in the previous lap

ValueAtTime
ValueAtTime(<channel>; <time> [; <LapIndex>])

– If <LapIndex> is omitted, <time> is the absolute time value within the file.

ValueAtTime(<channel>; <xtime>-10)

returns the value 10sec before the current position.

– If <LapIndex> is given, the <time> argument is a lap time value.

ValueAtDist(<channel>; 10; LapIndex)

returns the value at position 10sec of the current lap.

ValueAtDist(<channel>; laptime; LapIndex-1)

returns the value at the same laptime position but in the previous

lap
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Conditions
Conditions are a smaller size datatype that is meant to represent a boolean value. To ac-
cess the dialog, from the ribbon: Tools → Mathematics → Conditions

Conditions are stored on disk in the Settings.Ini file. This is located at %WinDarab Install%/
Config/Settings.ini.

Alternative to Conditions

– We recommend not using Conditions, as this functionality is nearing end of life and
will be removed in a later version.

Throughout WinDarab, any dialog box where a 'Condition' is specified, you can instead
select a Math function where and value not equal to 0 is true.

– Alternatively, you can enter a condition manually in any of these dialogs

2.3.7 XY-Plot
In a (x, y) graph coordinates are calculated for a pair of values (x, y) in two channels (x-
and y-axis).

This type of function allows you to determine very quickly which (x, y) pairs occur fre-
quently as these tend to show up as a dense, cloud-like accumulation of dots.

A (x, y)-Plot window can display multiple (x, y)-Plots that are bound to different axes. This
way it is very easy to compare the results of different (x, y) graphs.

In addition each (x, y)-Plot can be used to separate the clouds in components and then to
find the regression line for every component. Also for every component the correlation of
dots inside is found. You can also add your own (user) lines for comparison. In the next
figure you can see 4 components and 4 regression lines which correspond to the gears of
the car. There is also one user line indicated by the two movable handles (displayed as
dots on the line).
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Open x/y plot
Drag "Start/Worksheet controls/x-y-plot" into your workspace to open the (x, y)-Plot
Window.

Middle Mouse Click (Left Button + Right Button)
Clicking your middle mouse button (or left + right mouse buttons) displays a local menu
(context menu) with options.

Calculations
Calculations are started after changes in the settings are made, or after “Update View”
from the menu was clicked.

Because calculations can take much time especially if the range is above the whole file,
they are made inside of another thread and you will see a progress bar in this case. In-
stead of waiting for them you can work in some other windows.

For online files calculations are started automatically after changing the range (new
samples have been received) and the view will be updated too. The cross will be moved to
the last drawn dot.

2.3.7.1 XY-Plot Settings
A dialog box with settings appears automatically when you open the (x, y)-Plot Window
for the first time. Closing the window will save the settings. The next time the window is
opened this dialog will not appear again. Instead the saved settings will be loaded.

If you want to modify these settings or carry out a new calculation you can re-open the
dialog box using the menu item “Start/View Settings/ Edit” or by clicking “Set-
tings…” in the context menu.

You can also press the F5 key to open the “Settings” dialog box.
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Global Options Tab

In the global options tab are the options that are regarding all (x, y)-Plots or the window
itself.

Use jpg as Back-
ground Image

If desired, you can activate this option and select a jpg-file that
you want to have displayed in the Background. Zooming in on
the (x, y)-Plot also zooms in on the Picture.

Show Grid This option shows a grid in the background.

Show Info Shows the Offset and Gain of all the lines (regression lines and
user lines) and the correlation of the regression lines.

Display Tab
This tab is used to show all the existing plots, to manage them as well as setting the data
source and the condition, that is applies to the data from the data source.
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Data Source Choose the data that is analyzed by the (x, y)-Plot. The combo
box offers a wide range of selectable options.

Overlays & Channels
to Evaluate

In this list, you see all the (x, y)-Plots that are currently defined.
Every item shows the essential parameters selected for this par-
ticular plot.
It shows the selected overlay, the channels for the x- and y-axis,
the plot mode, the color/color scale for this plot, the marker
style and the selected axes.
You can manage these configurations with the buttons under
this list.
They allow you to rearrange the plots as well as removing,
adding, editing and duplicating them.

Note: If two or more plots have the same x- or y-axis the topmost plot defines the shown
range for this axis.

Plot Edit Dialog
This dialog is shown when you mark an existing (x, y)-Plot and press Modify or by
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The difference between adding a new plot or duplicating an existing plot is that the fields
are filled with default values when adding or with the values from the source plot when
duplicating a plot. The plot itself is only created after pressing OK.

Overlay Choose the overlay from which the data is analyzed.

x-Axis In this section, select the channel, the range and the axis-posi-
tion for the x-axis.

y-Axis In this section, select the channel, the range and the axis-posi-
tion for the y-axis.

Plot You can choose between 3 color modes.
Simple Plot: The simple plot is the basic mode. Every plot-
sample has the color specified for this plot
Frequency: This mode colors the plot-samples according to the
number of other plot-samples around them. This enables you to
highlight the more frequented areas of the plot.
Channel: With this option, you have to choose a channel and its
range. The plot-sample are then colored according to the value
of the selected channel they correlate with.

Appearance Choose the appearance of the plot-samples within the plot-win-
dow. First select the form of each sample. You can choose
between a various size of dots, a cross or circle.
In addition to that, you need to select a color for the samples.
Using the simple plot, just select a color that is used for all the
samples.
In frequency- or channel-mode, you have to select multiple col-
ors for various values.

You can move the sliders by dragging them to another position.
Remove sliders by pulling them away from the scale, and create
new sliders by clicking inside the gradient. You can also use pre-
defined color scale settings by using the button on the right side
of the color scale.
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Condition You can select a predefined condition or write a new one dir-
ectly into the field. The data is filtered by the condition before it
is being analyzed by the (x, y)-Plot.

Cloud detection and
polynomial fitting

In this section you can configure the regression lines, compon-
ents and user lines.
Select the sensitivity and the maximal component-count to reg-
ulate the outcome. The sensitivity controls how far two samples
can be away without losing the connection. The higher the sens-
itivity, the more separate components are found, but also the jit-
ter is reduced.
The maximal component-count limits the components and
therefor the regression lines. The x best components are calcu-
lated.
The components can be optional displayed to see with which
samples the regression lines are calculated.
The last option is to make the user lines visible or hide them.
For more information see: Components and regression lines

Components and Regression Lines
Components are calculated based on the (x, y)-Plot data to find and visualize connected
data samples. To analyze the data, the (x, y)-Plot is divided into a grid. First, the field con-
taining the most samples is set as a starting field of a component. Starting from this field,
the surrounding fields are analyzed. If a surrounding field contains more samples than a
given threshold, the field is added to the component. Now the surrounding fields of the
enlarged component are analyzed and maybe added. This step is repeated until there is
no surrounding field with a high enough sample count to add to the component.
Now the next field with the highest sample count outside a previously found component
is chosen to start a new component. A new component is being built from this. These
steps are repeated until the last component is found.
The higher the sensitivity is set, the finer the grid will be. Also the sample count threshold
rises with the sensitivity.
The count sets the maximum number of components. So if the maximum number of com-
ponents is reached, no new component will be started.
After the components have been found, the regression lines are calculated for each com-
ponent.

Working with the XY-Plot Window
Basic

In the (x, y)-Plot window, the chosen (x, y)-Plots are shown as overlapping layers. Clicking
on the window will show you a cross and the values of the selected dot can be seen in the
surrounding axes.
You can zoom in an area of the window and see more details.
Zoom functions:
Press right mouse button and drag down or up. The marked area will be all x-values and
only the y-values between the y-start drag and y-end drag values.
Press right mouse button and drag left or right. The marked area will be all y-values and
only the x-values between the x-start drag and x-end drag values.
Press Shift-key and then drag a box with pressed right mouse button. The marked
area will be x-values and y-values inside of the dragged box.
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Zoom in The picture will be zoomed in by a factor of 2 so the cross dot
will stay unmoved.
To zoom in:

– Double Click Left

– Context Menu/Zoom in

– Go to Start/Display/Zoom in

Zoom out The picture will be zoomed out by a factor of 2 so the cross dot
will stay unmoved.
To zoom out:

– Double Click Right

– Context Menu/Zoom out

– Go to Start/Display/Zoom out

Show All To show all dots:

– Press A

– Context Menu/Show All

– Go to Start/Display/Show All

Additional Elements
There are components, regression lines, user lines and an InfoBox with the information
about the files and lines. They are additional to the base picture. Additional elements can
be hidden and shown from the menu or the toolbar.

Show Info The InfoBox contains information about files and user lines. In-
formation for every file consists from files ranges, correlation of
the range and file regression lines. Information about file lines
can be shown or hidden by using +/- in front of the file name.
Every line has offset, gain and correlation.
To show info:

– Press i

– Context Menu/ShowInfo

– Go to Start/Display/Show polynomial coefficients

Show Color Scale Displays or hides the color scale for the selected (x,y) plot in the
(x,y) window. This is only available in frequency or channel
mode.
To show scale:

– Press the s

– Go to Start/Display/ShowScale
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Background Image Select and use an image for the background of your (x,y) plot.
To use a background image:

– Go to Start/Background/Use Image

Transparency Shows/Hides the selected (x,y) plot (press h). You can adjust the
transparency of the (x,y) plot by clicking on the drop down but-
ton and change the slider position or by using hotkeys (0-9) to
set the transparency (0% - 90%).
To access the transparency slider:

– Go to Start/Visibility/Transparency

Components Components are continuous regions with approximately the
same density of dots.
To show components:

– Press Ctrl+Space

– Context Menu/Components

Regression Lines Regression lines are calculated and they depend on calculated
components. For every regression line there is a correlation.
To show the regression lines:

Press Space

Context Menu/Regression Line

Go to start/Clouds and polynomial fitting/Fit polynom

Show/Enable User
Lines

User lines are free placeable lines that are inserted into a (x,y)
plot by the user.
To show/enable user lines:

– Press u

– Context Menu/User Lines

– Go to Start_User Lines/Show
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Add User Lines Adding a new user line is done by pressing Insert-key or “Insert
line” from the menu. To add a user line, user lines must be
showing. The inserted line is going through the (0, 0) and the
cross point. A user line can be dragged using two small rect-
angles on the line.
To add a user line:

– Press insert

– Context Menu/Insert Line

– Go to Start/User Lines/Insert

Lines

If the mouse cursor is near a line then the equation of the line will be shown in a small
window. The information about the lines can be seen also in the InfoBox. You can select a
line by clicking near to the line or by clicking in the InfoBox on some row with line inform-
ation. If the line belongs to the component the component will be selected too.

Delete User Lines You can delete the selected line and component.
To delete a selected user line:

– Press delete

– Context Menu/Remove Line

– Go to Start/User Lines/Remove

2.3.7.2 Components and Regression Lines
Components are calculated based on the (x, y)-Plot data to find and visualize connected
data samples. To analyze the data, the (x, y)-Plot is divided into a grid. First, the field con-
taining the most samples is set as a starting field of a component. Starting from this field,
the surrounding fields are analyzed. If a surrounding field contains more samples than a
given threshold, the field is added to the component. Now the surrounding fields of the
enlarged component are analyzed and maybe added. This step is repeated until there is
no surrounding field with a high enough sample count to add to the component.
Now the next field with the highest sample count outside a previously found component
is chosen to start a new component. A new component is being built from this. These
steps are repeated until the last component is found.
The higher the sensitivity is set, the finer the grid will be. Also the sample count threshold
rises with the sensitivity.
The count sets the maximum number of components. So if the maximum number of com-
ponents is reached, no new component will be started.
After the components have been found, the regression lines are calculated for each com-
ponent.

2.3.7.3 Working with XY-Plot Window
Basic
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In the (x, y)-Plot window, the chosen (x, y)-Plots are shown as overlapping layers. Clicking
on the window will show you a cross and the values of the selected dot can be seen in the
surrounding axes.
You can zoom in an area of the window and see more details.
Zoom functions:
Press right mouse button and drag down or up. The marked area will be all x-values and
only the y-values between the y-start drag and y-end drag values.
Press right mouse button and drag left or right. The marked area will be all y-values and
only the x-values between the x-start drag and x-end drag values.
Press Shift-key and then drag a box with pressed right mouse button. The marked
area will be x-values and y-values inside of the dragged box.

Zoom in The picture will be zoomed in by a factor of 2 so the cross dot
will stay unmoved.
To zoom in:

– Double Click Left

– Context Menu/Zoom in

– Go to Start/Display/Zoom in

Zoom out The picture will be zoomed out by a factor of 2 so the cross dot
will stay unmoved.
To zoom out:

– Double Click Right

– Context Menu/Zoom out

– Go to Start/Display/Zoom out

Show All To show all dots:

– Press A

– Context Menu/Show All

– Go to Start/Display/Show All

Additional Elements
There are components, regression lines, user lines and an InfoBox with the information
about the files and lines. They are additional to the base picture. Additional elements can
be hidden and shown from the menu or the toolbar.

Show Info The InfoBox contains information about files and user lines. In-
formation for every file consists from files ranges, correlation of
the range and file regression lines. Information about file lines
can be shown or hidden by using +/- in front of the file name.
Every line has offset, gain and correlation.
To show info:

– Press i

– Context Menu/ShowInfo
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– Go to Start/Display/Show polynomial coefficients

Show Color Scale Displays or hides the color scale for the selected (x,y) plot in the
(x,y) window. This is only available in frequency or channel
mode.
To show scale:

– Press the s

– Go to Start/Display/ShowScale

Background Image Select and use an image for the background of your (x,y) plot.
To use a background image:

– Go to Start/Background/Use Image

Transparency Shows/Hides the selected (x,y) plot (press h). You can adjust the
transparency of the (x,y) plot by clicking on the drop down but-
ton and change the slider position or by using hotkeys (0-9) to
set the transparency (0% - 90%).
To access the transparency slider:

– Go to Start/Visibility/Transparency

Components Components are continuous regions with approximately the
same density of dots.
To show components:

– Press Ctrl+Space

– Context Menu/Components

Regression Lines Regression lines are calculated and they depend on calculated
components. For every regression line there is a correlation.
To show the regression lines:

Press Space

Context Menu/Regression Line

Go to start/Clouds and polynomial fitting/Fit polynom
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Show/Enable User
Lines

User lines are free placeable lines that are inserted into a (x,y)
plot by the user.
To show/enable user lines:

– Press u

– Context Menu/User Lines

– Go to Start_User Lines/Show

Add User Lines Adding a new user line is done by pressing Insert-key or “Insert
line” from the menu. To add a user line, user lines must be
showing. The inserted line is going through the (0, 0) and the
cross point. A user line can be dragged using two small rect-
angles on the line.
To add a user line:

– Press insert

– Context Menu/Insert Line

– Go to Start/User Lines/Insert

Lines

If the mouse cursor is near a line then the equation of the line will be shown in a small
window. The information about the lines can be seen also in the InfoBox. You can select a
line by clicking near to the line or by clicking in the InfoBox on some row with line inform-
ation. If the line belongs to the component the component will be selected too.

Delete User Lines You can delete the selected line and component.
To delete a selected user line:

– Press delete

– Context Menu/Remove Line

– Go to Start/User Lines/Remove

2.3.7.4 Plotting GPS with a Maps Background
GPS data can be plotted, with a maps background, using an XY plot. Follow these steps to
plot GPS data with a maps background:

1. Open a new XY Plot

2. Plot the GPS data

– Select the data file with the gps data for the Overlay

– Select the longitude GPS data channel for the X-Axis

– Select the Latitude GPS data channel for the Y-Axis
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3. Screen capture a map of the track
Here is a possible method for obtaining the screen capture:

– Zoom all of the way out on the plot of the GPS data in WinDarab

– Note the range of the both axes (more specifically, note the coordinates of the bot-
tom leftmost point and the coordinates of the upper rightmost point)

– Open Google Earth on a Web Browser

– Open the search box (press the magnifying glass on the left side of the screen)
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– Enter the coordinates of the bottom leftmost point in the search bar

– Click Add to project in the pop-up to save the mark
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– Choose the name and project that you want to save the marker as, and click Save

– Repeat the last four steps for the coordinates of the top rightmost point. Once com-
pleted, there should be two marks on the map, marking the location of the corners of
the GPS data plot.
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– If needed, press the 2D icon, as well as the compass icon in the bottom right of the
screen to make a straight, top-down view.

– If there are other locations/businesses marked in the view, click on the map style icon
on the left side of the screen
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– and then choose Clean for the map style

– Use the Windows Snipping Tool to take a screen capture from one marker to the
other, and save the capture as a jpeg
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4. In the WinDarab GPS data plot, set the capture of the map as the background

Note: If the GPS data does not show up well on map, the size and color of the points can
be adjusted.

2.4 Advanced Use-Cases

2.4.1 Alias Channels
WinDarab has the concept of 'Alias Channels' These are channels that can be 'place hold-
ers' for other channels. Common usecases include:

– Renaming channels e.g., nmot -> Engine Speed

– Placeholding missing channels

– If a channel is missing (removed from logger or not on telemetry) but is used in a
Math Function
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Configuration

Potential [source] channels are checked in order from top to bottom. If a potential chan-
nel is found and is valid, it is used as the source for the Alias Channel.

Alias Channels Can Contain Variable Parts
– An alias channel name and the names of its possible member channels can contain

indexers. WinDarab automatically expands the alias channel definition (internally) to
discrete alias channels:

– The indexer can be given as a list of name parts “[part1,part2]” or a range [1..4] or [a-
d] or any combination [a,b-d]

– The number of indexers in the alias channel name and its member channel names
have to match!

Example

You want alias channels wheelspeed_fl, wheelspeed_fr, …

Now you can create an alias channel definition named “wheelspeed_[fl,fr]”

And give the following member channels:

– vspeed_[fl,fr]

– vwheel_[fl,fr]

– vspeed_[0..1]

2.4.2 Setupsheets
In WinDarab vehicle setupsheets can be created and maintained to correlate data with car
changes. Setupsheet values can be used in data analysis for viewing and calculations.
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What are setupsheets?
If a file is opened, WinDarab looks for the file “Setupsheet.xml” starting in the folder of the
file and all folders up to the root. If a setupsheet is found, the setupsheet is applied to the
file.

A setupsheet contains sections with CAR elements. A CAR element contains a file name
pattern attribute which is used by WinDarab to determine which CAR element is used for
a certain file.

A CAR element contains CHANNEL elements which are used to define virtual channels.

Each CHANNEL element contains one or more OUTING elements, which define the chan-
nels value for the given outing.

WinDarab is now creating/updating a virtual channel and puts the found outing value into
this channel (at least at each beginning of a lap or file).

Folder Layout Options
Example Folder Layout:

C:

└── Data

└── 20190325 - Sebring

├── Chassis 1

│ ├── Setupsheet.xml

│ ├── Chassis 1 Outing 1.bmsbin

│ └── Chassis 1 Outing 2.bmsbin

└── Chassis 2

├── Setupsheet.xml

├── Chassis 2 Outing 1.bmsbin

└── Chassis 2 Outing 2.bmsbin

Alternate Folder Layout:

C:

└── Data

└── 20190325 - Sebring

└── Setupsheet.xml

├── Chassis 1 Outing 1.bmsbin

├── Chassis 1 Outing 2.bmsbin

├── Chassis 2 Outing 1.bmsbin

└── Chassis 2 Outing 2.bmsbin

Setupsheet Creation
There are two main ways to create setupsheets.

1. Manually via the WinDarab Gui

2. Programmatically from an existing Excel sheet or other source (XML File).

Manual Creation

To create a setupsheet:

– Click on the Setupsheet icon in the ribbon under Tools → Mathematics

– Right Click on the <filename> in the File Explorer
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Or

This will open the setupsheet creation and editing interface. Rename your setupsheet as
desired; then click to add channels.

Add and configure properties for all channels to be used. Channels can be added or ed-
ited later from the same window.
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To finish inserting initial values add an outing, add setupsheet values, and Save & Close.

Programmatic Creation

Notes

– The hierarchical order of CHANNEL and OUTING elements can be switched.

– Currently there’s no UI to edit the “Setupsheet.xml” this will come.

– If a persistent virtual channel is defined by the setup sheet, WinDarab checks and (if
necessary) updates the saved channel data.

– Changes to the setupsheet.xml are automatically detected and used to update the vir-
tual channels immediately!

The following attributes are supported:

Attribute Property Description

CAR Filename Filename pattern (with wildcards “*” or “?”) to select the node
for a file.

CHANNEL Name Name of the (virtual) channel

Unit Unit of the (virtual) channel)

Format Number format (Len.Dec), The numbers are 10-based.

Min Default y-axis view minimum
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Max Default y-axis view maximum

Persistent If True, the virtual channel is saved to the file.

Note:

– To match all files, use the Filename pattern: '*'

Example XML Format

<!-- One way -->

<SETUPSHEET>

<CAR Filename="Chassis 3*">

<CHANNEL Name="packer_fl" Unit="mm" Format="5.2" Min="18" Max="20"

Persistent="True">

<OUTING Value="108">18.5</OUTING>

<OUTING Value="109">19.3</OUTING>

<OUTING Value="106">19.2</OUTING>

</CHANNEL>

<CHANNEL Name="packer_fr" Unit="mm" Format="5.2" Persist-

ent="True">

<OUTING Value="107">18.5</OUTING>

<OUTING Value="108">19.5</OUTING>

</CHANNEL>

<CHANNEL Name="packer_rl" Unit="mm" Format="5.1" Persist-

ent="True">

<OUTING Value="108">19.5</OUTING>

<OUTING Value="109">19.2</OUTING>

</CHANNEL>

<CHANNEL Name="packer_rr" Unit="mm" Format="6.3" Persist-

ent="True">

<OUTING Value="107">18.5</OUTING>

<OUTING Value="108">19.5</OUTING>

<OUTING Value="109">19.2</OUTING>

</CHANNEL>

</CAR>

</SETUPSHEET>

<!-- Other way -->

<SETUPSHEET>

<CAR Filename="Chassis 3*">

<OUTING Value="107" >

<CHANNEL Name="packer_fl2" Unit="mm" Persistent="True">18.5</CHAN-

NEL>

<CHANNEL Name="packer_fr2" Unit="mm" Persistent="True">18.5</CHAN-

NEL>

<CHANNEL Name="packer_rl2" Unit="mm" Persistent="True">18.5</CHAN-

NEL>

<CHANNEL Name="packer_rr2" Unit="mm" Persistent="True">18.5</CHAN-

NEL>

</OUTING>

<OUTING Value="108" Persistent="True">

<CHANNEL Name="packer_fl2">18.0</CHANNEL>

<CHANNEL Name="packer_fr2">18.0</CHANNEL>

</OUTING>
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<CAR>

</SETUPSHEET>

Using Setupsheet Channels for Data Analysis
For the Setupsheet values to be used in data analysis two conditions must be met:

3. The setupsheet CAR attribute Filename must match the BMSBIN file name. Wildcards
can be inserted with asterisks (*). Screenshots in the Manual Creation section show
the Filename as "*Data 1", this allows files whose name ends with "Data 1" to match
with the setupsheet

4. The setupsheet file must contain the outing number to match the dataset outing
number. Outing numbers can be manually edited in the Setupsheet GUI by clicking on
an outing number. An outing number value of '0' can be used as a 'global' or 'default'
value for the setupsheet

Using Values in Plots and Math

Setupsheet channels shown as "Virtual Channels", persistence can be set with the chan-
nel properties. These Virtual Channels can be used the same as all other virtual channels in
functions, conditions, and plots.

Changing existing Setupsheets

Setupsheets can be updated by opening the Setupsheet GUI and clicking on values to be
changed. Channels and outings can be edited, added, or deleted at any time.

Example: Setupsheet & Telemetry

As of WinDarab 7.7.003, Setupsheets can be used with Telemetry.

Prerequisites:

5. Setupsheet file must exist in the %WinDarab Install Directory% / Config / WD-
Server directory.

– The easiest way to do this is to use File Explorer → Setupsheet

6. WinDarab needs to know what Outing and Lap Special Channels your telemetry
stream is using.

– These are probably laptrigger_outcnt_dls and laptrigger_lapcurr_dls
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Verify your special channels settings are correct with your telemetry stream connec-
ted if your File Explorer looks similar to this:
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2.4.3 Comparing Overlays
In WinDarab it is possible to compare multiple overlays in multiple ways.

Overlays Setup
Add Overlays

Overlays can be created in the File Explorer Window with one or more files open. To cre-
ate multiple overlays:

– Select Overlay/Add

or

– Right click an overlay Orb/New Overlay/Add
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Now with multiple Overlays added:

Delete Overlays

Overlays may be deleted by two methods:

– Select Overlay/Delete

or

– Right click an overlay Orb/New Overlay/Delete
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Change Overlay Selection

Files selected for overlays can be changed in the File Explorer Window by clicking in the
grid where no overlay is currently set:

Show/Hide Overlays

Overlays can be shown or hidden without adding and deleting the overlay recreating set-
tings. To do so right click on the overlay and toggle Show Overlay:
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Oscilloscope
Both overlays will show in the Oscilloscope Window by default.

Compare two overlay differences

Overlays can be compared with the difference in values shown. This is especially useful
when doing a comparison of two drivers.

– Set the base Overlay by right clicking on the overlay orb then selecting Use as base
for differences.
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– Show the channel as a difference by right clicking on the channel value then select-
ing Use as diff-channel.

An example outcome for looking at laptime gain/loss:

Remove Overlay from Oscilloscope

To remove an overlay value from an oscilloscope:

– Click the value of the overlay you wish to remove from this area then press delete on
the keyboard.

or

– Right click the value of the overlay you wish to remove from this area and click Re-
move

2.4.4 Special Channels

Internal Channels
In addition to defining recorded channels, WinDarab also defines its own, internal chan-
nels. Apart from some exceptions, internal channels are treated like recorded channels.
The following table lists all internal channels and their descriptions:

Channel Description

laptrig when vehicle is passing lap trigger, otherwise 0

Mux Row values identifier (Reader/CanCard)
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Block number (CardMemory)

samples Record Number/ Samples
Channel has a special plotting routine, plotting every record as
a single dot.

xdist Distance axis
Logged distance travelled will be standardised to accord with
the course length-- if the difference between the logged lap
length and specified lap length is less than 5 %.
If the channel has not been recorded directly, it will be calcu-
lated using values from rawdist and laptrig.

xtime Time axis

lapdist Distance travelled on the course since last lap trigger.

laptime Time logged since last lap trigger.

rawdist Logged distance

Card Memory Only

Channel Description

dbg_time Block time stamp
(CardMemory with active debug switch only)

dbg_dist Block distance stamp
(CardMemory with active debug switch only)

Note

– Some channels may not be available depending on the hardware you use and its con-
figuration.

Special channels settings
WinDarab provides the user the possibility to define a list of special channels for the fol-
lowing categories:

Category Description

Distance Contains channels or calculation methods WinDarab should use
to generate distance information. Predefined calculation meth-
ods are “Calculate using GPS”, “Calculate using speed” and “De-
fault distance”.

Speed List of channels, which contain speed information. If a file con-
tains one of the channels in the list, it will be used in other cal-
culation (e.g., calculation of the distance information).
Predefined channels are “vfz_w”, “vfzg” and “speed”.

GPS Horizontal (meter) List of channels, which contain horizontal GPS-coordinates con-
taining data, which is transformed into relative meters.

GPS Vertical (meter) List of channels, which contain vertical GPS-coordinates con-
taining data, which is transformed into relative meters.

GPS Height(meter) List of channels containing GPS-height in meters.

GPS Longitude (Earth) List of channels, which contain the longitude of the

GPS Latitude (Earth) List of channels, which contain the latitude of the

GPS Height (Earth) List of channels, which contain the height of the GPS-coordin-
ates. The channel “gps_alt” is predefined.
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The user can select special channels for each category. WinDarab uses these lists to find
channels containing needed information. If a file contains one of the channels listed, it will
be used for further calculations. If a file contains more than one of the channels in the list,
the user selects must select one.

Defining a special channels list
To define special channels for the categories listed above or to modify a special channels
list, follow these steps:

1. Use “Tools → Settings → Program” to open the “Options” dialog box.

2. Select the “Special channels” tab.

3. Select the category from the “Special channels for” – list.

4. The “Special channels” tab contains two channel lists - list of all channels in the meas-
urement file and list of special cannels for the selected category.

– To add a channel to special channels list:

– Select the channel from the list of all channels and click on the Forward -button.

– To delete a channel from the special channel list:

– Select the channel from the special channel list and click on the Back -button.

The channels and the calculation methods in the special channel list have a priority. The
position of a channel in the list determines its priority. The higher the position of a chan-
nel in the list, the higher the priority. The user can change the priority of a channel or cal-
culation method as follow:

5. Select the desired channel in the list.

6. Place the channel to the desired position by using the up and down arrow buttons.

Note:

– The reserved entries in a special channel list cannot be removed.

– For distance generation information is valid - the calculation methods always have a
higher priority than the channels selected by the user.
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– If the channel provided for distance information was not sampled with each sample
block, the interpolation of the channel for each sample position was not “good”
enough, if the channels quantization did not offer enough precision for the interpol-
ated values.

– The channels provided for distance generation shall be monotonically strictly in-
creased (derivative > 0). Except the first two samples of the channel. In this very spe-
cial case, the first sample will be extrapolated based on the values of the second and
third sample. WinDarab carries out additional checks to ensure this and shows a mes-
sage if a distance channel cannot be used.

– If the distance channel is not strictly increasing, WinDarab interpolates the duplicate
values and saves the results to the file. This is done once when the channel is accep-
ted as distance channel.

– If distance information is calculated by GPS (the calculation method “Calculate using
GPS” is selected) and WinDarab runs with a unit converter for the distance channel,
the lap normalization is not working in the case the user changes the current
racetrack. Only in this case the data is not normalized (but as measured!).

2.4.5 WinDarab Pre-Configuration

Math Functions
A folder of *.BMSMTH files can be added to the default location for math functions. The
math functions can be organized and nested into sub-folders.

Users can specify an alternative default location for math functions which can be a shared
repository, a network drive (functions will be unavailable if the drive is disconnected), etc.

Alias Channels
An alias channel settings file can be in the default location for Math Functions. This file is
in standard XML format, so it can easily be checked into revision control software (git, svn,
etc)

Channel Settings
A channel settings file Config/ChannelSettings.xml can provided to users. Anything in
the Channel Settings dialog can be defined. This file is in standard XML format, so it can
easily be checked into revision control software (git, svn, etc)

Channel Colors
Similarly, to Channel Settings above, a channel colors file Config/ChannelColors.xml can be
provided to users. This will allow consistent colors of channels for all users. This file is in
standard XML format, so it can easily be checked into revision control software (git, svn,
etc)

Advanced Usecase
Users could use git to maintain common settings across multiple users. Changes to the
above-mentioned files/configurations could be easily tracked/shared.

Setup your base project:

1. Clone Repository from WinDarab Base Configuration into your WinDarab Install Dir-
ectory



WinDarab V7 | 2

Bosch Motorsport WinDarab V7 Wiki Manual 167 / 224

– This is a base repository with only a .gitignore file.

2. Make your project specific settings.

3. Commit your changes.

4. Change the git remote to your repository.

– For more information on this topic, please contact Bosch Motorsport

5. Push changes

Provide your project to users in your organization:

6. Install WinDarab

7. Git Clone your repository into the install directory.

Multi-Project Advanced Usecase
The above could be expanded when looking at data from multiple projects for example:

– If a user is looking at data for a GT3 car and a drag car

Recommended Steps:

8. Create Branch A and copy files related to your project.

9. Commit this branch.

10. Create a new branch Branch B with files related to project B

11. Commit this branch.

Now you can easily switch between branches (This should be done with WinDarab shut-
down)

Pitfalls
– Don't forget to commit any changes as you work!

– Pulling updates will overwrite any un-committed changes.

2.5 Hotkeys
The following sections lists Hotkeys supported in WinDarab.

Global

F1 Show help

Ctrl+F1 Minimize/maximize ribbon

F2 Create new worksheet

F3 Go to the channels pane

F5 Show the settings dialog for the window

F6 Load a configuration for the window

F7 Save the configuration for the window

F9 Load desktop settings

F10 Save the desktop settings

F11 Enable/disable "Play" mode
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F12 Toggle desktop layout

Ctrl+E Open measurement file

Ctrl+S Close a measurement file

Ctrl+I Open the initialize flashcard dialog

Ctrl+R Open the import dialog

Ctrl+Shif
t+C

Show/Hide all captions of the worksheets controls on the current worksheet

Ctrl+L Zoom current lap and align all overlays

Ctrl+F4 Close active worksheet

Shift+F4 Close active worksheet control

Ctrl+F6 Go to next worksheet

Ctrl+Tab Go to next worksheet

Ctrl+Shif
t+F6

Go to previous worksheet

Ctrl+C Copy

Ctrl+In-
sert

Copy

Ctrl+X Cut

Shift+De
l

Cut

Ctrl+V Paste

Shift+In-
sert

Paste

File Explorer Pane

R Replace the active overlay

F Go to the fastest lap of the selected overlay

Ctrl+F Select and align the fastest laps of all overlays

Channels Pane

/ Minimize tree (in tree mode only)

* Expand tree (in tree mode only)

Oscilloscope

G Show/Hide the grid

P Go to the previous lap

N Go to the next lap
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F Go to the fastest lap

Ctrl+F Select and align the fastest laps of all overlays

Ctrl+N Go to the next event

Ctrl+P Go to the previous event

Double
Click

Mark event range

Shift+-
Double
Click

Zoom event range

Shift+Le
ft Click
Drag

Mark range

+ Zoom in

- Zoom out

M Zoom the marked range

L Zoom the current lap

S Zoom the current segment

T Zoom between the current marker position and a set tag

A Show all

Ctrl+Shif
t+A

Select all channels

Ctrl+A Select all channels of the current area

Insert Show the insert menu

R Show the replace menu

Delete Show the delete menu

Ctrl+De-
lete

Clear the oscilloscope

Z Set the zero-offset

Ctrl+-
Back-
space

Undo the last zoom

Ctrl+Z Undo the last zoom

F4 Enable/Disable overlay shifting

Space Set/Clear tag

X Toggle axis mode

Ctrl+X Switch axis mode to custom

Ctrl+Shif
t+X

Switch axis mode to overlapped

Shift+X Switch axis mode to stacked

Ctrl+L Switch x-axis between absolute and lap-based

Ctrl+D Use the selected channel(s) as diff-channel

H Show/Hide channel

B Enable/Disable channel blinking

C Show channel color selector
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Y Show channels y-range dialog

Shift+Y Set the channels y-range to the default values

Ctrl+Y Set the channels y-range automatically

D Shows the channels display options menu

D, E Show/hide extremas

D, N, #/
X

Adjust channel format to N decimal places or change format

V Shows the oscilloscope display menu

W Shows the wide cursor menu

I Show/Hide quick info of a channel

Ctrl+C Copy the current value of celected channel to clipboard

Ctrl+0 Show the zero line

Ctrl+9 Set the constant line

Ctrl+Up/
Down

Shift the visible y-axis-range of the channel

Inform Window

Left Select previous overlay

Right Select next overlay

PageUp Select next page

PageDo
wn

Select previous page

Racetrack

A Show all

Ctrl+2 Switch to 2D-view

Ctrl+3 Switch to 3D-view

Ctrl+P Toggle perspective view (3D only)

F6 Load racetrack

F7 Save racetrack

Ctrl+Z Undo the last zoom

Ctrl+-
Back-
space

Undo the last zoom

XY-Plot

A Show all

Ctrl+3 Switch to 3D view

Ctrl+B Switch to 2D bar view
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Ctrl+L Switch to 2D line view

Ctrl+P Toggle perspective view (3D only)

Y Open the y-axis dialog

Ctrl+Y Automatically adjust the y-axis settings

G Show/hide grid

F Show/hide header table

Q Show/hide samples window

Ctrl+Z Undo the last zoom

Ctrl+-
Back-
space

Undo the last zoom

Distribution

A Show all (3D only)

Ctrl+2 Switch to 2D-view

Ctrl+3 Switch to 3D-view

Ctrl+G Toggle grid (3D only)

Ctrl+L Toggle height lines (3D only)

Ctrl+P Toggle perspective view (3D only)

Ctrl+S Toggle solid slices (3D only)

Ctrl+V Toggle 3D vertices (3D only)

F Show/hide header table

Ctrl+Z Undo the last zoom

Ctrl+-
Back-
space

Undo the last zoom

Histogram

A Show all (3D only)

Ctrl+2 Switch to 2D-view

Ctrl+3 Switch to 3D-view

Ctrl+L Switch to plot view

Ctrl+P Toggle perspective view (3D only)

F Show/hide header table

Ctrl+Z Undo the last zoom

Ctrl+-
Back-
space

Undo the last zoom
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Fast Fourier Transform

A Show all (3D only)

Ctrl+2 Switch to 2D line view

Ctrl+3 Switch to 3D-view

Ctrl+B Switch to 2D bar view

Ctrl+G Toggle grid (3D only)

Ctrl+L Toggle height lines (3D only)

Ctrl+P Toggle perspective view (3D only)

Ctrl+S Toggle solid slices (3D only)

Ctrl+V Toggle 3D vertices (3D only)

F Show/hide header table

Ctrl+Z Undo the last zoom

Ctrl+-
Back-
space

Undo the last zoom

Flow Chart

V Show/Edit variables

Delete Delete the selected items

Outing Report

F3 Show channel view

F4 Show segment view

Lap Analysis

I Show/hide information

Instrument Panel

Ctrl+D Duplicate an item

Ctrl+F6 Add settings

Shift+U
p/Down

Align gauge(s) to top/bottom

Shift+Le
ft/Right

Align gauge(s) to left/right

Ctrl+Up/
Down

Align gauge to top/bottom within another gauge when multi selected
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Ctrl+Left
/Right

Align gauge(s) to left/right within another gauge when multi selected

Insert Show the insert item menu

Delete Delete an element

2.6 COM-API / BMS2API
API Documentation
Full documentation for the API calls can be found from WinDarab.

Sample Files
Sample files are available in:

– C#

– VBA/Excel

– Matlab

These can be found on your computer at:<WinDarab Install>/Samples.

Registering the API with Windows
WinDarab automatically registers the COM-API and BMS2API with Windows on installa-
tion. However, some users run multiple installs of WinDarab and COM-API/BMS2API can
only be registered to a single install of WinDarab. If this is the case, we provide three
batch scripts:

1. DarabRegClean.cmd

2. DarabRegister.cmd

3. DarabUnregister.cmd

These must be run with Administrator privileges.

DarabRegClean

This is scripts solves a problem from much older WinDarab versions < 7.4, it unregisters
any (and all) versions of WinDarab from the Windows registry. Then it registers the version
of WinDarab from the executing directory of the script.

DarabRegister

This script triggers WinDarab to register the version contained in the executing directory.

DarabUnRegister
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This script removes the registration of the Darab contained in the executing directory.

COM-API vs BMS2API
COM-API

Using COM-API allows some control over WinDarab:

– Attaching to or creating new instances of WinDarab Application

– Data Domain (opened files and overlays)

– Cursor position

– View range

– Marked/Tagged range

A user can also compile their application as a WinDarab Plugin this allows custom buttons
and menus on the WinDarab Ribbon

Apart from plugins, applications using COM-API are out of process communication.

BMS2API

Using BMS2API allows the user to have in process communication.

When using BMS2API, there is no WinDarab Application that is spawned or interacted
with. This is prefered if the user needs to access purely the data stored in a WinDarab
datafile for external processing.

Creating COM-API vs BMS2API
% COM-API in Matlab

WinDarabApp = actxGetRunningServer('WinDarab.Application');

// COM-API in C#

var comType = Type.GetTypeFromProgID("WinDarab.Application");

dynamic application = Activator.CreateInstance(comType);

% BMS2API in Matlab

WinDarabApp = actxserver('BMS2Api.Application');

// BMS2API in C#

var comType = Type.GetTypeFromProgID("BMS2Api.Application");

dynamic application = Activator.CreateInstance(comType);

API in C / C++ / C#
C / C++

Header files are now included to aid in application/plugin development.

C#

Adding a reference via COM to either the BMS2API or WinDarab (COM-API) is preferred.
This provides static type checking and syntax completion in Visual Studio / Visual Studio
Code
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Opening Telemetry Data
The best practice to open telemetry data is to pass the telemetry URI to the Applica-
tion.OpenDataFile:

// C# example

string serverName = "Users Computer"; // the name of the PC host-

ing WDServer

string carName = "My Car"; // the name of the 'Car' in WDServer

string path = $"\\.\Telemetry\{serverName}\{carName}";

var app = new WinDarab.Application();

var telemetryFile = app.OpenDataFile(path);

Updating Virtual Channels
Important points:

– You cannot update the values of a virtual channel.

– You must remove the virtual channel and then re-add it.

The following sample shows a functional pattern.

void Main()

{

// Get a reference to the currently running WinDarab

// This is dangerous if you run multiple instances of WinDarab!

var app = Application.GetActiveObject();

//get the currently selected Datafile

var dataFile = app.CurrentDomain.CurrentOverlay.DataFile;

NewVirtualChannel(dataFile);

}

void NewVirtualChannel(WinDarabNet.DataFile df){

var channelName = "my demo channel";

// We need to remove the channel if we already made it

RemoveChannelIfAlreadyMade(channelName,df);

// Nominate a 'base' channel, we only need the Timeline from this

channel

var baseChannel = df.Channels["speed"];

var channel = df.NewVirtualChannel();

channel.Description = "Hi I'm a demo";

channel.Source = "demo";

channel.Name = channelName;

channel.TimeLine = baseChannel.TimeLine;

channel.IsPersistent = true;

//create dummy data and fill the array
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double[] values = new double[baseChannel.TimeLine.TimeStamp-

Count].Select(x => 4.0).ToArray();

channel.SetPhysicalValues(0,values);

channel.Publish();

}

void RemoveChannelIfAlreadyMade(string name, WinDarabNet.DataFile

df)

{

var channel = df.Channels[name];

if (channel != null)

{

channel.DataFile.RemoveChannel(channel as WinDarabNet.Channel);

}

}

COM-API Can Create New Measurement Files
– A 3rd party application/plugin can use the UserDataFile class to create new measure-

ment files with application generated channel data.

– Files created with the new API are written in WinDarab file format v2 which is suppor-
ted since WinDarab v7.6.

– A brief example how to write a file can be found in the BMS2ApiSamples.Net project,
see the source in CreateUserDataFile.cs

2.7 Printing
You can generate print previews for and print Logged Data as well as Analysis Windows.

Note:

It could be possible that very fine lines will not be displayed in the print preview. This
may be a result of a discrepancy between your screen and printer resolution.
The lines will be visible when printed.

If you choose your colors, please consider that background colors will not be printed. For
example, light colors against a black background are easy to see on screen, but your prin-
ted output will be difficult to read.

Print Options
Before a print job starts printing, or before the Print Preview appears on your screen, Win-
Darab will display a dialog box with printing options.

”Layout” Tab
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If more than one print layout is available for the window you want to print, you can select
the desired layout in this tab.

”Logged Data” Tab

Use this tab to determine the details you want an Oscilloscope to contain for printing.

Print Preview
Use these steps to print a window:

1. Arrange the window you want to print so that the data will be displayed in the desired
form.

2. Select “WinDarab-Button→ Print→ Print Preview” from the menu.

3. A selection of available templates for printing windows now appears. Choose the
template you want.
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4. The “Print Preview” window will now be displayed.

5. Use this window to

– set a zoom factor (10 to 400 %)

– print a template.

– close the window.

Print
Follow these steps to print a window directly:

Arrange the window you want to print so that the data is displayed in the desired form.

Select “WinDarab-Button→ Print→ Print” from the menu.

A selection of available templates may now appear. Choose the template you want.

The Windows “Print” dialog box appears next. Click on “OK”.

The template you have chosen will now be printed.

Note:
The Windows “Print” dialog box will only permit you to select your printer. All other set-
tings have no effect.

2.8 New Features Archive

2.8.1 New Features in WinDarab 7.7

2.8.1.1 Text/ASCII Import
Starting in WinDarab 7.7.38 we have added additional support for variations of text files to
import. Most Tab, Comma, and Semicolon delimited files are detected. Note: The files
must contain a time or xtime channel.

2.8.1.2 Support for File Compression
WinDarab 7.8 by default generates compressed data files. (~80 % reduction in disk space).
WinDarab 7.7.36+ supports opening these files.

2.8.1.3 Smooth Scrolling Settings
Smooth scrolling setting is now available in the Tools → Program options

2.8.1.4 New Math Channel Option "Include relevant Timestamps"
Some math channels work better if relevant timestamps are included to the math func-
tion. E.g. functions like “LapSigma” reset their result if a laptrigger is passed. However, val-
ues can be incorrect at the laptrigger boundary if this timestamp (exactly at laptrigger)
isn’t included in the selected timeline. This new option ensures that the timestamps of the
laptriggers are included in the math channels timeline and the math channel has a value
at these positions.

Note: The used math functions in a math formula control if relevant timestamps exist and
which they are (an example is LapSigma which adds the timestamps of the laptriggers to
the math channel).
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2.8.1.5 Show Extremas

How to find it
1. Higlight Channel in Oscilloscope

What it does

2.8.1.6 New Colors
Oscilloscopes and XY plots can get very busy when multiple signals are added. We have
added 20 distinct colors to help.
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Customize
These colors can be customized in setting.ini.

[Options]

DisinctColors= 0xe6194b, 0x3cb44b, 0xffe119, 0x4363d8, 0xf58231,

0x911eb4, 0x46f0f0, 0xf032e6, 0xbcf60c, 0xfabebe, 0x008080, 0xe6-

beff, 0x9a6324, 0xfffac8, 0x800000, 0xaaffc3, 0x808000, 0xffd8b1,

0x000075, 0x808080, 0xffffff, 0x000000__

Here’s an alternative set of colors:

DistinctColors=0xa6cee3, 0x1f78b4, 0xb2df8a, 0x33a02c, 0xfb9a99,

0xe31a1c, 0xfdbf6f, 0xff7f00, 0xcab2d6, 0x6a3d9a, 0x8dd3c7,

0xffffb3, 0xbebada, 0xfb8072, 0x80b1d3, 0xfdb462, 0xb3de69, 0xfc-

cde5, 0xd9d9d9, 0xbc80bd, 0xffffff, 0x000000

2.8.1.7 .mf4 Support
Support for MF4 ASAM files has been added.

Note: Some MDF4 features are not available. E.g.

– MDF4 Events

– Opening/viewing Attachments

– Some data types like CANDate/Time and String types

– Array types

2.8.1.8 Copy as image
All worksheets now support Copy as image.
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2.8.1.9 New Math Function Editor
We have overhauled the math function editor. It now supports:

– Keyword highlighting

– Intellisense

– Live syntax checking

– Bracket highlighting

2.8.1.10 Variables in Math Functions
Math functions support var & local variables

– var declared variables keep their values between the calculation of one sample to the
next. They are initialized once when evaluation the value of the first sample and can
be used to “transfer” intermediate results to the next calculation cycle.

– local declared variables are always initialized when calculating a sample. They can be
used to calculate intermediate values – e.g., if an intermediate result is required mul-
tiple times in the same expression.

Example #1
Calculate the average wheel speed over a file

var wheelSpeedSum

var wheelSpeedCount

Local wheelSpeedAve := (vwheel_fl + vwheel_fr) / 2

wheelSpeedSum := wheelSpeedSum + wheelSpeedAve

wheelSpeedCount := wheelSpeedCount + 1

wheelSpeedSum / WheelSpeedCount

Example #2
You can even use script blocks within any other function argument. Simple put your ex-
pressions within “begin” and “end”

var wheelSpeedSum

var wheelSpeedCount
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If (nmot >= 5000;

begin

Local wheelSpeedAve := (vwheel_fl + vwheel_fr) / 2

wheelSpeedSum := wheelSpeedSum + wheelSpeedAve

wheelSpeedCount := wheelSpeedCount + 1

end; 0)

wheelSpeedSum / WheelSpeedCount

2.8.1.11 COM-API Can Create New Measurement Files
– A 3rd party application/plugin can use the UserDataFile class to create new measure-

ment files with application generated channel data.

– Files created with the new API are written in WinDarab file format v2 which is suppor-
ted since WinDarab v7.6.

– A brief example how to write a file can be found in the BMS2ApiSamples.Net project,
see the source in CreateUserDataFile.cs

2.8.1.12 Outing Report Emphasized Values
– In 2017 we added a feature to emphasize min/max values in the outing report using

different colors. A “wanted side effect” of this coloration is also the result determina-
tion of the lap/total values (lap values if a racetrack segmentation is used to evaluate
the segment min/max values).

– If a column is configured to show the minimum value, previous WinDarab versions
used to show the “maximum value of the segment minimum values”, if both are em-
phasized by colorization. NOW the “total minimum” is used!

– If a column is configured to show something else as the minimum value, the “max-
imum value of all sub values” was taken – this behaviour wasn’t changed.

– Another issue was the setting dialog: The default color settings default to emphasize
the maximum value – even if the column function “Minimum” is selected. Because it
makes more sense to emphasize the total minimum it this case, we changed the set-
tings dialog: Now the colors for Minimum and Maximum value are swapped, if no col-
orization is configured for the minimum value – and swapped back if the function is
again changed to another function expect “Minimum”.

2.8.1.13 Math Functions Support 'NoValue'
– In math channels you can use “NoValue” to supress any output in WinDarab (e.g. the

oscilloscope signal is interrupted).

– A math function “IsValue” was added to checka input value for “NoValue”.

– Also, all analysis windows (should) work correctly if they meet a “NoValue”.

– Note: All comparisions with NoValue will returns false (NoValue is internally a NaN
double value)

– Here’s a sample math function:

if (nmot > 6000; nmot; NoValue)
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This channel will show only a signal, if nmot is larger than 6000 – anywhere else there’s
nothing!

2.8.1.14 x-y-Plot: Toggle between <auto> and absolute x-y-z-axis
limits

– Buttons were added in the ribbon (and hotkeys X, Y and Z) to toggle the x-, y- or z-
axis limits between <auto> and the absolute value (current values of <auto>).

2.8.1.15 Worksheet items can be automatically arranged
– In the “Windows” ribbon category we added the function “Tile controls” to tile all

worksheet controls on the current worksheet.

– The function is also available if you open the context menu of the worksheet control
caption/border.

2.8.1.16 Math Inspector Improvement
– The upper pane shows the value tree.

– The lower pane shows the math expression.

2.8.1.17 Automatic Y Axis
– After the user added a y-axis for a channel in the oscilloscope, the y-axis context

menu can be used to turn the y-axis into an “automatic y-axis” (click “Selected chan-
nel” in the context menu)

– An automatic y-axis always shows the corresponding y-scale for the selected channel
in this area.

– A second click on “Selected channel” REMOVES the automatic y-axis.

– If a channel is dropped onto an automatic y-axis, the y-axis is a normal axis for the
channel.
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– Note: A automatic axis always fills the complete height of the y-axis area and cannot
be changed (height or vertical position).

2.8.1.18 Less Restrictions on Linked Files
– New in WinDarab is the support to open different files as a linked file – even the re-

cording configurations are different

– All channels occurring in at least one of the member files is available in the linked
file.

– If a member file doesn’t contain a channel, the area in the linked file doesn’t con-
tain any samples Following restrictions are still valid:

– All channels have to use the same data format and bit size (e.g., unsigned 16-Bit)

– All channels have to use the same quantization (e.g., offset/gain)

– To complete the support, the file extract functions were refactored.

– In case of a linked file, file extract supports the creation of additional timelines
which are required to export linked channels correctly, if some member channels
are missing.

– The export functions are much faster now because they use multiple threads to
collect the data to export.

2.8.1.19 Instrument Panel Improvement
– Instrument panel allow to select multiple gauges by pressing the Ctrl + Left Click or

using a rubberband.
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– The location and size of all selected gauges can be adjusted in a single step.

– Copy and paste of the selected gauges is supported.

– The layout grid is removed. Now the borders of the gauges act as magnetic lines
making it easy to align/adjust gauges.

– If multiple gauges are selected, the arrow keys can be used to move the gauges by
pixel (without snapping to the magnetic lines). Additionally, the arrow keys can be
used with Shift to align all gauges to the top, left, bottom or right border, together
with Ctrl the size can be adjusted (Ctrl+Right Arrow, Ctrl+Down Arrow) or aligned
and sized (Ctrl+Left Arrow, Ctrl+Up Arrow).

2.8.1.20 Ignore Hardware Triggers
– WinDarab now allows to “ignore” / ”hide” lap triggers created by the recording hard-

ware. To ignore a lap trigger simply use “Delete laptrigger” from the context menu /
ribbon menu.

– Hidden hardware lap triggers can be restored in the “Lap trigger” dialog (-> ribbon).
Hidden hardware triggers are shown in red using an italic font.

– Note: This feature is not yet fully implemented/tested. Especially distance normaliza-
tion for linked files lacks, because WinDarab used some optimizations in the past
which cannot handle deleted hardware triggers in correctly. But the feature can be
used for single files (e.g. if data was converted with “one file per outing”).

2.8.1.21 New Math Functions

The math function “ValueAtDist” was added
ValueAtDist(<channel>; <dist> [; <LapIndex>])

– If <LapIndex> is omitted, <dist> is the absolute distance value within the file.

ValueAtDist(<channel>; <xdist>-10)

returns the value 10m before the current position.

– If <LapIndex> is given, the <dist> argument is a lap distance value.

ValueAtDist(<channel>; 100; LapIndex)

returns the value at position 100m of the current lap.
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ValueAtDist(<channel>; lapdist; LapIndex-1)

returns the value at the lap position but in the previous lap.

The math function “ValueAtTime” was extended accordingly to
ValueAtDist
ValueAtTime(<channel>; <time> [; <LapIndex>])

– If <LapIndex> is omitted, <time> is the absolute time value within the file.

ValueAtTime(<channel>; <xtime>-10)

returns the value 10sec before the current position.

– If <LapIndex> is given, the <time> argument is a lap time value.

ValueAtDist(<channel>; 10; LapIndex)

returns the value at position 10sec of the current lap.

ValueAtDist(<channel>; laptime; LapIndex-1)

returns the value at the same laptime position but in the previous

lap.

Note: WinDarab optimizes the following usage pattern of
ValueAtTime
ValueAtTime(<channel>; xtime-<delta>)

– In this case WinDarab doesn’t calculate a “real” math channel. Instead WinDarab shifts
the timeline accordingly and passes the channel data through – this is almost like ac-
cessing the original channel!

2.8.1.22 Alias Channels Can Contain Variable Parts
– An alias channel name and the names of its possible member channels can contain

indexers. WinDarab automatically expands the alias channel definition (internally) to
discrete alias channels:

– The indexer can be given as a list of name parts “[part1, part2]” or a range [1...4] or [a-
d] or any combination [a,b-d]

– The number of indexers in the alias channel name and its member channel names
must match!

Example
You want alias channels wheelspeed_fl, wheelspeed_fr, …

Now you can create an alias channel definition named “wheelspeed_[fl,fr]”

And give the following member channels:

– vspeed_[fl,fr]

– vwheel_[fl,fr]

– vspeed_[0..1]
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2.8.1.23 Setupsheets & Telemetry
Now setupsheets can also be configured for telemetry streams. The setupsheet file (setup-
sheet.xml) has to be located in the folder WinDarab Install\Config\WDServer”.

2.8.1.24 Auto-align Telemetry and Logged Data
– If the option “Auto-Align running laps” is enabled all running laps of telemetry

streams are automatically aligned and the oscilloscope is scrolled so that the aligned
laptrigger is located at the left edge of the oscilloscope.

– As soon as the next laptrigger is received, the new lap is automatically aligned to the
other laps.

– Note: While replaying the cursor is always moved to/for the overlay which is the
closest to the right side of the oscilloscope. This ensures that all values (channels
pane, analysis windows) are evaluated for the current values.
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2.8.1.25 Hide Overlay
– The visualization of an overlay can be disabled (hidden) – while the file keeps opened

and attached to the overlay.

– To hide an overlay, use the overlay context menu in the file explorer. An overlay is
shown again, if you select the same context menu item or – simly – by clicking into
the overlay column to select a lap. Alternatively, you can use the “Hide” context menu
in the oscilloscope (“H” key).

– What happens if an overlay is hidden:

– The oscilloscope hides all channel of hidden overlays

– The trackmap doesn’t show the position of the car.

– All analysis windows hide the evaluation results of hidden overlays (except
LapAnalysis)

– If an overlay is hidden most calculations for the attached files are stopped/dis-
abled.

Only “Event rules” and “LapAnalysis” is still evaluated.

2.8.1.26 Detect Event Supports Multiple Overloads
– Two additional arguments “BeginDelay” and “EndDelay” were added to DetectEvent.

With these arguments DetectEvent delays state changes by the given amount of time.

– The two arguments are optional and don’t change the signature of the “old” Detec-
tEvent:

DetectEvent(Inactive|Rising|Active|Falling; <BeginCondition>; <Be-

ginDuration>; <BeginDelay>; <EndCondition>; <EndDuration>; <End-

Delay>)

– The kind of the arguments are controlled by the given number of arguments. Hereby
the first keyword argument (Inactive/Rising|Active|Falling) is always optional and is
NOT counted as an argument!

DetectEvent with 6 Arguments

DetectEvent(

Inactive|Rising|Active|Falling;

<BeginCondition>; <BeginDuration>; <BeginDelay>; 

<EndCondition>; <EndDuration>; <EndDelay>

)

DetectEvent with 5 Arguments

DetectEvent(

Inactive|Rising|Active|Falling;

<BeginCondition>; <BeginDuration>; <BeginDelay>;

; <EndDuration>; <EndDelay>

)

DetectEvent with 4 Arguments

DetectEvent(

Inactive|Rising|Active|Falling;

<BeginCondition>; <BeginDuration>; ;

<EndCondition>; <EndDuration>; 

)

DetectEvent with 3 Arguments
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DetectEvent(

Inactive|Rising|Active|Falling;

<BeginCondition>; <BeginDuration>; ;

; <EndDuration>; 

)

DetectEvent with 2 Arguments

DetectEvent(

Inactive|Rising|Active|Falling;

<BeginCondition>; <BeginDuration>; 

)

DetectEvent with 1 Arguments

DetectEvent(

Inactive|Rising|Active|Falling;

<BeginCondition>; 

)

2.8.1.27 Flow Chart: output can be virtual channels
– Columns in any output table can be enabled to create/populate a virtual channel. The

virtual channel can be used in any other view of WinDarab for futher analysis.

– Peristent channels are also supported for single files (not linked files and not tele-
metry), but only if the evaluation “Whole file” is selected for the flow chart. Note: Be
aware that persistent channels are replaced each time the flow is executed!

– The name of the column is used as the name of the virtual channel and the name of
the table is used as the data source. Nevertheless to prevent name conflicts we en-
courage the use of „unique names“. WinDarab will resolve channel name conflicts**
nevertheless depending on the execution order of Flow Charts the name conflicts
aren’t always resolved the same way!

Setup of the Output Table:

Example Flow chart (calculate the average engine rpm (nmot) above 6000 rpm):
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Example Output (oscilloscope and XY Plot):

2.8.2 New Features in WinDarab 7.8

2.8.2.1 Outing Report - Virtual Channels
In the outing report settings (Options Tab) a new feature is added. If enabled, the outing
report provides a virtual channel for each configured column.

For each column the outing report creates:

– A virtual channel with lap-based results

– A virtual channel(s) with segment-based results, if racetrack segments are evaluated

Important: If outing report is configured to evaluate segments, the “lap” row shows the
maximum or minimum of the single segment values. The lap-based virtual channels con-
tain the statistic value over the whole lap, which is not the same as the “lap value” in the
outing report table!
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2.8.2.2 Oscilloscope - Quick Expand an area
The user can expand a single area of an oscilloscope to the whole Oscilloscope display
area while the other areas are 'hidden’.

Hotkey:

– Use 1,2...-0 on the keyboard.

– 'Z' Shows a context menu with all 'zoom' operations

Replaced Hotkeys:

– Zoom Tag: T → Z, T

– Zoom Marked: M → Z, M

– Zoom Segment: S → Z, S

2.8.2.3 Calculation of Lap Statistics changed
The functions to calculate lap statistics were changed.

– They do not include interpolated values at the lap boundaries anymore.

WinDarab only evaluates the recorded samples within the lap boundaries (LapTimeBegin
<= time < Lap.TimeEnd)

2.8.2.4 File Compression
WinDarab supports WinDarab files using channel data compression.

Starting with WinDarab v7.08.003 WinDarab files can use a format extension allowing
WinDarab/DataLoggerImport to compress channel data in WinDarab files.

– This reduced the WinDarab file size by ~ 70-90% of the uncompressed size.
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Important:

– Starting with WinDarab v7.08.003 files can take advantage of channel data compres-
sion.

– Both, WinDarab and DataLoggerImport, have options in their program settings to
DISABLE data compression. The default is ENABLE data compression!

– Starting with WinDarab v7.07.036 support to open WinDarab files using data com-
pression was added. Nevertheless WinDarab v7.07 cannot create compressed files.

– If users/teams start using v7.08 but need backward compatibility to WinDarab
v7.07.035 and before, they have to DISABLE data compression.

2.8.2.5 WinDarab supports opening WinDarab files with
multilogging option

– Upcoming dataloggers devices / setups support a synchronized data recording with
multiple dataloggers in a single car. The files generated by these devices contain a
multilogging identifiers.

– If such files are selected and opened, WinDarab detects the multilogging identifiers
and arranges the files accordingly:

– All files from the same logging device are opened as an internal linked file group (or
single file, if it’s only a single file)

– The resulting internal files for each logging device are then combined to a single lar-
ger file:

– If channels names are duplicated the channel of the first logging device “wins”

– Laptriggers of all member files are unioned.

Note: The implementation is preliminary as a proof-of-concept and especially to test the
results of multilogging and how to combine and handle the data.
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2.8.2.6 BMS2Api - Trackmap/Segments support added
– The code for trackmap and segments was refactored (separation of trackmap data

and trackmap UI implementation) and the trackmap data implementation was moved
to the common data-access-layer sources. With these changes, BMS2Api now sup-
ports the use of all trackmap- / segment-based operations! E.g., the track length nor-
malization of distance/lap distance channels.

2.8.2.7 New features added to lap- and segment-based math
functions
Now evaluation of a subexpression is supported instead of evaluation a channel only:

LapAve((speed_wl + speed_wheel_r) / 2)

An optional argument was added to all lap- and segment-based math functions:

LapAve(<channel>)-> LapAve(<expression>[;<condition>])

Only values are taken into account, if the condition evaluates to true.

Note: Because these math functions have to evaluate their subexpressions independently
from the calculation of the math channel, the use of variables within the arguments is not
allowed!

2.8.2.8 The caption of all views can be edited
The caption of all views can be edited individually (see context menu of the caption or in
the ribbon category Windows)

2.8.2.9 Math Channel - Explicit control of interpolation
Normally the channel data is accessed in the same way that WinDarab draws the signal on
the screen (Analoge, Digital, Dots …).

– That means the channel data is interpolated between to timestamps (analoge) or just
the last sample value is taken (Digital, Dotted).

Therefore, the result of the math function depends on the current signal kind the user has
selected.

This can be an issue in the reliability of math functions.

– Because of this we decided to add an optional appendix to channel names, which let
the math formula creator control how the channel data is accessed by the math func-
tion:

{ChannelName:a} to get interpolated values
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{ChannelName:d} to get the last sample value

{ChannelName} to get the value depending on the current signal

kind

2.8.2.10 Telemetry - Refactoring the handling of disconnect/
connect from/to WDServer

– Because of several problems in the past regarding the stability of WinDarab when the
connection to WDServer is lost and reestablished, we decided to overhaul the hand-
ling of disconnect/connect from/to WDServer.

– Since the beginning of telemetry support WinDarab tried to preserve and synchronize
the objects of a telemetry connection when reconnecting to a WDServer after a tem-
porary network failure. But this approach was never 100 % stable but caused from
time to time known and new issues.

– Now, we overhauled the implementation and discarded the approach of keeping and
synchronizing existing objects. Now, we create a new and complete set of the tele-
metry stream objects and replace the outdated telemetry stream by the new stream.

2.8.2.11 Oscilloscope - Settings dialog is coming back
– After customers asked for the oscilloscope settings dialog, a new implementation of

the former dialog is started.

Note:

– The dialog is still “under work” and provided for testing!

– Digital/Analog/Dots does not appear in this dialog → it is a Channel setting not
an Oscilloscope setting!

2.8.3 New Features in WinDarab 7.9

2.8.3.1 Quality Feedback Agent
Feedback Agent allows users to send feedback and crash dumps directly from the tool to
development team.

Feedback agent and manual crashdump can be triggered manually with keyboard short-
cut Left CTRL + Right Shift + F10 or from the icon in the top right corner of the tool:

User can select which information is included in the feedback and also add additional files
like screencaptures, data files or video.
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If there is no active internet connection or user does not want to send large files right
away on restricted connection, feedback agent can also save ticket locally and send it
later. Feedback agent is also able to resume interrupted data transmissions.

2.8.3.2 Updater Tool
WinDarab checks automatically from the Bosch server if there is a new version of the tool
available or it is possible check updates from the Tools menu – Look for Updates.
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User can select between officially released version or the latest development version.

It is also possible to download only the new installer or let the tool also proceed the up-
date.

Available actions are

2.8.3.3 Map Creator
Like distribution but is targeted to create calibration maps where defined map axis points
are required.

The user can give desired exact axis points and range (width in x- and y-xis) around these
points which values are considered for these defined cells.

Conditions can be used further to filter the data.

Supports 2D and 3D view of the data and copy table to clipboard.
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2.8.3.4 Multiple file selection and lap/range zoom
Select multiple files in File browser with shift + up/down or with mouse.

Zoom laps/range also possible similar way.

2.8.3.5 Oscilloscope - Show only current overlay in oscilloscope
New option added option to show only current overlay in oscilloscope.

Select overlay to be shown in the bottom of the oscilloscope and click Show Current
Overlay Only. This works with as many overlays as there are, only the selected will be
shown, and rest will be hidden.
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2.8.3.6 Oscilloscope - Channel time shift
Like overlay time shift, but for individual channels.

1. Set the tag marker to define a position which will shifted.

2. Place the cursor at the position the marked position is shifted to.

3. Right click on the channel and select “x-shift” or click set from Time Shift menu icon.

Note: The time-shift is not stored in the file and goes away if a channel is removed from
memory (not used by any view).

Time-Shifting a channel is also possible using math channels / filters using the function
pattern “ValueAtTime(<channel>;xtime +/- <offset>).

2.8.3.7 Formulas - human readable math channels .json format
Formulas have option to use human readable math channel .json format.
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– Starting with v7.09.055 WinDarab can read (and optionally write) math channel files in
a human readable Json format.

– When reading/loading WinDarab automatically detects if a math channel file is the
binary format or the Json format.

– Writing the Json-format is optionally possible if a flag is added to the settings.ini file:

– Config\setting.ini

– [Options]

– MathDefinition_UseJsonFormat=1

– Important: Saving the math channel definition in binary format is still the default. This
is also true, if you open a json-formatted file in WinDarab and save it while the flag
above is undefined (or set to zero).

Be aware that you cannot use Json-formatted math channels in conjunction with Win-
Darab versions prior to v7.09.55.

2.8.3.8 Conditions are moved under functions
Conditions are moved under functions which makes easier to share them as they are also
stored like math functions as individual files.

All conditions previously that were defined in config\settings.ini are converted to indi-
vidual bmscnd files.

WinDarab converts (one-time) the conditions stored in settings.ini to condition files (*.bm-
scnd) and saves those files in the current math channel base folder. Then the condition
definitions are removed from setting.ini.

If users use several different math channel set (-> changing the base folders), then they
have to copy the new *.bmscnd files to the other math channel base folders.

2.8.3.9 Video analysis is updated to use VLC ActiveX control
Video analysis is updated to use VLC ActiveX control which allows better control and visu-
alization of video against data. Make sure to have latest and correct 64bit VLC package in-
stalled.

2.8.3.10 Lookup table editor improved
Lookup table data grid control is improved by adding several features:

– Copy and Paste improved/fixed

– Adding an additional empty line when growing the table fixed

– Handling comma/dots improved

– Detection of the used separator improved

– A entered value is applied to all selected cells

– Relative editing of a cells / multiple cells

Prepend the operation in front of the entered value: “+”, “-“, “*”, “/”

Append a equal “=” to perform the calculation.

Append a percent “%” to perform a percentage calculation



2 | WinDarab V7

202 / 224 WinDarab V7 Wiki Manual Bosch Motorsport

Examples:

+10= -> Adds 10 to the selected values (“21” becomes “31”)

/2= -> Divides the selected values by 2 (“10” becomes “5”)

-10% -> Decreases the selected values by 10% (“1.0” becomes “0.9”)

*10% -> Multiplies the selected values with 10% (or 0.1) (“1.0” becomes “0.1”)

2.8.3.11 Formulas support scripting
Formulas/math editor allows scripting and IF functions together with support for local
variables. Also commenting is possible in editor.

2.8.3.12 Math functions – dtNext, dsNext and „No value“ added
New math functions dtNext and dsNext are added and „No value“ added to skip data
points with no value.

2.8.3.13 Overlays can be aligned with file or user defined events
– Overlays can be aligned/shifted with/to the current cursor position by selecting file

events in the “File Events” pane.

– The user selects one event per outing.

– Then a click on the “Align” button in the “File Events” toolbar shifts all overlays a
event was selected for in a way, that the event timestamp is aligned to the cursor
position.

– This feature works for all file events:

– Recorded device events

– Events created by event rules (-> “Event Rules” pane)

– User-defined events which can be inserted/added manually to a file (Oscillo-
scope / Insert-key / User Event)

2.8.3.14 Telemetry data access protection and encryption
WinDarab v7.9.026 is the first client supporting the new WDServer v3.2 with enabled ac-
cess protection and data encyption.

After access protection is enabled in WDServer v3.2, WinDarab v7.9.026 is capable to de-
tect, connect to WDServer v3.2 and show its telemetry streams:

1. If a protected WDServer v3.2 is detected, WinDarab shows the WDServer in the “new
files” section at the bottom of the “File Explorer” view. When double-clicking the
entry, the user can enter the correct password to allow WinDarab to receive the WD-
Server configuration.

2. After unlocking the WDServer connection, all streams of the WDServer are shown in
the “New files” section. Again, a double-click on an entry opens (if required) the pass-
word dialog to connect with the specific telemetry stream.

Notes:

– The password hint/password can be stored in the password safe of WinDarab. If a
matching password is found in the password safe, the WDServer and/or telemetry
stream is immediately unlocked/established.
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– If a WDServer is unlocked and the same password hint/password is used to protect a
telemetry stream, the password is not required to be entered again.

– If WinDarab is opened, a stream which was connected before won’t ask for the pass-
word again when reconnecting.

– Enable password protection 1st in global settings then individual streams can be pro-
tected!

– Alias name for stream source can be used instead of computer name.

2.8.3.15 Telemetry data compression between WDServer and
WinDarab
WDServer v3 supports data compression between WDServer and WinDarab v7.9.

2.8.3.16 Telemetry connect / re-connect to a stream revised for
stability
Further improvements on telemetry stability and connection/re-connection implemented.

2.8.3.17 Telemetry align realtime positions
– This new feature aligns the realtime positions of all telemetry streams.

– The feature is accessible in the context menu of the oscilloscope view (signal area) or
in the drop-down menu of the “Replay” ribbon button.

– Note: The files are aligned by shifting the files by time.Therefore, the realtime posi-
tions will run away, if the x-axis is not time (e.g. distance).
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3 WDServer V3

3.1 New Features in WDServer V3
WDServer optionally distribute setup sheet XML files to connected
clients

– A setup sheet file can be configured for each stream/car.

– If a new client (WinDarab) connects to a WDServer stream, the setup sheet is sent to
the client.

– WDServer observes the setup sheet files for changes/updates. If WDServer receives an
update notification the changed setup sheet is distributed to all clients without stop-
ping/restarting the stream.

– WinDarab v7.10.059 is required to support the WDServer distributed setup sheets.

– WinDarab can handle changed values and also newly added setup sheet channels.
Deleted setup channels are not applied; they will disappear if WinDarab reconnects to
the WDServer stream

– The setup sheet can be viewed and edited in WinDarab. Nevertheless, updates aren’t
applied unless the changed setup sheet folder is stored in the folder that is con-
figured/observed in/by WDServer.

New page “Client Monitor”
A new page “Client Monitor” was added to WDServer. On this page WDServer lists all cli-
ents that are “seen” by WDServer:

– A client is listed as soon as a lookup or client info message is received by WDServer.

– A client is unlisted if WDServer doesn’t receive a client info message for more than 1
minute. In case a WinDarab client send only a lookup message and no client info the
time until unlisting is extended to 15 minutes.

– Starting with WinDarab v7.10.056 client info messages are sent periodically by
WinDarab.

– Up to WinDarab v7.10.055 WinDarab sends a lookup message once after startup.
A client info message is sent only if WinDarab connects to a WDServer stream.

The “Client Monitor” page shows additional information about detected clients:

– Online/Offline indicator

– Last Seen time

– Streams a client is connected to (on this WDServer)

Additional properties if a client info message was received:

– Application Name

– Application Version

Optional laptime limit to force file export
– A laptime limit can be set on the “Configure” page. If the current lap exceeds the

given limit WDServer starts to export the lap in multiple WinDarab files using the
given timespan.
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– By default, the laptime limit is set to <empty> (or 0), meaning that this feature is
disabled.

– The laptime limit can be set globally only and not per stream.

– Placeholder [Fragment] and [n] were added to avoid duplicated filenames.

– [Fragment]: Is the fragment counter of a lap (starting at 1)

– [n]: Is a unique number to avoid any kind of duplicated filename (startsint at 1)

– [Fragment] or [RecTime] can be used to distinguish the files, if they belong to the
same lap.

Internet connection monitor added
– At the bottom of the sidebase WDServer shows a internet connection monitor now.

That shows the ping/http roundtrp times of the past

– The connection monitor uses a simple ping to googles nameserver (8.8.8.8).

– Because some firewalls or network configurations may prevent successful pings, WD-
Server will fall back to (slower) sending http-request to the WinDarab Update server.

External Telemetry – New interface for incoming data
– External Telemetry is a new data interface for incoming data. The interface is designed

to accept data in a well-documented manner. This allows 3rd party software to gener-
ate telemetry data that is accepted by WDServer v3 and delivered to any WinDarab
v7.10 client.

– External telemetry streams are only supported by WinDarab v7.10 clients and requires
an addon license for “External Telemetry”.

3.1.1 Key Changes in WDServer v3
WDServer v3 is a data decoding and forwarding software for different types of telemetry
data streams. It is used with Bosch Motorsport telemetry products, such as hardware and
cloud services.

– Support for DirectLink services.

– DirectLink provides the ability to receive telemetry using a secure connection with
the Bosch RaceConnect cloud.

– Data is received through the local PC internet connection.

– Web-browser based GUI.

– Auto-forwarding of the .ini configuration file for DirectLink users.

– Requires Ethernet connection between the data logger and telemetry gateway.

– Requires latest logger and LTE65 firmware.

– End of support for serial / RS232 data interfaces on the local PC.

– WDServer v3 no longer decodes data from serial devices on the local PC, such as
a USB to RS232 adapter connected to an LTE65 receiver

– This means data must be received on the WDServer side using a local Ethernet
device, such as an LTE65 Receiver, or via DirectLink
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– Data from the source, i.e. the vehicle logging system, can still be serial / RS232

3.1.2 Telemetry data access protection an encryption
WinDarab v7.9.026 is the first client supporting the new WDServer v3.2 with enabled ac-
cess protection and data encyption.

After access protection is enabled in WDServer v3.2, WinDarab v7.9 is capable to detect,
connect to WDServer v3.2 and show its telemetry streams:

If a protected WDServer v3.2 is detected, WinDarab shows the WDServer in the “new files”
section at the bottom of the “File Explorer” view. When double-clicking the entry, the user
can enter the correct password to allow WinDarab to receive the WDServer configuration.

After unlocking the WDServer connection, all streams of the WDServer are shown in the
“New files” section. Again, a double-click on an entry opens (if required) the password dia-
log to connect with the specific telemetry stream.

Alias name for stream source can be used instead of computer name.

3.1.3 Telemetry data compression between WDServer
and WinDarab
WDServer v3 supports data compression between WDServer and WinDarab v7.9.

3.1.4 Telemetry connect / re-connect to a stream
revised for stability
Further improvements on telemetry stability and connection/re-connection implemented.

3.1.5 General Troubleshooting
WDServer v3 supports minidumps like WinDarab and stores important events in log files
which can help debugging issues.

3.2 About WDServer V3
WDServer V3 is a data decoding and forwarding software for different types of telemetry
data streams. It is used with Bosch Motorsport telemetry products, such as hardware and
cloud services.

Example use cases include:
– Receive a live data stream from a Bosch data logger in the Bosch telemetry data

format. Data can be transmitted using a Bosch telemetry modem, a DirectLink con-
nection (Internet-based), or a third-party device telemetry modem.

– Receive a live data stream in a third-party data format, using a source such as a Bosch
telemetry modem or a DirectLink connection (Internet-based). Then, forward the data
stream to a third-party application for data analysis.

Key Changes in WDServer V3:
– Support for DirectLink services.

– DirectLink provides the ability to receive telemetry using a secure connection with
the Bosch RaceConnect cloud.
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– Data is received through the local PC internet connection.

– End of support for serial / RS232 data interfaces on the local PC.

– WDServer V3 no longer decodes data from serial devices on the local PC, such as
a USB to RS232 adapter connected to an LTE65 receiver.
This means data must be received on the WDServer side using a local Ethernet
device, such as an LTE65 Receiver, or via DirectLink

– Data from the source, i.e., the vehicle logging system, can still be serial / RS232

– Web-browser based GUI.

– Auto-forwarding of the .ini configuration file for DirectLink users.

– Requires Ethernet connection between the data logger and telemetry gateway.

– Requires latest logger and LTE65 firmware
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Software Installation Notes
1. Launch the Windows installer executable delivered in the WDServer zip-file.

Note: Microsoft .NET Core 6.0.32 or higher is required. An internet connection may be
required, if Microsoft .NET Core 6.0.32 Windows Server Hosting is not already in-
stalled on the PC.

2. Follow the setup instructions to install WDServer V3.

The option is available to choose the installation folder.

There are two options to install WDServer V3, either as a new version in a separate folder
on the computer, or to replace the existing version.

Note: For users with WDServer V2 already installed, it is recommended to install WD-
Server V3 to a new folder.

3.3 Firewall Rules
To ensure proper communication with other data analysis tools on the PC, it is strongly
recommended to set firewall rules which allow free inbound and outbound communica-
tion.
- Inbound and Outbound rules are needed for WDServer and WinDarab (if you are using
WinDarab as your data analysis tool).

Inbound Rule
1. Open Windows Defender Firewall with Advanced Security, using Run as administrator.

2. Create a new Inbound Rule for WDServer.
On the left side of the window, click on Inbound Rules.
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On the right side of the window, click on New Rule.

3. Next, choose to add a rule for Program. 
Choose to add This program path and navigate to your WDServer installation folder.
By default, this will be C:/Bosch/WDServer. Select WDServer.exe as the program to al-
low, then click on Open.

4. Optionally, at this step look for the part of the file path that says %SystemDrive%\,
and replace with the drive letter, for example, C:\

5. Then, click Next again to allow the connection.

6. Click Next again to apply the rule for all network types.

7. Create a name for the rule and click Finish.

Outbound Rule
Once the Inbound Rule is created, repeat the same steps in the Outbound Rules menu, to
create a rule allowing outbound traffic for the WDServer.exe program.
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Note: The difference in steps between Inbound Rule and Outbound Rule setup, is to
change "Block the connection" to "Allow the connection" on the screen after selecting the
WDServer.exe program.

3.4 Getting started with WDServer V3
Launch the application WDServer.exe.

– It is helpful to pin the application to the taskbar after starting for the first time.

Two things should automatically happen:

– A command window will open for WDServer console.

– A web browser should open with the following address and a login page: http://
127.0.0.1:5000/Identity/Account/Login 
Default login details, which can be changed later in the settings:
Email address: admin 
Pass: password

Note: In case a web browser does not automatically open, go to http://localhost:5000/

After first installation and successful login, this is how WDServer looks in the web browser:

3.5 WDServer Configuration
Data streams may be added or changed in the Configure tab.

http://127.0.0.1:5000/Identity/Account/Login
http://127.0.0.1:5000/Identity/Account/Login
http://localhost:5000/
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3.5.1 Configure a DirectLink Token
1. Click the Configure tab and select Add New

2. Select DirectLink

3. Select Region: such as US V2 Prod

4. Token: Enter the token: a specific value unique to each user, provided by Bosch

Note: Once the token is added, the remaining settings will only become when data is re-
ceived from the source.

3.5.2 DirectLink with Bosch Data Stream
1. Click on the settings gear next to the data stream statistics.

2. Set the settings for the stream.

Select Stream Type: Bosch Data Stream

Project Key: Provide the Telemetry Project Key from RaceCon.

– Location in RaceCon project:

– Logger -> Telemetry -> Settings -> Project Key

– Ini File Folder: Provide the file path to the .ini file generated by RaceCon is saved.
The INI file is written by RaceCon to the PC that most recently updated the vehicle
configuration.
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„Auto-INI“: INI files can be automatically transferred via the RaceConnect cloud, if
supported by the data logger. If Auto-INI is not available, the file path must be
provided here.

Below, two examples are below, where Auto-INI is enabled and disabled, respectively.

Reference Information: Location of INI File Folder and Project Key from within RaceCon
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Lastly, below is a summary of the user interface and functions in the DirectLink configura-
tion view.

3.5.3 DirectLink as UDP Proxy / Port forwarding
The UDP Proxy function allows a data stream to be forwarded to an external application.

1. Click on the settings gear next to the data stream statistics.

2. Select Stream Type: UDP Proxy

3. Forward to: Enter the IP address and port where the external application will listen for
data. Use a colon „:“ to separate the IP address and port.
Examples:
localhost:15002
127.0.0.1:15002
192.168.1.25:15002
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Where 150xx is an arbitrary port also set up in the other application.

After the setup, WDServer will report where data is being forwarded:

Example of matching Cosworth Pi Toolset configuration:
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Example of matching MoTeC T2 Server configuration:

3.6 Monitoring the Data Stream

Car Monitor
For each stream:

– B/s is the raw Bytes / second



3 | WDServer V3

216 / 224 WinDarab V7 Wiki Manual Bosch Motorsport

– Indicates if any data is being received to the PC.

– P/s is the decoded Packets / sec

– For Bosch Data Streams (non-UDP Proxy / Port Forwarding mode), indicates that
data is being decoded properly using the .INI file, and can be viewed by Win-
Darab users.

Basic troubleshooting for data streams:

– If B/s is 0 and P/s is 0:

– No data is being received.

– If B/s is populated and P/s is 0:

– Data is being received, but the .ini file is missing or does not match.

– If B/s is populated and P/s is populated:

– WDServer is decoding data.

Client Sessions
– For Bosch Data Streams (non-UDP Proxy / Port Forwarding mode):

– A list of PCs viewing the decoded data stream in WinDarab

– The list will include the PC that is hosting WDServer, if this PC is also viewing the data
stream in WinDarab.

3.7 Configure an LTE65 Receiver
1. Connect an LTE65 Receiver to an open Ethernet port on the WDServer PC.

2. Click on the Configure tab and click on Add New.

3. Select Car Via LTE65.

3.7.1 Configure an LTE65 Receiver with Bosch Data
Stream
1. Provide a name for the data stream, the RaceCon telemetry project key, and the path

to the local folder containing the INI file.
Refer to the section DirectLink with Bosch Data Stream for information regarding
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where to find the RaceCon telemetry project key, and the INI file folder location.
The INI file is written by RaceCon to the PC that most recently updated the vehicle
configuration.

2. Click on Ok, then Add Datasource.

3. Provide the UDP Port (configured in RaceConnect) and the IP address of the LTE65
Receiver.
In most cases, the IP address is 10.10.0.235
If unsure about the UDP Port defined in RaceConnect, contact your Bosch represent-
ative or your dealer.

Note: Multiple data streams can be received via the same LTE65 Receiver. To set up mul-
tiple data streams, with different INI files and project keys, add a second LTE65 Receiver in
the Configure page by clicking on Add New -> Car Via LTE65, and define another stream
using the information of the same LTE65.

Lastly, below is a summary of the user interface and functions in the LTE65 configuration
view.

– Refer to section Monitoring the Data Stream for information about the user interface
and basic troubleshooting.
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3.7.2 LTE65Receiver with UDP Proxy
1. After following the steps from section Configure an LTE65 Receiver, change the

Stream type to UDP Proxy.

2. Provide a Name for the data stream.

3. Forward to: Enter the IP address and port where an external application will listen for
data. Use a colon „:“ to separate the IP address and port.
Examples:
localhost:15002
127.0.0.1:15002
192.168.1.25:15002
Where 150xx is an arbitrary port also set up in the other application.

Click Ok, then Add Datasource.

4. Provide the UDP Port (configured in RaceConnect) and the IP address of the LTE65
Receiver.
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In most cases, the IP address is 10.10.0.235

If unsure about the UDP Port defined in RaceConnect, contact your Bosch representative
or your dealer.

Note: Multiple data streams can be received via the same LTE65 Receiver. To set up mul-
tiple data streams, in order to forward multiple streams to another application, add a
second LTE65 Receiver in the Configure page by clicking on Add New -> Car Via LTE65,
and define another UDP Proxy. The information defining the LTE65, will have to be
entered again for each desired additional stream.

3.8 Configure a Third Party Receiver
A third-party telemetry system which supports Ethernet may be used in place of the
LTE65.

In this case, the instructions in the sections LTE65 Receiver with Bosch Data Stream or
LTE65 Receiver with UDP Proxy should be followed, by declaring the local/LAN IP address
of the third-party telemetry receiver, and the corresponding UDP port which data is being
sent to the PC, during the data stream configuration steps.

However, Bosch makes no guarantee of the compatibility of WDServer with third-party
telemetry systems.

3.9 WDServer Export Settings
For streams with data type Bosch Data Streams, a folder path may be specified for WD-
Server to save telemetry files to disk, in WinDarab .bmsbin file format. Files are written
upon laptrigger (end of each lap as configured in RaceCon), or when the red stop icon is
clicked in the WDServer interface for a given data stream.

The configuration is set in the Configure tab of WDServer. Using placeholders, file names
can be specified using a field from the telemetry data itself.

Note: If the configuration is left empty, no files are written by WDServer.

Be sure to click Apply for the settings to take effect.

Example:
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C:\Users\TelemetryUser\Desktop\MyLoggedTelemetry\[Car] [RecDate]\[Car]-[RecDate]-
Out[Outing03]-Lap[Lap03]_[RecTime].bmsbin

Placeholder Description

[Car] Inserts the name of the car.

[RecDate] Inserts the system date using the format
"yyyy-MM-dd"

[RecTime] Inserts the system time using the format
"HH-mm-ss"

[Outing] Inserts the outing number (formatting see
below).

[Lap] Inserts the lap number (formatting see be-
low).

Lap and outing numbers may be formatted by placing the number of digits behind the
placeholder name. If the length starts with a zero, the number is formatted with leading
zeros, otherwise space characters are used.

Placeholder Example Result

[Lap] 12

[Lap3] 12

[Lap03] 012

3.10 WDServer Global Settings
In the Global Settings window, additional options are available that modify the functional-
ity of WDServer.

3.10.1 Login name and password
Specify the username and password required when connecting to the WDServer V3
browser window.

The WDServer browser page may be accessible to other users on your local network. This
option is available to provide an additional level of authorization, preventing others on
the local network from accessing data stream settings.

3.10.2 Network adapters
Set which specific network adapters on the PC will serve data for WinDarab users.
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3.10.3 TCP/UDP Server Ports
Change the TCP/UDP port used by WDServer to communicate with WinDarab.

Primary/Default port is currently recommended.

3.10.4 Proxy Settings
Set the URL of a network proxy. Optionally, provide authentication to access the proxy.

By default, the proxy of the PC / system is used, if one is active.

3.10.5 Other Settings
Alias name: Set the name of the WDServer instance, which is displayed in WinDarab when
users connect to a data stream.

Keep files: Enter the timespan to keep telemetry data files in temporary files
(days.hh:mm:ss). See section .tmp Files for more information.

3.10.6 WDServer Password Protection
Enables password protection for WinDarab. This requires WinDarab users to enter a pass-
word before being able to connect to a Bosch data stream.

– WinDarab v7.9.26 is the first client supporting the new WDServer V3.2 with enabled
access protection and data encyption.

– After access protection is enabled in WDServer V3.2, WinDarab v7.9.026 or later is
capable to detect, connect to WDServer V3.2 and show its telemetry streams:

– If a protected WDServer V3.2 is detected, WinDarab shows the WDServer in the “new
files” section at the bottom of the “File Explorer” view. When double-clicking the
entry, the user can enter the correct password to allow WinDarab to receive the WD-
Server configuration.

– After unlocking the WDServer connection, all streams of the WDServer are shown in
the “New files” section. Again, a double-click on an entry opens (if required) the pass-
word dialog to connect with the specific telemetry stream. See next slide for details.

1. Enable password protection 1st in global settings then individual streams can be pro-
tected!
Alias name for stream source can be used instead of computer name.

2. Set the password for the individual stream.
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3. Opening password protected stream in WinDarab

– The password hint/password can be stored in the password safe of WinDarab. If a
matching password is found in the password safe, the WDServer and/or telemetry
stream is immediately unlocked/established.

– If a WDServer is unlocked and the same password hint/password is used to protect a
telemetry stream, the password is not required to be entered again.

– As long as WinDarab is opened, a stream which was connected before won’t ask for
the password again when reconnecting.

3.11 Troubleshooting: WDServer Command
Window does not start (.NET Version)
Observed behavior:

When launching WDServer, the application terminal window appears for only an instant.
The window crashes and is immediately closed.

Cause:

.NET Desktop Runtime 6 is not installed, or the currently installed version is incompatible.

Solution:

Install the latest official version of .NET Desktop Runtime 6.

https://dotnet.microsoft.com/en-us/download/dotnet/6.0

https://dotnet.microsoft.com/en-us/download/dotnet/6.0
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3.12 Troubleshooting: Browser Loading Issues
(Error 404, Port Conflicts)
Observed behavior:

WDServer reports a 404 error in your browser or does not load in the browser, and there
are no errors in the running WDServer application terminal.

Cause:

Another application or process on the PC tries to use the same port as WDServer for the
browser interface (TCP port 5000). A common conflict is Vector tools (CANalyzer, etc.)

Solution:

Find the the application or service which is also trying to use the same port, and close it.

Open Windows Command Prompt and run the command:
netstat -noa | find "5000"

Look for multiple entries in the list marked as "LISTENING". This indicates a conflicting ap-
plication.

Use the rightmost column, the PID, and then open Task Manager (Ctrl-Alt-Delete).

The PID of the offending process or application will be shown in the Details column in
Task Manager.

3.13 General Troubleshooting
WDServer V3 supports minidumps like WinDarab and stores important events in log files
which can help debugging issues.

For issues not resolved by the troubleshooting steps or through this manual, contact your
Bosch representative. The following supporting information is useful to provide:

.tmp files and log files.

3.13.1 .tmp files
WDServer saves important runtime files in the following location:
C:\Users\YOUR_USERNAME\AppData\Local\Temp\WDServer.Net

Locate the files which have the problem data stream in the file name. Provide the files to
your Bosch representative.

3.13.2 WDServer log files
WDServer saves log files of the application terminal window in its installation directory, in
the LogFiles folder.

Example directory: C:\Bosch\WDServer V3.02.011\LogFiles

Provide these files to your Bosch representative.
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